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BTS Login from the GUI Environment
Follow the procedures in Table 3-7 to log into a BTS when using the
GUI environment.

Table 3-7: BTS GUI Login Procedure

� Step Action

1 Start the CDMA LMF GUI environment by double–clicking on the WinLMF desktop icon (if the
LMF is not running).

NOTE
If a warning similar to the following is displayed, select No, shut down other LMF sessions which
may be running, and start the CDMA LMF GUI environment again:

The CLI handler is already running.
This may cause conflicts with the LMF.
Are you sure you want to start the application?

Yes No

2 Click on Login tab (if not displayed).

3 Double click on CDMA (in the Available Base Stations pick list).

4 Click on the desired BTS number.

5 Click on the Network Login tab (if not already in the forefront).

6 Enter correct IP address (normally 128.0.0.2) for a field BTS, if not correctly displayed in the IP
Address box.

7 Type in the correct IP Port number (normally 9216) if not correctly displayed in the IP Port box.

8 Change the Multi-channel Preselector from the Multi-channel Preselector pick list (normally
MPC) to a device corresponding to your BTS configuration, if required.

9 Use a Tower Top Amplifier is not applicable to the SC4812ET Lite.

10 Click on Login. (A BTS tab with the BTS is displayed.)

NOTE
� If you attempt to log into a BTS that is already logged on, all devices will be gray.

� There may be instances where the BTS initiates a log out due to a system error (i.e., a device
failure).

� If the MGLI is OOS–ROM (blue), it must be downloaded with RAM code before other devices
can be seen.

� If the MGLI is OOS–RAM (yellow), it must be enabled before other installed devices can be
seen.
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BTS Login from the CLI Environment
Follow the procedures in Table 3-8 to log into a BTS when using the
CLI environment.

If the CLI and GUI environments are to be used at the
same time, the GUI must be started first and BTS login
must be performed from the GUI. Refer to Table 3-7 to
start the GUI environment and log into a BTS.

IMPORTANT

*

Table 3-8: BTS CLI Login Procedure

� Step Action

1 Double–click the WinLMF CLI desktop icon (if the LMF CLI environment is not already
running).

NOTE
If a BTS was logged into under a GUI session before the CLI environment was started, the CLI
session will be logged into the same BTS, and step 2 is not required.

2 At the /wlmf prompt, enter the following command:

login bts–<bts#>  host=<host>  port=<port>

where:

host = MGLI card IP address (defaults to address last logged into for this BTS or 128.0.0.2 if this
is first login to this BTS)

port = IP port of the BTS (defaults to port last logged into for this BTS or 9216 if this is first login
to this BTS)

A response similar to the following will be displayed:

LMF>
13:08:18.882 Command Received and Accepted
             COMMAND=login bts–33

13:08:18.882 Command In Progress

13:08:21.275 Command Successfully Completed
             REASON_CODE=”No Reason”

 

Logging Out
Logging out of a BTS is accomplished differently for the GUI and CLI
operating environments.
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The GUI and CLI environments use the same connection to
a BTS. If a BTS is logged into in both the GUI and CLI
environments at the same time, logging out of the BTS in
either environment will log out of it for both. When either
a login or logout is performed in the CLI window, there is
no GUI indication that the login or logout has occurred.

IMPORTANT

*

Logging Out of a BTS from the GUI Environment
Follow the procedure in Table 3-9 to logout of a BTS when using the
GUI environment.

Table 3-9: BTS GUI Logout Procedure

� Step Action

1 Click on Select on the BTS tab menu bar.

2 Click the Logout item in the pulldown menu (a Confirm Logout pop-up message will appear).

3 Click on Yes (or press the Enter key) to confirm logout. The Login tab will appear.

NOTE
If a logout was previously performed on the BTS from a CLI window running at the same time as
the GUI, a Logout Error popup message will appear stating the system could not log out of the
BTS. When this occurs, the GUI must be exited and restarted before it can be used for further
operations.

4 If a Logout Error popup message appears stating that the system could not log out of the Base
Station because the given BTS is not logged in, click OK and proceed to step 5.

5 Select File > Exit in the window menu bar, click Yes in the Confirm Logout popup, and click
Yes in the Logout Error popup which appears again.

6 If further work is to be done in the GUI, restart it.

NOTE
� The Select menu on the BTS tab will only log you out of the displayed BTS.

� You can also log out of all BTS sessions and exit CDMA LMF by clicking on the File selection
in the menu bar and selecting Exit from the File menu list. A Confirm Logout pop–up
message will appear.
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Logging Out of a BTS from the CLI Environment
Follow the procedure in Table 3-10 to logout of a BTS when using the
CLI environment.

Table 3-10: BTS CLI Logout Procedure

� Step Action

* IMPORTANT
If the BTS is also logged into from a GUI running at the same time and further work must be done
with it in the GUI, proceed to step 2.

1 Logout of a BTS by entering the following command:

logout bts–<bts#>

A response similar to the following will be displayed:

LMF>
13:24:51.028 Command Received and Accepted
             COMMAND=logout bts–33

13:24:51.028 Command In Progress

13:24:52.04  Command Successfully Completed
             REASON_CODE=”No Reason”

2 If desired, close the CLI interface by entering the following command:

exit

A response similar to the following will be displayed before the window closes:

Killing background processes....

 

Establishing an MMI
Communication Session

For those procedures which require MMI communication between the
CDMA LMF and BTS FRUs, follow the procedures in Table 3-11 to
initiate the communication session.

Figure 3-11 illustrates common equipment connections for the CDMA
LMF computer. For specific connection locations on FRUs, refer to the
illustration accompanying the procedures which require the MMI
communication session.

Table 3-11: Establishing MMI Communication

Step Action

1 Connect the CDMA LMF computer to the equipment as detailed in the applicable procedure which
requires the MMI communication session.

2 Start the named HyperTerminal connection for MMI sessions by double clicking on its Windows
desktop shortcut.

. . . continued on next page
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Table 3-11: Establishing MMI Communication

Step Action

NOTE
If a Windows desktop shortcut was not created for the MMI connection, access the connection from
the Windows Start menu by selecting:

Programs > Accessories > Hyperterminal > HyperTerminal > <Named HyperTerminal
Connection (e.g., MMI Session)>

3 Once the connection window opens, establish MMI communication with the BTS FRU by pressing
the CDMA LMF computer Enter key until the prompt identified in the applicable procedure is
obtained.

 

NULL MODEM
BOARD

(TRN9666A)

8–PIN TO 10–PIN
RS–232 CABLE (P/N
30–09786R01)

RS–232 CABLE

8–PIN

CDMA LMF
COMPUTER

To FRU MMI port

DB9–TO–DB25
ADAPTER

Figure 3-11: CDMA LMF Computer Common MMI Connections

COM1
OR

COM2

Online Help

Task oriented online help is available in CDMA LMF by clicking on
Help in the menu bar.
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Pinging the BTS

For proper operation, the integrity of the Ethernet LAN A and B links
must be be verified. Figure 3-12 represents a typical BTS Ethernet
configuration for the SC4812ET Lite with an expansion frame. The
drawing depicts cabling and termination for both the A and B LANs.

Ping is a program that sends request packets to the LAN network
modules to get a response from the specified “target” module.

Follow the steps in Table 3-12 to ping each processor (on both LAN A
and LAN B) and verify LAN redundancy is working properly.

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module to prevent damage
by Electro–Static Discharge (ESD).

CAUTION

SIGNAL
GROUND

SIGNAL
GROUND

50Ω

IN

SC4812ET Lite
(MASTER)

SC4812ET Lite
(EXPANSION)

SIGNAL
GROUND

Figure 3-12:  BTS Ethernet LAN Interconnect Diagram
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The Ethernet LAN A and B cables and/or terminations
must be installed on each frame/enclosure external LAN
connector before performing this test. All other processor
board LAN connections are made through the backplanes.

IMPORTANT

*

Table 3-12: Pinging the Processors

Step Action

1 If this is a first–time communication with a newly–installed frame or a GLI2 which has been replaced,
perform the procedure in Table 6-3 and then return to step 2.

2 Be sure uncabled LAN A and B IN and OUT connectors in the power entry compartment (rear of
frame – Figure 3-9 and Figure 3-12) are terminated with 50 Ω loads.

3 If it has not already been done, interface the LMF computer to the BTS (refer to Table 3-6 and
Figure 3-10.)

4 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 3-7).

5 In the power entry compartment, remove the 50Ω termination on the frame LAN B IN connector. The
CDMA LMF session should remain active. Replace the 50Ω terminator on the BTS frame LAN B IN
connector.

6 From the Windows desktop, click the Start button and select Run.

7 In the Open box, type ping and the GLI2 IP address (for example, ping 128.0.0.2).

NOTE
128.0.0.2 is the default IP address for the GLI2 in field BTS units.

8 Click on OK.

9 If the targeted module responds,  a DOS window will appear with a display similar to the following:

Reply from 128.0.0.2: bytes=32 time=3ms TTL=255

� If the device responds, proceed to step 18.

If there is no response the following is displayed:

Request timed out

� If the GLI2 fails to respond, it should be reset and re–pinged. If it still fails to respond, typical
problems would be: failure of the CDMA LMF to login, shorted BNC to inter-frame cabling, open
cables, crossed A and B link cables, or the GLI2 itself.

10 Logout of the BTS as described in Table 3-9, exit from the CDMA LMF program, and restart the
Windows operating system on the CDMA LMF computer.

11 Restart the CDMA LMF GUI program as described in LMF Help function, and log into the BTS as
described in Table 3-7.

12 Perform steps 6 through 9 again.

� If the device responds, proceed to step 18.

If there is still no response,proceed to step 13.

. . . continued on next page
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Table 3-12: Pinging the Processors

Step Action

13 If ping was unsuccessful after restarting the CDMA LMF computer, press the MGLI front panel reset
pushbutton and perform steps 6 through 9 again.

14 NOTE
Refer to Table 6-1 if ping was unsuccessful after resetting the MGLI.

15 After the BTS has been successfully pinged, be sure the 50Ω termination was replaced on the BTS
frame LAN B IN connector in the power entry compartment (Figure 3-12). Disconnect the LMF cable
from the LAN shelf LAN A connector, and connect it to LAN B (right–hand connector) using a
BNC–female–to–BNC–female adapter (refer to Figure 3-10).

16 In the power entry compartment, remove the 50Ω termination on the BTS frame LAN A IN connector.

17 Repeat steps 5 through 8 using LAN B.

18 After the BTS has been successfully pinged on the secondary LAN, replace the 50Ω termination on
the frame LAN A IN connector in the power entry compartment.

19 Disconnect the LMF cable from the LAN shelf LAN B and connect it to LAN A using a
BNC-female-to-BNC-female adapter.

20 Remove and replace the 50Ω termination on the LAN B IN connector to force the MGLI to switch to
primary LAN A.

21 Repeat steps 5 through 8 to ensure proper primary LAN operation.
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Overview

Before a BTS can operate, each equipped device must contain device
initialization (ROM) code. ROM code is loaded in all devices during
manufacture or factory repair. Device application (RAM) code and data
must be downloaded to each equipped device by the user before the BTS
can be made fully functional for the site where it is installed.

ROM Code

Downloading ROM code to BTS devices from the CDMA LMF is NOT
routine maintenance or a normal part of the optimization process. It is
only done in unusual situations where the resident ROM code in the
device does not match the release level of the site operating software
AND the CBSC can not communicate with the BTS to perform the
download. An example would be a BTS loaded with Release 9.2
software where a GLI loaded with Release 2.8.1 ROM code must be
installed to replace a malfunctioning MGLI.

Before ROM code can be downloaded from the CDMA LMF, the correct
ROM code file for each device to be loaded must exist on the LMF
computer. ROM code must be manually selected for download.

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded will change to
OOS–ROM (blue). The device will remain OOS–ROM (blue) when the
download is completed. The same Revision–level RAM code must then
be downloaded to the device. For example, if Release 2.9.2.1.1 ROM
code is downloaded, Release 2.9.2.1.1 RAM code must be downloaded.

Procedures to load ROM code are located in Appendix G.

RAM Code

Before RAM code can be downloaded from the CDMA LMF, the correct
RAM code file for each device must exist on the LMF computer. RAM
code can be automatically or manually selected depending on the Device
menu item chosen and where the RAM code file for the device is stored
in the CDMA LMF file structure. The RAM code file will be selected
automatically if the file is in the \lmf\cdma\loads\n.n.n.n\code folder
(where n.n.n.n is the version number of the download code that matches
the “NextLoad” parameter of the CDF file). The RAM code file in the
code folder must have the correct hardware bin number.

RAM code can be downloaded to a device that is in any state. After the
download is started, the device being loaded will change to OOS-ROM
(blue). When the download is completed successfully, the device will
change to OOS-RAM (yellow). When code is downloaded to an MGLI
or GLI, the CDMA LMF automatically also downloads data and then
enables the MGLI. When enabled, the MGLI will change to INS (green).

For non–GLI devices, data must be downloaded after RAM code is
downloaded. To download data, the device state must be OOS–RAM
(yellow).
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RAM code downloading requires a few minutes. After the download
starts, the non–GLI device being loaded changes to OOS–ROM (blue). If
the download is completed successfully, the non–GLI device changes to
OOS–RAM (yellow).

The devices to be loaded with RAM code and data are:

� Master Group Line Interface (MGLI2)

� Redundant GLI (GLI2)

� Clock Syncronization Module (CSM) (Only if new revision code must
be loaded)

� Multi Channel CDMA (MCC24 or MCC8E) card

� Broadband Transceiver (BBX2)

� RFDS Test Subscriber Interface Card (TSIC), if equipped

The MGLI must be successfully downloaded with RAM
code and data, and in INS (green) status before
downloading any other device. The RAM code download
process for an MGLI automatically downloads data and
then enables the MGLI.

IMPORTANT

*

Verify GLI ROM Code Loads

Devices should not be loaded with RAM code which is for a different
system release than the ROM code with which they are loaded. Before
downloading RAM code and data to the processor cards, follow the
procedure in Table 3-13 to verify the GLI devices are loaded with the
correct ROM code for the system release used by the BSS.

Table 3-13: Verify GLI ROM Code Loads

Step Action

1 If it has not already been done, start a GUI LMF session and log into the BTS ( refer to Table 3-7).

2 Select all GLI devices by clicking on them, and select Device > Status from the menu bar.

3 In the status report window which opens, note the number in the ROM Ver column for each GLI2.

� The  system release number will be the first two decimal divisions of the number; for example, the
number 2.15.0.0.3 would be for System Release 2.15, and 2.9.2.2.34 would be for System Release
2.9.

4 If the ROM code loaded in the GLIs is not for the correct system release, log out of the BTS,
disconnect the CDMA LMF computer, reconnect the span lines as described in Table 5-7, and have the
CBSC download the correct ROM code version to the BTS devices.

5 When the GLIs have the correct ROM load for the system release being used, be sure the span lines
are disabled as outlined in Table 3-4 and proceed to downloading RAM code and data.
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Download RAM Code and Data
to MGLI and GLI

Follow the steps outlined in Table 3-14 to download the RAM code and
data to the MGLI and other installed GLI devices.

Prerequisites

� Prior to performing these procedures, ensure a code file exists for each
of the devices to be loaded.

� The CDMA LMF computer is connected to the BTS (refer to
Table 3-6), and is logged in using the GUI environment (refer to
Table 3-7).

Table 3-14: Download and Enable MGLI and GLI Devices

Step Action

1 From the Util pull down menu, select Tools, then Update NextLoad.

2 Select the correct code version for the system release being used and click Save.

3 Download code to the MGLI by clicking on the device.

4 From the Device pull down menu, select Download Code.

A status report is displayed confirming change in the device(s) status. Click OK to close the status
window. (The MGLI will automatically be downloaded with data and enabled.)

5 Once the MGLI is enabled, load and enable additional installed GLIs by clicking on the devices and
repeating step 4.

6 Click OK to close the status window for the additional GLI devices.
 

Download RAM Code and Data
to Non–GLI Devices

Downloads to non–GLI devices can be performed individually for each
device or all installed devices can be downloaded with one action. RAM
code and data are downloaded to non–GLI devices in separate steps.

CSM devices are RAM code–loaded at the factory. RAM
code is downloaded to CSMs only if a newer software
version needs to be loaded.

IMPORTANT

*

When downloading to multiple devices, the download may
fail for some of the devices (a time–out occurs). These
devices can be loaded individually after completing the
multiple download.

NOTE

Follow the steps in Table 3-15 to download RAM code and data to
non–GLI devices.
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Table 3-15: Download RAM Code and Data to Non–GLI Devices

Step Action

1 Select the target CSM, MCC, and BBX device(s).

2 From the Device pull down menu, select Download Code.

A status report is displayed that shows the results of the download for each selected device.

3 Click OK to close the status report window when downloading is completed.

NOTE
After a BBX, CSM, or MCC device is successfully loaded with RAM code and has changed to the
OOS–RAM state (yellow), the status LED should be rapidly flashing GREEN.

4 To download data, select the target CSM and MCC device(s).

5 From the Device pull down menu, select Download Data.

A status report is displayed that shows the results of the download for each selected device.

6 Click OK to close the status report window when downloading is completed.
 

Select CSM Clock Source

A CSM can have three different clock sources. The Select CSM Source
function can be used to select the clock source for each of the three
inputs. This function is only used if the clock source for a CSM needs to
be changed. The Clock Source function provides the following clock
source options.

� Local GPS

� Remote GPS

� HSO (only for source 2 & 3)

� LFR (only for source 2 & 3)

� 10 MHz (only for source 2 & 3)

� NONE (only for source 2 & 3)

Prerequisites

MGLI=INS_ACT (green), CSM= OOS_RAM (yellow) or INS_ACT
(green)

Table 3-16: Select CSM Clock Source

Step Action

1 Select the applicable CSM(s).

2 Click on the Device menu.

3 Click on the Clock Source menu item.

4 Click on the Select menu item. A clock source selection window is displayed.

5 Select the applicable clock source in the Clock Reference Source pick lists. Uncheck the related
check box if you do not want the displayed pick list item to be used.

. . . continued on next page
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Table 3-16: Select CSM Clock Source

Step Action

6 Click on the OK button. A status report window is displayed showing the results of the selection
action.

7 Click on the OK button to close the status report window.
 

Enable CSMs

Each BTS CSM system features two CSM boards per site. In a typical
operation, the primary CSM locks its Digital Phase Locked Loop
(DPLL) circuits to GPS signals. These signals are generated by either an
on–board GPS module (RF–GPS) or a remote GPS receiver (R–GPS).
The GPS receiver interfaced to CSM 1 is used as the primary timing
reference and synchronizes the entire cellular system. CSM 2 provides
clock syncronization back–up, but does not have a GPS receiver.

The BTS may be equipped with a LORAN–C Low Frequency Receiver
(LFR), a High Stability Oscillator (HSO), or external 10 MHz Rubidium
source which the CSM can use as a secondary timing reference. In all
cases, the CSM monitors and determines what reference to use at a given
time.

For RF–GPS, verify the CSM configured with the GPS
receiver “daughter board” is installed in the frame’s CSM 1
slot before continuing.

IMPORTANT

*

Follow the steps outlined in Table 3-17 to enable the CSMs installed in
the SCCP shelves.

Table 3-17: Enable CSMs

Step Action

1 NOTE
If equipped with two CSMs, enable CSM–2 first.

Click on the target CSM.

From the Device pull down, select Enable.

2 A status report is displayed confirming change in the device(s) status.

Click OK to close the status report window.

NOTE
� CSM 1 houses the GPS receiver. The enable sequence can take up to one hour (see below).

� FAIL may be shown in the status report table for enable action. If Waiting For Phase Lock is shown
in the Description field, the CSM changes to the Enabled state after phase lock is achieved.

. . . continued on next page
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Table 3-17: Enable CSMs

Step Action

* IMPORTANT
The GPS satellite system satellites are not in a geosynchronous orbit and are maintained and operated
by the United States Department of Defense (DOD). The DOD periodically alters satellite orbits;
therefore, satellite trajectories are subject to change. A GPS receiver that is INS contains an “almanac”
that is updated periodically to take these changes into account.

If a GPS receiver has not been updated for a number of weeks, it may take up to an hour for the GPS
receiver “almanac” to be updated.

Once updated, the GPS receiver must track at least four satellites and obtain (hold) a 3–D position fix
for a minimum of 45 seconds before the CSM will come in service. (In some cases, the GPS receiver
needs to track only one satellite, depending on accuracy mode set during the data load).

3 NOTE
� If equipped with two CSMs, CSM–1 should be bright green (INS–ACT) and CSM–2 should be

dark green(INS–STB)

� If more than an hour has passed, refer to CSM Verification, see Figure 3-13 and Table 3-20 to
determine the cause.

After the CSMs have been successfully enabled, be sure the PWR/ALM LEDs are steady green
(alternating green/red indicates the card is in an alarm state).

 

Enable MCCs

This procedure configures the MCC and sets the “tx fine adjust”
parameter. The “tx fine adjust” parameter is not a transmit gain setting,
but a timing adjustment that compensates for the processing delay in the
BTS (approximately 3 �S).

Follow the steps outlined in Table 3-18 to enable the MCCs installed in
the SCCP shelves.

The MGLI and CSM must be downloaded and enabled,
prior to downloading and enabling the MCC.

IMPORTANT

*

Table 3-18: Enable MCCs

Step Action

1 Click on the target MCC(s) or from the Select pull down menu choose All MCCs.

2 From the Device menu, select Enable

A status report is displayed confirming change in the device(s) status.

3 Click OK to close the status report window.
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Clock Synchronization
Manager (CSM) System Time

The primary function of the Clock Synchronization Manager (CSM)
cards is to maintain CDMA system time. The CSM card in SCCP shelf
slot CSM–1 is the primary timing source while the card in slot CSM–2
provides redundancy. The second generation CSM card (CSM2) is
required when using the remote GPS receiver (R–GPS). R–GPS uses a
GPS receiver in the antenna head that has a digital output to the CSM2
card. A CSM2 card can have a local GPS receiver daughter card to
support an RF–GPS signal.

Each CSM2 card features a temperature–stablized, crystal oscillator that
provides 19.6608 MHz clock, even second pulse, and 3 MHz reference
signals to the synchronization source selected from the following (refer
to Table 3-20 for source selection/verification procedures):

� GPS: local/RF–GPS or remote/R–GPS

� LORAN–C Low Frequency Receiver (LFR) or High Stability
Oscillator (HSO)

� External reference oscillator sources

CDMA Clock Distribution Cards (CCDs) buffer and distribute
even–second reference and 19.6608 MHz clock signals from the CSM
cards. CCD 1 is married to the card in slot CSM–1, and CCD 2 is
married to the card in slot CSM–2.

The BTS switches between the primary and redundant units (card slots
CSM–1 and CSM–2, respectively) upon failure or command. A failure
in CSM–1 or CCD 1 will cause the system to switch to the
CSM–2–CCD 2 redundant card pair.

Fault management has the capability of switching between the GPS
synchronization source and the LFR/HSO backup source in the event of
a GPS receiver failure in CSM–1. During normal operation, the card in
CSM–1 selects GPS as the primary timing source (Table 3-20). The
source selection can also be overridden via the CDMA LMF or by the
system software.

In addition to providing GPS synchronization to the LFR or HSO
back–up sources, synchronization between the primary and redundant
CSM–CCD pairs increases reliability.

Low Frequency Receiver/
High Stability Oscillator

The CSM performs the overall configuration and status monitoring
functions of the LFR/HSO. In the event of GPS failure, the LFR/HSO is
capable of maintaining synchronization initially established by the GPS
reference signal.

The LFR requires an active external antenna to receive LORAN–C RF
signals. Timing pulses are derived from this signal, which is
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synchronized to Universal Time Coordinates (UTC) and GPS time. The
LFR can maintain system time indefinately after initial GPS lock.

The HSO is a high stability 10 MHz oscillator with the necessary
interface to the CSMs. The HSO is typically installed in those
geographical areas not covered by the LORAN–C system. Since the
HSO is a free–standing oscillator, system time can only be maintained
for 24 hours after 24 hours of GPS lock.

Upgrades and Expansions: LFR2/HSO2/HSOX

LFR2/HSO2 (second generation cards) both export a timing signal to the
expansion or logical BTS frames. The associated expansion or logical
frames require an HSO–expansion (HSOX) whether the starter frame has
an LFR2 or an HSO2. The HSOX accepts input from the starter frame
and interfaces with the CSM cards in the expansion frame. LFR and
LFR2 use the same source code in source selection (Table 3-20). HSO,
HSO2, and HSOX use the same source code in source selection
(Table 3-20).

Allow the base site and test equipment to warm up for
60 minutes after any interruption in oscillator power. CSM
card warm-up allows the oscillator oven temperature and
oscillator frequency to stabilize prior to test. Test
equipment warm-up allows the Rubidium standard
timebase to stabilize in frequency before any measurements
are made.

NOTE
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PRELIMINARY

CSM Frequency Verification

The objective of this procedure is the initial verification of the Clock
Synchronization Module (CSM) cards before performing the RF path
verification tests.

Test Equipment Setup 
(GPS & LFR/HSO Verification)

Follow the steps outlined in Table 3-19 to set up test equipment.

Table 3-19: Test Equipment Setup (GPS & LFR/HSO Verification)

Step Action

1a For local GPS (RF–GPS): Verify a CSM card with a GPS receiver is installed in the primary CSM
slot, CSM–1, and that CSM–1 is INS.

NOTE
This is verified by checking the card ejectors for kit number SGLN1145 on the card in slot 1.

1b For Remote GPS (RGPS): Verify a CSM2 card is installed in primary slot CSM–1 and that CSM–1 is
INS.

NOTE
This is verified by checking the card ejectors for kit number SGLN4132CC or subsequent.

2 Remove CSM–2 (if installed) and connect a serial cable from the LMF COM 1 port (via null modem
card) to the MMI port on CSM–1 (see Figure 3-13).

3 Reinstall CSM–2.

4 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-11) .

5 When the terminal screen appears press the Enter key until the CSM> prompt appears.

In the power entry compartment, connect the GPS antenna
to the RF GPS connector ONLY. Damage to the GPS
antenna and/or receiver can result if the GPS antenna is
inadvertently connected to any other RF connector.

CAUTION
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NULL MODEM
BOARD

(TRN9666A)

RS–232 SERIAL
MODEM CABLE

DB9–TO–DB25
ADAPTER

COM1

LMF
NOTEBOOK

Figure 3-13: CSM MMI Terminal Connection

FW00372

CSM card shown
removed from frame

19.6 MHZ TEST
POINT REFERENCE

(NOTE 1)

EVEN SECOND
TICK TEST POINT

REFERENCE

GPS RECEIVER
ANTENNA INPUT

GPS RECEIVER

MMI SERIAL
PORT

ANTENNA COAX
CABLE

REFERENCE
OSCILLATOR

9–PIN TO 9–PIN
RS–232 CABLE

NOTES:
1. One LED on each CSM:

Green = IN–SERVICE ACTIVE
Fast Flashing Green = OOS–RAM
Red = Fault Condition
Flashing Green & Red = Fault

GPS Initialization/Verification

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� The primary CSM and HSO (if equipped) has been warmed up for at
least 15 minutes.

� The CDMA LMF computer is connected to the MMI port of the
primary CSM as shown in Figure 3-13.

� A HyperTerminal session has been started (Table 3-11), and the CSM>
prompt is present in the HyperTerminal window (Table 3-19).

Follow the steps outlined in Table 3-20 to initialize and verify proper
GPS receiver functioning.
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Table 3-20: GPS Initialization/Verification

Step Action

1 To verify that Clock alarms (0000), Dpll is locked and has a reference source, and
GPS self test passed messages are displayed within the report, issue the following MMI
command

bstatus

– The system will display a response similiar to the following:

CSM Status INS:ACTIVE Slot A Clock MASTER.

BDC_MAP:000, This CSM’s BDC Map:0000

Clock Alarms (0000):

DPLL is locked and has a reference source.
GPS receiver self test result: passed

Time since reset 0:33:11, time since power on: 0:33:11

2 Enter the following command at the CSM> prompt to display the current status of the Loran and GPS
receivers:

sources

– When equipped with LFR, the system will generate a response similar to the following:

N Source Name Type TO Good Status Last Phase Target Phase Valid
–––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 LocalGPS Primary 4 YES Good 0 0 Yes
1 LFR CHA Secondary 4 YES Good –2013177 –2013177 Yes
2 Not Used
Current reference source number: 0

– When equipped with HSO, the system will generate a response similar to the following:

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 No N/A timed–out* Timed–out* No

*NOTE “Timed–out” should only be displayed while the HSO is warming up. “Not–Present” or
“Faulty” should not be displayed. If the HSO does not appear as one of the sources, then configure the
HSO as a back–up source by entering the following command at the CSM> prompt:

ss 1 12

After a maximum of 15 minutes, the Rubidium oscillator should reach operational temperature and the
LED on the HSO should now have changed from red to green. After the HSO front panel LED has
changed to green, enter sources <cr> at the CSM> prompt. Verify that the HSO is now a valid source
by confirming that the bold text below matches the response of the “sources” command.

The HSO should be valid within one (1) minute, assuming the DPLL is locked and the HSO rubidium
oscillator is fully warmed.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good 3 0 Yes
1 HSO Backup 4 Yes N/A xxxxxxxxxx xxxxxxxxxx Yes

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

3 HSO information (underlined text above, verified from left to right) is usually the #1 reference source.
If this is not the case, have the OMCR determine the correct BTS timing source has been identified in
the database by entering the display bts csmgen command and correct as required using the edit
csm csmgen refsrc command.

* IMPORTANT
If any of the above areas fail, verify:

– If LED is RED, verify that HSO had been powered up for at least 5 minutes. After oscillator
temperature is stable, LED should go GREEN Wait for this to occur before continuing !

– If “timed out” is displayed in the Last Phase column, suspect the HSO output buffer or oscillator
is defective

– Verify the HSO is FULLY SEATED and LOCKED to prevent any possible card warpage

4 Verify the following GPS information (underlined text above):

– GPS information is usually the 0 reference source.

– At least one Primary source must indicate “Status = good” and “Valid = yes” to bring site up.

. . . continued on next page
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Table 3-20: GPS Initialization/Verification

Step Action

5 Enter the following command at the CSM> prompt to verify that the GPS receiver is in tracking mode.

gstatus

– Observe the following typical response:

24:06:08 GPS Receiver Control Task State: tracking satellites.
24:06:08 Time since last valid fix: 0 seconds.
24:06:08 
24:06:08 Recent Change Data:
24:06:08 Antenna cable delay 0 ns.
24:06:08 Initial position: lat 117650000 msec, lon –350258000 msec, height 0 cm (GPS)
24:06:08 Initial position accuracy (0): estimated.
24:06:08 
24:06:08 GPS Receiver Status:
24:06:08 Position hold:  lat 118245548 msec, lon –350249750 msec, height 20270 cm
24:06:08 Current position: lat 118245548 msec, lon –350249750 msec, height 20270 cm
(GPS)
24:06:08 8 satellites tracked, receiving 8 satellites, 8 satellites visible.
24:06:08 Current Dilution of Precision (PDOP or HDOP): 0.
24:06:08 Date & Time: 1998:01:13:21:36:11
24:06:08 GPS Receiver Status Byte: 0x08
24:06:08 Chan:0, SVID: 16, Mode: 8, RSSI: 148, Status: 0xa8
24:06:08 Chan:1, SVID: 29, Mode: 8, RSSI: 132, Status: 0xa8
24:06:08 Chan:2, SVID: 18, Mode: 8, RSSI: 121, Status: 0xa8
24:06:08 Chan:3, SVID: 14, Mode: 8, RSSI: 110, Status: 0xa8
24:06:08 Chan:4, SVID: 25, Mode: 8, RSSI:  83, Status: 0xa8
24:06:08 Chan:5, SVID:  3, Mode: 8, RSSI:  49, Status: 0xa8
24:06:08 Chan:6, SVID: 19, Mode: 8, RSSI: 115, Status: 0xa8
24:06:08 Chan:7, SVID: 22, Mode: 8, RSSI: 122, Status: 0xa8
24:06:08 
24:06:08 GPS Receiver Identification:
24:06:08 COPYRIGHT 1991–1996 MOTOROLA INC. 
24:06:08 SFTW P/N # 98–P36830P      
24:06:08 SOFTWARE VER # 8           
24:06:08 SOFTWARE REV # 8           
24:06:08 SOFTWARE DATE  6 AUG 1996 
24:06:08 MODEL #    B3121P1115      
24:06:08 HDWR P/N # _               
24:06:08 SERIAL #   SSG0217769      
24:06:08 MANUFACTUR DATE 6B07       
24:06:08 OPTIONS LIST    IB        
24:06:08 The receiver has 8 channels and is equipped with TRAIM.

6 Verify the following GPS information (shown above in underlined text):

– At least 4 satellites are tracked, and 4 satellites are visible.

– GPS Receiver Control Task State is “tracking satellites”. Do not continue until this occurs!

– Dilution of Precision indication is not more that 30.

Record the current position base site latitude, longitude, height and height reference (height reference
to Mean Sea Level (MSL) or GPS height (GPS). (GPS = 0   MSL = 1).

. . . continued on next page

3



CSM System Time – GPS & LFR/HSO Verification – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/20013-44

Table 3-20: GPS Initialization/Verification

Step Action

7 If steps 1 through 6 pass, the GPS is good.

* IMPORTANT
If any of the above mentioned areas fail, verify that:

– If Initial position accuracy is “estimated” (typical), at least 4 satellites must be tracked and
visible (1 satellite must be tracked and visible if actual lat, log, and height data for this site has
been entered into CDF file).

– If Initial position accuracy is “surveyed,” position data currently in the CDF file is assumed to be
accurate. GPS will not automatically survey and update its position.

– The GPS antenna is not obstructed or misaligned.

– GPS antenna connector center conductor measureS approximately +5 Vdc with respect to the
shield.

– There is no more than 4.5 dB of loss between the GPS antenna OSX connector and the BTS frame
GPS input.

– Any lightning protection installed between GPS antenna and BTS frame is installed correctly.

8 Enter the following commands at the CSM> prompt to verify that the CSM is warmed up and that GPS
acquisition has taken place.

debug dpllp 

Observe the following typical response if the CSM is not warmed up (15 minutes from application of
power) (If warmed–up proceed to step 9)

CSM>DPLL Task Wait. 884 seconds left.
DPLL Task Wait. 882 seconds left.
DPLL Task Wait. 880 seconds left.   ...........etc.

NOTE
The warm command can be issued at the MMI port used to force the CSM into warm–up, but the
reference oscillator will be unstable.

9 Observe the following typical response if the CSM is warmed up.

c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17486 off: –11, 3, 6 TK SRC:0 S0: 3 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175
c:17470 off: –11, 1, 6 TK SRC:0 S0: 1 S1:–2013175,–2013175

10 Verify the following GPS information (underlined text above, from left to right):

– Lower limit offset from tracked source variable is not less than –60 (equates to 3µs limit).

– Upper limit offset from tracked source variable is not more than +60 (equates to 3µs limit).

– TK SRC: 0 is selected, where SRC 0 = GPS.

11 Enter the following commands at the CSM> prompt to exit the debug mode display.

debug  dpllp
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LORAN–C
Initialization/Verification

Table 3-21: LORAN–C Initialization/Verification

Step Action Note

1 At the CSM> prompt, enter lstatus <cr> to verify that the LFR is in tracking
mode. A typical response is:

CSM> lstatus <cr>
LFR St ti St tLFR Station Status:
Clock coherence: 512 >
5930M 51/60 dB 0 S/N Flag:
5930X 52/64 dn –1 S/N Flag:
5990 47/55 dB –6 S/N Flag:
7980M 62/66 dB 10 S/N Fl

This must be greater
than 100 before LFR
becomes a valid source.

7980M 62/66 dB 10 S/N Flag:
7980W 65/69 dB 14 S/N Flag: . PLL Station . >
7980X 48/54 dB –4 S/N Flag:
7980Y 46/58 dB –8 S/N Flag:E
7980Z 60/67 dB 8 S/N Flag:
8290M 50/65 dB 0 S/N Flag

This shows the LFR is
locked to the selected
PLL station.

8290M 50/65 dB 0 S/N Flag:
8290W 73/79 dB 20 S/N Flag:
8290W 58/61 dB 6 S/N Flag:8290W 58/61 dB 6 S/N Flag:
8970M 89/95 dB 29 S/N Flag:
8970W 62/66 dB 10 S/N Flag:
8970X 73/79 dB 22 S/N Flag:8970X 73/79 dB 22 S/N Flag:
8970Y 73/79 dB 19 S/N Flag:
8970Z 62/65 dB 10 S/N Flag:
9610M 62/65 dB 10 S/N Fl

g
9610M 62/65 dB 10 S/N Flag:
9610V 58/61 dB 8 S/N Flag:
9610W 47/49 dB –4 S/N Flag:E9610W 47/49 dB –4 S/N Flag:E
9610X 46/57 dB –5 S/N Flag:E
9610Y 48/54 dB –5 S/N Flag:E
9610Z 65/69 dB 12 S/N Flag9610Z 65/69 dB 12 S/N Flag:
9940M 50/53 dB –1 S/N Flag:S
9940W 49/56 dB –4 S/N Flag:E9940W 49/56 dB 4 S/N Flag:E
9940Y 46/50 dB–10 S/N Flag:E
9960M 73/79 dB 22 S/N Flag:
9960W 51/60 dB 0 S/N Flag:9960W 51/60 dB 0 S/N Flag:
9960X 51/63 dB –1 S/N Flag:
9960Y 59/67 dB 8 S/N Flag:
9960Z 89/96 dB 29 S/N Fl9960Z 89/96 dB 29 S/N Flag:

LFR Task State: lfr locked to station 7980W
LFR Recent Change Data:

Search List: 5930 5990 7980 8290 8970 9940 9610 9960 >
PLL GRI: 7980W

LFR Master, reset not needed, not the reference source.
CSM>

This search list and PLL
data must match the
configuration for the
geographical location
of the cell site.

. . . continued on next page
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Table 3-21: LORAN–C Initialization/Verification

Step NoteAction

2 Verify the following LFR information (highlighted above in boldface type):

– Locate the “dot” that indicates the current phase locked station assignment (assigned by MM).

– Verify that the station call letters are as specified in site documentation as well as M X Y Z
assignment.

– Verify the S/N ratio of the phase locked station is greater than 8.

3 At the CSM> prompt, enter sources <cr> to display the current status of the the LORAN receiver.

– Observe the following typical response.

Num Source Name Type TO Good Status Last Phase Target Phase Valid
––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––––
0 Local GPS Primary 4 Yes Good –3 0 Yes
1 LFR ch A Secondary 4 Yes Good –2013177 –2013177 Yes
2 Not used
Current reference source number: 1

*NOTE “Timed–out” should only be displayed while the LFR is warming up. “Not–Present” or
“Faulty” should not be displayed. If the LFR does not appear as one of the sources, then configure the
LFR as a back–up source by entering the following command at the CSM> prompt:

ss 1 2

4 LORAN LFR information (highlighted above in boldface type) is usually the #1 reference source
(verified from left to right).

* IMPORTANT
If any of the above mentioned areas fail, verify:

– The LFR antenna is not obstructed or misaligned.

– The antenna pre–amplifier power and calibration twisted pair connections are intact and < 91.4 m
(300 ft) in length.

– A dependable connection to suitable Earth Ground is in place.

– The search list and PLL station for cellsite location are correctly configured .

NOTE
LFR functionality should be verified using the “source” command (as shown in Step 3). Use the
underlined responses on the LFR row to validate correct LFR operation.

5 Close the hyperterminal window.
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Connecting Test Equipment to
the BTS

All test equipment is controlled by the LMF through an IEEE–488/GPIB
bus. The LMF requires each piece of test equipment to have a factory set
GPIB address. If there is a communications problem between the LMF
and any piece of test equipment, verify that the GPIB addresses have
been set correctly as follows:

� Power meter address should be 13

� Communications test set should be 18

The following test equipment is required to perform optimization,
calibration and ATP tests:

� CDMA LMF

� Communications test set model supported by the CDMA LMF

� Power meter model supported by the CDMA LMF (required when
using the HP 8921A/600 and Advantest R3465 test sets)

� Non–radiating transmit line termination load

� Directional coupler and in–line attenuator

� RF cables and adapters

Refer to Table 3-22 for an overview of connections for test equipment
currently supported by the CDMA LMF. In addition, see the following
figures:

� Figure 3-15 and Figure 3-16 show the test set connections for TX
calibration

� Figure 3-17 and Figure 3-18 show the test set connections for
optimization/ATP tests

Supported Test Equipment

Optimization and ATP testing may be performed using the following test
equipment:

� CyberTest

� Advantest R3465 and HP–437B or Gigatronics Power Meter

� Hewlett–Packard HP 8935

� Hewlett–Packard HP 8921 (W/CDMA and PCS Interface (1.9 GHz))
and HP–437B or Gigatronics Power Meter

� Spectrum Analyzer (HP8594E) – optional

� Rubidium Standard Timebase – optional

To prevent damage to the test equipment, all transmit (TX)
test connections must be through a 30 dB directional
coupler plus a 20 dB in-line attenuator for both the 800
MHz and 1.9 GHz BTSs.

CAUTION
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Test Equipment Preparation

For specific steps to prepare each type of test set and power meter to
perform calibration and ATP, see Appendix F.

Test Equipment Connection
Chart

Table 3-22 depicts the current test equipment available meeting Motorola
standards.

To identify the connection ports, locate the test equipment presently
being used in the TEST SETS columns, and read down the column.
Where a ball appears in the column, connect one end of the test cable to
that port. Follow the horizontal line to locate the end connection(s),
reading up the column to identify the appropriate equipment/BTS port.

Table 3-22: Test Equipment Setup
TEST SETS ADDITIONAL TEST EQUIPMENT

SIGNAL
Cyber–

Test
Ad-

vantest
HP

8935
HP

8921A

HP
8921

W/PCS
Power
Meter

GPIB
Inter-
face LMF

Directional
Coupler & Pad* BTS

EVEN SECOND 
SYNCHRONIZATION

EVEN
SEC REF

EVEN SEC
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

EVEN
SECOND
SYNC IN

19.6608 MHZ
CLOCK

TIME
BASE IN

CDMA
TIME BASE

IN
EXT

REF IN

CDMA
TIME BASE

IN

CDMA
TIME BASE

IN

CONTROL
IEEE 488 BUS

IEEE
488 GPIB HP–IB HP–IB GPIB

SERIAL
PORTHP–IB HP–IB

TX TEST
CABLES

RF
IN/OUT

INPUT
50–OHM

RF
IN/OUT TX1–6

RF
IN/OUT

RF
IN/OUT

20 DB
PAD

BTS
PORT

RX TEST
CABLES

RF IN/
OUT

RF OUT
50–OHM DUPLEX RX1–12

DUPLEX
OUT

RF OUT
ONLY

SYNC
MONITOR

FREQ
MONITOR
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Equipment Warm-up

Warm-up BTS equipment for a minimum of 60 minutes
prior to performing the BTS optimization procedure. This
assures BTS site stability and contributes to optimization
accuracy. (Time spent running initial power-up,
hardware/firmware audit, and BTS download counts as
warm-up time.)

IMPORTANT

*

Before installing any test equipment directly to any BTS
TX OUT connector, verify there are no CDMA BBX
channels keyed. At active sites, have the OMC-R/CBSC
place the antenna (sector) assigned to the LPA under test
OOS. Failure to do so can result in serious personal injury
and/or equipment damage.

WARNING

Automatic Cable Calibration
Set–up

Figure 3-14 shows the cable calibration setup for various supported test
sets. The left side of the diagram depicts the location of the input and
output ports of each test set, and the right side details the set up for each
test. Table 3-26 provides a procedure for calibrating cables.

3



Test Equipment Set–up  – continued

PRELIMINARY1X SC�4812ET Lite BTS Optimization/ATP 08/01/20013-50
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Motorola CyberTest

Hewlett–Packard Model HP 8935

Advantest Model R3465

DUPLEX
OUT

RF OUT
50–OHM

INPUT
50–OHM

RF GEN OUTANT IN

ANT
IN

SUPPORTED TEST SETS

100–WATT  (MIN)
NON–RADIATING

RF LOAD

TEST
SET

A. SHORT CABLE CAL

SHORT
CABLE

B. RX TEST SETUP

TEST
SET

C. TX TEST SETUP

20 DB IN–LINE
ATTENUATOR
FOR 1.9 GHZ

CALIBRATION SET UP

N–N FEMALE
ADAPTER

TX
CABLE

TX
CABLE

SHORT
CABLE

Note: The Directional Coupler is not used with the
Cybertest Test Set. The TX cable is connected
directly to the Cybertest Test Set.

A 10dB attenuator must be used with the short test
cable for cable calibration with the CyberTest Test
Set. The 10dB attenuator is used only for the cable
calibration procedure, not with the test cables for
TX calibration and ATP tests.

TEST
SET

RX
CABLE

SHORT
CABLE

Figure 3-14: Cable Calibration Test Setup

FW00089

Note: For 800 MHZ only. The HP8921A cannot
be used to calibrate cables for PCS frequencies.

Hewlett–Packard Model HP 8921A

DIRECTIONAL
COUPLER 
(30 DB)

N–N FEMALE
ADAPTER

50 Ω
ΤERM.
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Manual Cable Calibration

If manual cable calibration is required, refer to the procedures in
Appendix F.

Set–up for TX Calibration

Figure 3-15 and Figure 3-16 show the test set connections for TX
calibration.

ÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁ
ÁÁ

Motorola CyberTest

Hewlett–Packard Model HP 8935

TEST SETS TRANSMIT (TX) SET UP

ÏÏÏ
ÏÏÏÌ

Ì

FRONT PANEL
RF

IN/OUT

RF IN/OUT

HP–IB
TO GPIB
BOX

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

COMMUNICATIONS
TEST SET

CONTROL
IEEE 488
GPIB BUS

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232
NULL
MODEM
CABLE

OUT

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS

G MODE

ON

TEST SET
INPUT/

OUTPUT
PORTS

BTS

100–WATT  (MIN)
NON–RADIATING
RF LOAD

IN

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH
SETTINGS**

2O DB
IN–LINE
ATTENUATOR

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

TX TEST
CABLE

TX ANTENNA
PORT OR TX

RFDS
DIRECTIONAL

COUPLERS

POWER
METER

(OPTIONAL)*

NOTE: THE DIRECTIONAL COUPLER IS NOT USED WITH THE
CYBERTEST TEST SET. THE TX CABLE IS CONNECTED DIRECTLY
TO THE CYBERTEST TEST SET.

* A POWER METER CAN BE USED IN PLACE
OF THE COMMUNICATIONS TEST SET FOR TX
CALIBRATION/AUDIT

POWER
SENSOR

Figure 3-15: TX Calibration Test Setup (CyberTest and HP 8935)

FW00094

DIRECTIONAL
COUPLER
(30 DB)

** BLACK PORTION OF THE
DIAGRAM REPRESENTS THE
RAISED PART OF THE
SWITCH

50 Ω
ΤERM.
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POWER METER

TEST SETS TRANSMIT (TX) SET UP

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232
NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

100–WATT  (MIN)
NON–RADIATING
RF LOAD

TX
TEST
CABLE

CDMA
LMF

DIP SWITCH
SETTINGS*

2O DB
IN–LINE
ATTENUATOR

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

TX ANTENNA GROUP
OR TX RFDS DIRECTIONAL
COUPLERS

TX
TEST
CABLE

POWER
SENSOR

FW00095

NOTE: THE HP8921A AND ADVANTEST
CANNOT BE USED FOR TX CALIBRATION. A
POWER METER MUST BE USED.

Figure 3-16: TX Calibration Test Setup HP 8921A and Advantest

DIRECTIONAL COUPLER
(30 DB)

* BLACK PORTION OF THE
DIAGRAM REPRESENTS THE
RAISED PART OF THE
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Setup for Optimization/ATP

Figure 3-17 and Figure 3-18 show the test set connections for
optimization/ATP tests.

ÁÁÁÁÁÁÁÁÁÁ
ÁÁ
ÁÁÁÁÁ
Á
Á
Á

Motorola CyberTest

Hewlett–Packard Model HP 8935

DUPLEX OUT

TEST SETS Optimization/ATP SET UP

ÏÏÏÏ
ÏÏÏÏ
ÏÏÏÏÌ

RF
IN/OUT

SYNC MONITOR
EVEN SEC TICK

PULSE REFERENCE
FROM CSM BOARD

FREQ MONITOR
19.6608 MHZ CLOCK
REFERENCE FROM
CSM BOARD

RF IN/OUT

HP–IB
TO GPIB
BOX

Advantest Model R3465

INPUT
50–OHM

GPIB CONNECTS
TO BACK OF UNIT

NOTE: The Directional Coupler is not used
with the Cybertest Test Set. The TX cable is
connected directly to the Cybertest Test set.

RF OUT

RX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

TX ANTENNA
PORT OR RFDS
RX ANTENNA
DIRECTIONAL

COUPLER

RS232–GPIB
INTERFACE BOX

INTERNAL PCMCIA
ETHERNET CARD

GPIB
CABLE

UNIVERSAL TWISTED
PAIR (UTP) CABLE

(RJ45 CONNECTORS)

RS232 NULL
MODEM
CABLE

S MODE
DATA FORMAT

BAUD RATE

GPIB ADRS G MODE

ON

BTS

TX
TEST
CABLE

CDMA
LMF

DIPSWITCH SETTINGS*

10BASET/
10BASE2
CONVERTER

LAN
B

LAN
A

RX
TEST
CABLE

COMMUNICATIONS
TEST SET

IEEE 488
GPIB BUS

IN

TEST SET
INPUT/

OUTPUT
PORTS

OUT

NOTE:  IF BTS RX/TX SIGNALS ARE
DUPLEXED, BOTH THE TX AND RX TEST
CABLES CONNECT TO THE DUPLEXED
ANTENNA GROUP AND USE THE 30 DB
DIRECTIONAL COUPLER AND 20 DB IN–LINE
ATTENUATOR.

100–WATT  (MIN)
NON–RADIATING

RF LOAD

2O DB
IN–LINE
ATTENUATOR

DIRECTIONAL
COUPLER
(30 DB)

EVEN
SECOND/SYNC
IN (BNC “T”
WITH 50 OHM
TERMINATOR)

CDMA
TIMEBASE

 IN

FREQ
MONITOR

SYNC
MONITOR

CSM

FW00096

Figure 3-17: Optimization/ATP Test Setup Calibration (CyberTest, HP 8935 and Advantest)
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Figure 3-18: Optimization/ATP Test Setup HP 8921A
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Background

Proper test equipment set–up ensures that all measurements are correct
and the test equipment and associated test cables do not introduce
measurement errors.

If the test equipment set (see Chapter 1, Terms and
Abbreviations) being used to interface with the BTS has
been calibrated and maintained as a set, this procedure does
not need to be performed.

NOTE

This procedure must be performed before the optimization. Verify all test
equipment (including all associated test cables and adapters actually used
to interface all test equipment and the BTS) has been calibrated and
maintained as a set.

If any piece of test equipment, test cable, or RF adapter,
that makes up the calibrated test equipment set has been
replaced, the set must be re-calibrated. Failure to do so can
introduce measurement errors, resulting in incorrect
measurements and degradation to system performance.
Motorola recommends repeating cable calibration before
testing at each BTS site.

CAUTION

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test set. Calibrate the test equipment
after it has been allowed to warm–up and stabilize for a
minimum of 60 minutes.

IMPORTANT

*

Purpose

These procedures access the CDMA LMF automated calibration routine
used to determine the path losses of the supported communications
analyzer, power meter, associated test cables, and (if used) antenna
switch that make up the overall calibrated test equipment set. After
calibration, the gain/loss offset values are stored in a test measurement
offset file on the CDMA LMF.
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Manual cable calibration procedures using the HP8921A and Advantest
R3465 communications test sets are provided in Appendix F, if needed.
Manual power meter calibration procedures are also included in
Appendix F.

Selecting Test Equipment

Prerequisites

A Serial Connection and a Network Connection tab are provided for
test equipment selection. The Serial Connection tab is used when the
test equipment items are connected directly to the CDMA LMF
computer via a GPIB box (normal setup). The Network Connection tab
is used when the test equipment is to be connected remotely via a
network connection.

Ensure the following has been completed before selecting test
equipment:

� Test equipment is correctly connected and turned on.

� Test equipment GPIB addresses have been verified as correct.

� CDMA LMF computer serial port and test equipment are connected to
the GPIB box.

Selecting Test Equipment

Use Options > LMF Options in the menu bar to select test equipment
automatically (using the autodetect feature) or manually.

Manually Selecting Test
Equipment in a Serial
Connection Tab

Test equipment can be manually specified before, or after, the test
equipment is connected. CDMA LMF does not check to see if the test
equipment is actually detected for manual specification.

Table 3-23: Selecting Test Equipment Manually in a Serial Connection Tab

Step Action

1 In the menu bar, click Options and select LMF Options... from the pulldown. The LMF Options
window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on the Manual Specification button (if not enabled).

5 Click on the check box corresponding to the test item(s) to be used.

6 Type the GPIB address in the corresponding GPIB address box. Addresses are:
13=Power Meter
18=CDMA Analyzer

. . . continued on next page
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Table 3-23: Selecting Test Equipment Manually in a Serial Connection Tab

Step Action

7 Click on Apply. (The button will darken until the selection has been recorded.)

NOTE
With manual selection, CDMA LMF does not detect the test equipment to see if it is connected and
communicating with CDMA LMF.

8 Click on Dismiss to close the test equipment window.

 

Automatically Selecting Test
Equipment in a Serial
Connection Tab

When using the auto-detection feature to select test equipment, the
CDMA LMF examines which test equipment items are actually
communicating with CDMA LMF. Follow the procedure in Table 3-24
to use the auto-detect feature.

Table 3-24: Selecting Test Equipment Using Auto-Detect

Step Action

1 In the menu bar, click Options and select LMF Options... from the pulldown. The LMF Options
window appears.

2 Click on the Serial Connection tab (if not in the forefront).

3 Select the correct serial port in the COMM Port pick list (normally COM1).

4 Click on Auto–Detection (if not enabled).

5 Type in the GPIB addresses in the box labeled GPIB address to search (if not already displayed).

* IMPORTANT
When both a power meter and analyzer are selected, the first item listed in the GPIB addresses to
search box will be used for RF power measurements (i.e., TX calibration). The address for a power
meter is normally 13 and the address for a CDMA analyzer is normally 18. If 13,18 is included in the
GPIB addresses to search box, the power meter (13) will be used for RF power measurements. If the
test equipment items are manually selected the CDMA analyzer is used only if a power meter is not
selected.

6 Click Apply. The button will darken until the selection has been committed. A check mark will appear
in the Manual Configuration section for detected test equipment items.

7 Click Dismiss to close the LMF Options window.
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Calibrating Test Equipment

The calibrate test equipment function zeros the power measurement level
of the test equipment item that is to be used for TX calibration and audit.
If both a power meter and an analyzer are connected (for example, an HP
437 and an HP8921A/600), only the power meter is zeroed.

Calibrate Test Equipment from the Util menu list is used to calibrate
test equipment item before being used for testing. The test equipment
must be selected before beginning calibration. Follow the procedure in
Table 3-25 to calibrate the test equipment.

Table 3-25: Test Equipment Calibration

Step Action

1 From the Util menu, select Calibrate Test Equipment. A Directions window is displayed. Follow
the instructions provided.

2 Follow the direction provided.

3 Click on Continue to close the Directions window. A status window is displayed.

4 Click on OK to close the status report window.

 

Calibrating Cables – Overview

The cable calibration function is used to measure the loss (in dB) for the
TX and RX cables that are to be used for testing. A CDMA analyzer is
used to measure the loss of each cable configuration (TX cable
configuration and RX cable configuration). The cable calibration
consists of the following steps.

� Measure the loss of a short cable. This is done to compensate for any
measurement error of the analyzer. The short cable, which is used only
for the calibration process, is used in series with both the TX and RX
cable configuration when they are measured. The measured loss of the
short cable is deducted from the measured loss of the TX and RX
cable configuration to determine the actual loss of the TX and RX
cable configurations. This deduction is done so any error in the
analyzer measurement will be adjusted out of both the TX and RX
measurements.

� The short cable plus the RX cable configuration loss is measured. The
RX cable configuration normally consists only of a coax cable with
type–N connectors that is long enough to reach from the BTS RX port
the test equipment. For BTSs with antenna ports carrying duplexed TX
and RX, a directional coupler and, if required by BTS type, an
additional attenuator are also used on the RX cable configuration and
must be included in the measurement.

� The short cable plus the TX cable configuration loss is measured. The
TX cable configuration normally consists of two coax cables with
type–N connectors and a directional coupler, a load, and an additional
attenuator if required by the BTS type. The total loss of the path loss
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of the TX cable configuration must be as required for the BTS
(normally 30 or 50 dB). The Motorola Cybertest analyzer is different
in that the required attenuation/load is built into the test set so the TX
cable configuration consists only of the required length coax cable.

Calibrating Cables with a
CDMA Analyzer

The Cable Calibration menu item from the Util menu list is used to
calibrate both TX and RX test cables for use with CDMA LMF.

LMF cable calibration cannot be accomplished with an
HP8921A analyzer for 1.9 MHz. A different analyzer type
or the signal generator and spectrum analyzer method must
be used (refer to Table 3-27 and Table 3-28). Cable
calibration values must be manually entered if the signal
generator and spectrum analyzer method is used. For the
HP8921A, refer to Appendix F.

NOTE

The test equipment must be selected before this procedure can be started.
Follow the procedure in Table 3-26 to calibrate the cables. Figure 3-14
illustrates the cable calibration test equipment setup.

Table 3-26: Cable Calibration

Step Action

1 From the Util menu, select Cable Calibration. A Cable Calibration window is displayed.

2 Enter a channel number(s) in the Channels box. Multiple channels numbers must be separated with a
comma, no space (i.e., 200,800). When two or more channels numbers are entered, the cables will be
calibrated for each channel. Interpolation will be accomplished for other channels as required for TX
calibration.

3 Select TX and RX CABLE CAL, TX CABLE CAL or RX CABLE CAL in the Cable Calibration
picklist.

4 Click OK. Follow the directions displayed for each step. A status report window will be displayed
with the results of the cable calibration.
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Calibrating TX Cables Using a
Signal Generator and Spectrum
Analyzer

Follow the procedure in Table 3-27 to calibrate the TX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-19 for a
diagram of the signal generator and spectrum analyzer.

Table 3-27: Calibrating TX Cables Using Signal Generator and Spectrum Analyzer

Step Action

1 Connect a short test cable between the spectrum analyzer and the signal generator.

2 Set signal generator to 0 dBm at the customer frequency of the 869.7–893.31 MHz band for North
American cellular and 1930–1990 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-19, “A”) and record the value.

4 Connect the spectrum analyzer’s short cable to point “B”, as shown in the lower portion of the
diagram, to measure cable output at customer frequency (869.7–893.31 MHz band for North American
cellular and 1930–1990 MHz for North American PCS) and record the value at point “B”.

5 Calibration factor = A – B  Example: Cal = –1 dBm – (–53.5 dBm) = 52.5 dB

NOTE
The short cable is used for calibration only. It is not part of the final test setup. After calibration is
completed, do not re-arrange any cables. Use the equipment setup, as is, to ensure test procedures use
the correct calibration factor.

 

Figure 3-19:  Calibrating Test Equipment Setup for TX Cable Calibration
(Using Signal Generator and Spectrum Analyzer)
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Calibrating RX Cables Using a
Signal Generator and Spectrum
Analyzer

Follow the procedure in Table 3-28 to calibrate the RX cables using the
signal generator and spectrum analyzer. Refer to Figure 3-20, if required.

Table 3-28: Calibrating RX Cables Using a Signal Generator and Spectrum Analyzer

Step Action

1 Connect a short test cable to the spectrum analyzer and connect the other end to the Signal Generator.

2 Set signal generator to –10 dBm at the customer’s RX frequency of 824.7–848.31 MHz for North
American cellular or 1850–1910 MHz band for North American PCS.

3 Use spectrum analyzer to measure signal generator output (see Figure 3-20, “A”) and record the value
for “A”.

4 Connect the test setup, as shown in the lower portion of the diagram, to measure the output at the
customer’s RX frequency (824.7–848.31 MHz for North American cellular or 1850–1910 MHz band
for North American PCS). Record the value at point ‘‘B”.

* IMPORTANT
When preparing to calibrate a BTS with duplexed TX and RX the cable calibration setup must include
the 30 dB directional coupler and 20 dB in–line attenuator as in the TX cable calibration shown in
Figure 3-19.

5 Calibration factor = A – B
Example: Cal = –12 dBm – (–14 dBm) = 2 dB

NOTE
The short test cable is used for test equipment setup calibration only. It is not part of the final test
setup. After calibration is completed, do not re-arrange any cables. Use the equipment setup, as is, to
ensure test procedures use the correct calibration factor.

 

Figure 3-20:  Calibrating Test Equipment Setup for RX ATP Test
(Using Signal Generator and Spectrum Analyzer)
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Setting Cable Loss Values
Cable loss values for the TX and RX test cable configurations are
normally set by accomplishing automatic cable calibration with use of
the applicable test equipment. The resulting values are stored in the cable
loss files. The cable loss values can also be set/changed manually.

Cable loss values must be manually entered in the LMF
database if manual cable calibration was performed.
Failure to do this will result in inaccurate BTS calibration
and reduced site performance.

CAUTION

Prerequisites

� Logged into the BTS

Table 3-29: Setting Cable Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit > Cable Loss > TX or RX. A data entry pop–up window will appear.

3 Click on the Add Row button to add a new channel number. Then click in the Channel # and Loss
(dBm) columns and enter the desired values.

4 To edit existing values click in the data box to be changed and change the value.

5 To delete a row, click on the row and then click on the Delete Row button.

6 Click on the Save button to save displayed values.

7 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
� If cable loss values exist for two different channels the LMF will interpolate for all other channels.

� Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Setting TX Coupler Loss Value
If an in–service TX coupler is installed the coupler loss (e.g., 30 dB)
must be manually entered so it will be included in the LMF TX
calibration and audit calculations.

Prerequisites

� Logged into the BTS

Table 3-30: Setting TX Coupler Loss Values

Step Action

1 Click on the Util menu.

2 Select Edit > TX Coupler Loss. A data entry pop–up window will appear.

3 Click in the Loss (dBm) column for each carrier that has a coupler and enter the appropriate value.

4 To edit existing values click in the data box to be changed and change the value.

5 Click on the Save button to save displayed values.

6 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
� The In–Service Calibration check box in the Options > LMF Options > BTS Options tab must

checked before entered TX coupler loss values will be used by the TX calibration and audit
functions.

� Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Introduction

Calibration compensates for normal equipment variations within the
BTS and assures maximum measurement accuracy.

RF Path Bay Level Offset
Calibration

Bay Level Offset (BLO) calibration identifies the accumulated gain in
every transmit path (BBX2 slot) at the BTS site and stores that value in
the CDMA LMF CAL file. The BLOs are subsequently downloaded to
each BBX2.

Each transmit path starts at an SCCP shelf backplane BBX2 slot, travels
through the CIO card, trunking module, LPA, trunking module (again),
TX filter or TX filter combiner, DRDC or TRDC, and ends at a BTS TX
antenna port.

Each receive path starts at a BTS RX antenna port, travels through a
DRDC or TRDC, the MPC card, the CIO card, and terminates at a
backplane BBX2 slot.

Calibration identifies the accumulated gain in every transmit path ( by
BBX2 slot) at the BTS site and stores that value in the CAL file. When
the TX path calibration is performed, the RX path BLO will
automatically be set to the default value.

When to Calibrate BLOs
Calibration of BLOs is required after initial BTS installation.

The BLO data of an operational BTS site must be re-calibrated once
each year. Motorola recommends re-calibrating the BLO data for all
associated RF paths after replacing any of the following components or
associated interconnecting RF cabling:

� BBX2 board

� SCCP shelf

� CIO card

� CIO–to–LPA trunking module RF cable

� LPA trunking module

� LPA

� Trunking module–to–TX filter/filter combiner RF cable

� TX filter or TX filter combiner

� TX filter/filter combiner–to–DRDC/TRDC cable

� DRDC or TRDC
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TX Path Calibration

The TX Path Calibration assures correct site installation, cabling, and the
first order functionality of all installed equipment. The proper function
of each RF path is verified during calibration. The external test
equipment is used to validate/calibrate the TX paths of the BTS.

Before installing any test equipment directly to any TX
OUT connector you must first verify that there are no
CDMA channels keyed. Have the OMC–R place the sector
assigned to the LPA under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

WARNING

Always wear a conductive, high impedance wrist strap
while handling any circuit card/module. If this is not done,
there is a high probability that the card/module could be
damaged by ESD.

CAUTION

At new site installations, to facilitate the complete test of
each SCCP shelf (if the shelf is not already fully populated
with BBX2 boards), move BBX2 boards from shelves
currently not under test and install them into the empty
BBX2 slots of the shelf currently being tested to insure that
all BBX2 TX paths are tested.

– This procedure can be bypassed on operational sites
that are due for periodic optimization.

– Prior to testing, view the CDF file to verify the
correct BBX2 slots are equipped. Edit the file as
required to include BBX2 slots not currently
equipped (per Systems Engineering documentation).

IMPORTANT

*

RX Path Calibration

RX path calibration is not required or supported on CDMA BTS
systems. Default RX calibration values are written to the RX calibration
data files during the TX calibration routine. Functionality is verified
during Frame Erasure Rate (FER) testing.
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BLO Calibration Data File

During the calibration process, the CDMA LMF creates a calibration
(CAL) data file where BLO values are stored. After calibration has been
completed, this offset data must be downloaded to the BBX2s using the
CDMA LMF Download BLO function. An explanation of the file is
shown below.

Due to the size of the file, Motorola recommends printing
out a copy of a bts.cal file and referring to it for the
following descriptions.

NOTE

The CAL file is subdivided into sections organized on a per–slot basis (a
slot Block).

The Slot 1 Block contains the calibration data for the six BBX2 slots.
The Slot 20 Block contains the calibration data for the redundant BBX2
(see Table 3-32). Each BBX2 slot Block header contains:

� A creation Date and Time – broken down into separate parameters of
createMonth, createDay, createYear, createHour, and createMin.

� The number of calibration entries – fixed at 720 entries corresponding
to 360 calibration points of the CAL file – plus the slot Block format.

Within the slot Block body, the BBX2 calibration data (BayLevelCal) is
organized as a large flat array. The array is organized by branch, BBX2
SCCP cage slot, and calibration point.

� The first breakdown of the array indicates which branch the contained
calibration points are for. The array covers transmit, main receive, and
diversity receive offsets as follows:

Table 3-31: BLO BTS.cal file Array Branch Assignments

Range Branch Assignment

C[1]–C[120] Transmit

C[121]–C[240] No SC4812ET Lite BLO cal
point entries (default only)

C[241]–C[360] Receive

C[361]–C[480] No SC4812ET Lite BLO cal
point entries (default only)

C[481]–C[600] Diversity Receive

C[601]–C[720] No SC4812ET Lite BLO cal
point entries (default only)
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� The second breakdown of the array is by BBX by sector. Three sectors
are allowed.

Table 3-32: SC4812ET Lite BTS.cal File Array (Per Sector)

BBX2 Sectorization TX Branch RX Branch
RX Diversity

Branch

Slot[1] (Primary BBX2s 1 through 6)

1 (Omni) C[1]–C[20] C[241]–C[260] C[481]–C[500]

2 3–Sector, C[21]–C[40] C[261]–C[280] C[501]–C[520]

3
1st Carrier

C[41]–C[60] C[281]–C[300] C[521]–C[540]

4 C[61]–C[80] C[301]–C[320] C[541]–C[560]

5 3–Sector, C[81]–C[100] C[321]–C[340] C[561]–C[580]

6
2nd Carrier

C[101]–C[120] C[341]–C[360] C[581]–C[600]

C[121]–C[140] C[361]–C[380] C[601]–C[620]

C[141]–C[160] C[381]–C[400] C[621]–C[640]
Not Used in SC4812ET Lite

(CAL file entries are C[161]–C[180] C[401]–C[420] C[641]–C[660](CAL file entries are 
Channel 0 with default C[181]–C[200] C[421]–C[440] C[661]–C[680]

power set level.)
C[201]–C[220] C[441]–C[460] C[681]–C[700]

C[221]–C[240] C[461]–C[480] C[701]–C[720]

Slot[20] (Redundant BBX2–R1)

1 (Omni) C[1]–C[20] C[241]–C[260] C[481]–C[500]

2 3–Sector, C[21]–C[40] C[261]–C[280] C[501]–C[520]

3
1st Carrier

C[41]–C[60] C[281]–C[300] C[521]–C[540]

4 C[61]–C[80] C[301]–C[320] C[541]–C[560]

5 3–Sector, C[81]–C[100] C[321]–C[340] C[561]–C[580]

6
2nd Carrier

C[101]–C[120] C[341]–C[360] C[581]–C[600]

C[121]–C[140] C[361]–C[380] C[601]–C[620]

C[141]–C[160] C[381]–C[400] C[621]–C[640]
Not Used in SC4812ET Lite

(CAL file entries are C[161]–C[180] C[401]–C[420] C[641]–C[660](CAL file entries are 
Channel 0 with default C[181]–C[200] C[421]–C[440] C[661]–C[680]

power set level.)
C[201]–C[220] C[441]–C[460] C[681]–C[700]

C[221]–C[240] C[461]–C[480] C[701]–C[720]

� Refer to the CAL file print–out and Table 3-32. It can be seen that
there is one BBX2 slot per sector, and 10 calibration points for each
BBX2 (sector) are supported for each branch. Each “calibration point”
consists of two entries.

� The first entry for a calibration point (all odd entries) identifies the
CDMA channel (frequency) where the BLO is measured. The second
calibration point entry (all even entries) is the power set level
(PwrLvlAdj). The valid range for PwrLvlAdj is from 2500 to 27500
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(2500 corresponds to –125 dBm and 27500 corresponds to +125
dBm).

� The 10 calibration points for each slot/branch combination must be
stored in order of increasing frequency. If less than 10 points
(frequencies) are calibrated, the BLO data for the highest frequency
calibrated is written into the remainder of the 10 points for that
slot/branch.

Example:

C[1]=384     (odd cal entry)

C[2]=19102     (even cal entry)

C[3]=777     (odd cal entry)

C[4]=19086     (even cal entry)

C[19]=777     (odd cal entry)

C[20]=19086     (even cal entry)

.

.

.

=  1 “calibration point”

In the example above, BLO was measured at only two frequencies
(channels 384 and 777) for SCCP slot BBX–1 transmit (Table 3-32).
The BLO data for the highest frequency measured (777) will be
written to the remaining eight transmit calibration points (defined by
entries C[5] through C[20]) for BBX2–1.

� When BLO data is downloaded to the BBXs, the data is downloaded
to the devices in the order it is stored in the CAL file. TxCal data
(C[1] – C[60]) is sent first. BBX2 slot 1’s 10 calibration points (C[1]
– C[20]) are sent initially, followed by BBX2 slot 2’s 10 calibration
points (C[21] – C[40]), and so on. The RxCal data is sent next,
followed by the RxDCal data.

� Temperature compensation data (TempLevelCal) is also stored in the
CAL file for each slot Block.

Test Equipment Setup:
RF Path Calibration

Follow the steps outlined in Table 3-33 and refer as needed to
Figure 3-15 or Figure 3-16 to set up test equipment.

Table 3-33: Set Up Test Equipment (RF Path Calibration)

Step Action

1 If it has not already been done, refer to the procedure in Table 3-6 to interface the CDMA LMF
computer terminal to the frame LAN A connector.

2 If it has not already been done, refer to Table 3-7 to start a GUI LMF session.

3 If required, calibrate the test equipment per the procedure in Table 3-25.
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Table 3-33: Set Up Test Equipment (RF Path Calibration)

Step Action

! CAUTION
To prevent damage to the test equipment, all transmit (TX) test connections must be via the 30 dB
directional coupler for 800 MHz or via a 30 dB coupler with a 20 dB in–line attenuator for 1900
MHz.

4 For TX path calibration, verify that the coaxial cable from the appropriate ANTENNA connector
(Figure 1-6 or Figure 1-7) is connected to the test equipment RF input port via the directional
coupler.

Transmit (TX) Path Calibration

The assigned channel frequency and desired power level at the frame TX
ports for transmit calibration are derived from the BTS CDF file. Each
BBX2 at the site is assigned to a sector and carrier. These are specified
respectively in the sector and carrier fields of the ParentCARRIER
parameter in each BBX2’s CDF file block. The channel frequency and
desired power for the assigned sector are specified respectively in the
ChannelList and SIFPilotPwr parameters of the CDF block for the
CARRIER to which the BBX2 is assigned.

The calibration procedure attempts to adjust the measured power to
within +0.5 dB of the desired power. The calibration will pass if the
error is less than +1.5 dB.

The TX BLO for the SC4812ET Lite is approximately 42.0 dB ±5.0 dB.
BLO is the gain in dB between the known power output of the BBX2
and the measured power at the TX port. BLO is derived by deducting the
known BBX2 power output from the power measured at the TX port or
(Measured Power) – (BBX2 TX Power Output).

Example:

Measured Power (at TX port) = 36.0 dBm

Known BBX TX Power Output = –6.0 dBm

BLO = (36.0) – (–6.0) = 42.0 dB gain

The CDMA LMF Tests menu list items TX Calibration and All
Cal/Audit perform TX BLO Calibration testing for installed BBX(s).
The All Cal/Audit menu item initiates a series of actions to perform TX
calibration, download BLO, and perform TX audit if the TX calibration
passes. The TX Calibration selection performs only the TX calibration.
When the TX Calibration selection is used, BLO download and TX
audit must be performed as separate activities. All measurements are
made through the appropriate antenna connector using the calibrated TX
cable setup.

In both the TX Calibration and All Cal/Audit dialog boxes, a Verify
BLO checkbox is provided and checked by default. After the actual TX
calibration is completed during either the TX Calibration or All
Cal/Audit process, the BLO derived from the calibration is compared to
a standard, acceptable BLO tolerance for the BTS. In some installations,
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additional items may be installed in the transmit path. The additional
change in gain from these items could cause BLO verification failure
and, therefore, failure of the entire calibration. In these cases, either the
Verify BLO checkbox should be unchecked or the additional path losses
should be added into each applicable sector using the Util > Edit > TX
Coupler Loss... function.

Prerequisites

Before running this test, ensure that the following have been done:

� CSM–1, GLIs, MCCs, and BBX2s have correct code load and data
load.

� Primary CSM and MGLI are INS.

� All BBX2s are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS in the GUI environment.

Connect the test equipment as shown in  Figure 3-15 and Figure 3-16
and follow the procedure in Table 3-34 to perform the TX calibration
test.

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX2
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

Verify all BBX2 boards removed and repositioned have
been returned to their assigned shelves/slots. Any BBX2
boards moved since they were downloaded will have to be
downloaded again.

IMPORTANT

*
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Table 3-34: All Cal/Audit Path Calibration

Step Action

1 Configure test equipment for TX path calibration per Table 3-33.

2 Select the BBX2(s) to be calibrated.

3 From the Tests menu, select All Cal/Audit.

4 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

5 Type the appropriate channel number in the Carrier n Channels box.

6 Click on OK.

7 Follow the cable connection directions as they are displayed.

The test results will be displayed in the status report window.

8 Click on Save Results or Dismiss to close the status report window.
 

TX Calibration Test

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� MGLI and primary CSM and BDC are INS_ACT (CSM clock valid)

� All BBXs are OOS–RAM (yellow)

� Test equipment and test cables are calibrated and connected for TX
BLO calibration

� LMF is logged in to the BTS in the GUI environment

Verify all BBX boards removed and repositioned have been
returned to their assigned shelves/slots. Any BBX boards
moved since being downloaded will have to be
downloaded with code and data again.

IMPORTANT

*

If just a TX calibration must be run by itself, follow the procedures in
Table 3-35.

Table 3-35: TX Calibration Test

Step Action

1 Configure test equipment for TX path calibration per Table 3-33.

2 Click on the BBX(s) to be calibrated.

3 From the Tests menu, select TX Calibration.

4 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list (press and hold the Shift
or Ctrl keyboard key to select multiple items).

. . . continued on next page
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Table 3-35: TX Calibration Test

Step Action

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK to display the status report window followed by a Directions pop-up window.

7 Follow the cable connection directions as they are displayed. The test results will be displayed in the
status report window.

8 Click OK to close the status report window.

 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re–run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.

Download BLO Procedure

After a successful TX path calibration, download the bay level offset
(BLO) calibration file data to the BBX2s. BLO data is extracted from the
CAL file for the Base Transceiver Subsystem (BTS) and downloaded to
the selected BBX2 devices.

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding.

� BBXs being downloaded are OOS–RAM (yellow).

� TX calibration successfully completed

After a TX calibration has been performed using the procedure in
Table 3-35, follow the steps in Table 3-36 to download the BLO data to
the BBX2s.
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Table 3-36: Download BLO

Step Action

1 Select the BBX2(s) to be downloaded.

2 From the Device menu, select Download BLO.

A status report window displays the result of the download.

NOTE
Selected device(s) do not change color when BLO is downloaded.

3 Click OK to close the status report window.

 

Calibration Audit Introduction

The BLO calibration audit procedure confirms the successful generation
and storage of the BLO calibrations. The calibration audit procedure
measures the path gain or loss of every BBX2 transmit path at the site.
In this test, actual system tolerances are used to determine the success or
failure of a test. The same external test equipment set up is used.

* RF path verification, BLO calibration, and BLO data
download to BBX2s must have been successfully
completed prior to performing the calibration audit.

IMPORTANT

Transmit (TX) Path Audit

Perform the calibration audit of the TX paths of all equipped BBX2
slots, per the steps in Table 3-37.

Before installing any test equipment directly to any TX
OUT connector, first verify there are no CDMA BBX2
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

If a successful All Cal/Audit was completed, this
procedure does not need to be performed, as BLO is
downloaded as part of the All Cal/Audit.

NOTE
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TX Audit Test

The Tests menu item, TX Audit, performs the TX BLO Audit test for a
BBX2(s). All measurements are made through the appropriate TX output
connector using the calibrated TX cable setup.

Prerequisites

Before running this test, the following should be done:

� CSM–1,GLI2s, BBX2s have correct code load.

� Primary CSM and MGLI2 are INS.

� All BBX2s are OOS_RAM.

� Test equipment and test cables are calibrated and connected for TX
BLO calibration.

� LMF is logged into the BTS.

After a TX calibration has been performed using the procedure in
Table 3-35, or if verification of BLO data in the CAL file is required,
connect the test equipment as shown in Figure 3-15 or Figure 3-16 and
follow the procedure in Table 3-37 to perform the BTS TX Path Audit
test.

Table 3-37: TX Path Audit

Step Action

1 Select the BBX2(s) to be audited. From the Tests menu, select TX Audit.

2 Select the appropriate carrier(s) displayed in the Channels/Carrier pick list.

Press and hold the <Shift> or <Ctrl> key to select multiple items.

3 Type the appropriate channel number in the Carrier n Channels box.

4 Click on OK.

5 Follow the cable connection directions as they are displayed.

A status report window displays the test results.

6 Click on Save Results or Dismiss to close the status report window.

 

Exception Handling

In the event of a failure, the calibration procedure displays a FAIL
message in the status report window and provides information in the
Description field.

Recheck the test setup and connection and re–run the test. If the tests fail
again, note specifics about the failure, and refer to Chapter 6,
Troubleshooting.
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Create CAL File

The Create Cal File function gets the BLO data from BBXs and
creates/updates the CAL file for the BTS. If a CAL file does not exist a
new one is created. If a CAL file already exists it is updated. After a
BTS has been fully optimized a copy of the CAL file must exist so it can
be transferred to the CBSC. If TX calibration has been successfully
performed for all BBXs and BLO data has been downloaded, a CAL file
will exist. Note the following:

� The Create Cal File function only applies to selected (highlighted)
BBXs.

Editing the CAL file is not encouraged as this action can
cause interface problems between the BTS and the LMF.
To manually edit the CAL file you must first logout of the
BTS. If you manually edit the CAL file and then use the
Create Cal File function the edited information will be lost.

CAUTION

Prerequisites

Before running this test, the following should be done:

� LMF is logged into the BTS

� BBX2s are OOS_RAM with BLO downloaded

Table 3-38: Create CAL File

Step Action

1 Select the applicable BBX2s. The CAL file will only be updated for the selected BBX2s.

2 Click on the Device menu.

3 Click on the Create Cal File menu item. The status report window displays the results of the action.

4 Click OK.
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RFDS Description

The optional RFDS is used to perform RF tests of the site from the
CBSC or from the LMF. The RFDS contains the following FRUs:

� Antenna Select Unit (ASU)

� FWT Interface Card (FWTIC)

� Subscriber Unit Assembly (SUA)

For complete information regarding the RFDS, refer to the CDMA
CDMA RFDS Hardware Installation; 68P64113A93, CDMA RFDS
User’s Guide; 68P64114A51, and the LMF Help function.

RFDS Parameter Settings

The bts-#.cdf  file includes RFDS parameter settings that must
match the installed RFDS equipment. The paragraphs below describe the
editable parameters and their defaults. Table 3-39 explains how to edit
the parameter settings.

� RfdsEquip – valid inputs are 0 through 2.
0 = (default) RFDS is not equipped
1 = Non-Cobra/Patzer box RFDS
2 = Cobra RFDS

� TsuEquip – valid inputs are 0 or 1
0 = (default) TSU not equipped
1 = TSU is equipped in the system

� MC1....4 – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Multicouplers equipped in RFDS system 

(SC9600 internal RFDS only)

� Asu1/2Equip – valid inputs are 0 or 1
0 = (default) Not equipped
1 = Equipped

� TestOrigDN – valid inputs are ’’’ (default) or a numerical string up to
15 characters. (This is the phone number the RFDS dials when
originating a call. A dummy number needs to be set up by the switch,
and is to be used in this field.)

Any text editor may be used to open the bts–#.cdf  file
to verify, view, or modify data.

NOTE
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Table 3-39: RFDS Parameter Settings

Step Action

* IMPORTANT
Log out of the BTS prior to performing this procedure.

1 Using a text editor, verify the following fields are set correctly in the bts–#.cdf  file (1 = GLI based
RFDS; 2 = Cobra RFDS).

EXAMPLE:
RfdsEquip = 2
TsuEquip = 1
MC1Equip = 0
MC2Equip = 0
MC3Equip = 0
MC4Equip = 0
Asu1Equip = 1
Asu2Equip = 0 (1 if system is non-duplexed)
TestOrigDN = ’123456789’

NOTE
The above is an example of the bts-#.cdf  file that should have been generated by the OMC–R and
copied to the LMF. These fields will have been set by the OMC–R if the RFDSPARM database is
modified for the RFDS.

2 Save and/or quit the editor. If any changes were made to these fields data will need to be downloaded
to the GLI2 (see Step 3, otherwise proceed to Step 4).

3 To download to the GLI2, click on the Device menu and select the Download Data menu item
(selected devices do not change color when data is downloaded). A status report window is displayed
showing status of the download. Click OK to close the status report window.

! CAUTION
After downloading data to the GLI2 the RFDS LED will slowly begin flashing red and green for
approximately 2–3 minutes. DO NOT attempt to perform any functions with the RFDS until the LED
remains green.

4 Status the RFDS TSU. A status report is displayed showing the software version number for the TSIC
and SUA.

* IMPORTANT
If the LMF yields an error message, check the following:

� Ensure AMR cable is correctly connected from the BTS to the RFDS.

� Verify RFDS has power.

� Verify RFDS status LED is green.

� Verify fields in the bts-#.cdf  file are correct (see Step 1).

� Status the GLI2 and ensure the device is communicating (via Ethernet) with the LMF, and the
device is in the proper state (INS).
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RFDS TSU NAM Programming

The NAM (number assignment module) information needs to be
programmed into the TSU before it can receive and process test calls, or
be used for any type of RFDS test. The RFDS TSU NAM must be
programmed with the appropriate system parameters and phone number
during hardware installation. The TSU phone and TSU MSI must be
recorded for each BTS used for OMC–R RFDS software configuration.

The user will only need to program the NAM for the initial
install of the RFDS.

NOTE

Explanation of Parameters
used when Programming the
TSU NAM

Table 3-40 defines the parameters used when editing the tsu.nam file.

Table 3-40: Definition of Parameters

Access Overload Code
Slot Index
System ID
Network ID

These parameters are obtained from the switch.

Primary Channel A
Primary Channel B
Secondary Channel A
Secondary Channel B

These parameters are the channels which are to be used in operation
of the system.

Lock Code
Security Code
Service Level
Station Class Mark

Do NOT change.

IMSI MCC
IMSI 11 12

These fields are obtained at the OMC using the following command:
OMC000>disp bts–# imsi
If the fields are blank, replace the IMSI fields in the NAM file to 0,
otherwise use the values displayed by the OMC.

MIN Phone Number These fields are the phone number assigned to the mobile. The ESN
and MIN must be entered into the switch as well.

NOTE
This field is different from the TODN field in the bts-#.cdf file.
The MIN is the phone number of the RFDS subscriber, and the
TODN is the number the subscriber calls.
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Valid NAM Ranges
Table 3-41 provides the valid NAM field ranges. If any of the fields are
missing or out-of–range, the RFDS will error out.

Table 3-41: Valid NAM Field Ranges

Valid Range

NAM Field Name Minimum Maximum

Access Overload Code 0 15

Slot Index 0 7

System ID 0 32767

Network ID 0 32767

Primary Channel A 25 1175

Primary Channel B 25 1175

Secondary Channel A 25 1175

Secondary Channel B 25 1175

Lock Code 0 999

Security Code 0 999999

Service Level 0 7

Station Class Mark 0 255

IMSI 11 12 0 99

IMSI MCC 0 999

MIN Phone Number N/A N/A
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Set Antenna Map Data

The antenna map data must be entered manually if an RFDS is installed.
Antenna map data does not have to be entered if an RFDS is not
installed. The antenna map data is only used for RFDS tests and is
required if a RFDS is installed.

Prerequisite

� Logged into the BTS

Table 3-42: Set Antenna Map Data

Step Action

1 Click on the Util menu.

2 Select Edit > Antenna Map > TX or RX. A data entry pop–up window will appear.

3 Enter/edit values as required for each carrier.

NOTE
Refer to the Util > Edit–antenna map LMF help screen for antenna map examples.

4 Click on the Save button to save displayed values.

5 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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Set RFDS Configuration Data

If an RFDS is installed the RFDS configuration data must be manually
entered.

Prerequisite

� Logged into the BTS

The entered antenna# index numbers must correspond to
the antenna# index numbers used in the antenna maps.

IMPORTANT

*

Table 3-43: Set RFDS Configuration Data

Step Action

1 Click on the Util menu.

2 Select Edit > RFDS Configuration > TX or RX. A data entry pop–up window will appear.

3 Click on the Add Row button to add a new antenna number. Then click in the other columns and enter
the desired data.

4 To edit existing values click in the data box to be changed and change the value.

NOTE
Refer to the Util > Edit–RFDS Configuration LMF help screen for RFDS configuration data
examples.

5 To delete a row, click on the row and then click on the Delete Row  button.

6 Click on the Save button to save displayed values.

7 Click on the Dismiss button to exit the window. Values that were entered/changed after the Save
button was used will not be saved.

NOTE
Entered values will be used by the LMF as soon as they are saved. You do not have to logout and
login.
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RFDS Calibration

The RFDS Calibration option is used to calibrate the RFDS TX and RX
paths. For a TX antenna path calibration the BTS XCVR is keyed at a
pre–determined power level and the BTS power output level is measured
by the RFDS. The power level is then measured at the TX antenna
directional coupler by the power measuring test equipment item being
used (power meter or analyzer). The difference (offset) between the
power level at the RFDS and the power level at the TX antenna
directional coupler is used as the TX RFDS calibration offset value.

For an RX antenna path calibration the RFDS is keyed at a
pre–determined power level and the power input level is measured by the
BTS XCVR. A CDMA signal at the same power level measured by the
BTS XCVR is then injected at the RX antenna directional coupler by the
CDMA communications analyzer. The difference (offset) between the
RFDS keyed power level and power level measured at the BTS XCVR is
the RFDS RX calibration offset value.

The TX and RX RFDS calibration offset values are written to the CAL
file.

For each RFDS TSIC, the channel frequency is determined at the lower
third and upper third of the appropriate band using the frequencies listed
in Table 3-44.

Table 3-44: RFDS TSIC Calibration Channel Frequencies

System Channel Calibration Points

800 MHz (A and B) 341 and 682

1.9 GHz 408 and 791

Before installing any test equipment directly to any TX
OUT connector, verify that there are no CDMA BBX
channels keyed. Failure to do so can result in serious
personal injury and/or equipment damage.

WARNING

Prerequisites

� BBX2s are INS_TEST

� Cable calibration has been performed

� TX calibration has been performed and BLO has been downloaded for
the BTS

� Test equipment has been connected correctly for a TX calibration

� Test equipment has been selected and calibrated
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Table 3-45: RFDS Calibration

Step Action

1 Select the RFDS tab.

2 Click on the RFDS menu.

3 Click on the RFDS Calibration menu item.

4 Select the appropriate direction (TX/RX) in the Direction pick list.

5 Enter the appropriate channel number(s) in the Channels box. Separate the channel numbers with a
comma or a dash if more than one channel number is entered (e.g., 247,585,742 or 385–395 for
through).

6  Select the appropriate carrier(s) in the Carriers pick list (use the Shift or Ctrl key to select multiple
carriers).

7 Select the appropriate RX branch (Both, Main, or Diversity) in the RX Branch pick list.

8 Select the appropriate baud rate (1=9600, 2=14400) in the Rate Set pick list.

9 Click on the OK button. A status report window is displayed, followed by a Directions pop–up
window.

10 Follow the cable connection directions as they are displayed. Test results are displayed in the status
report window.

11 Click on the OK button to close the status report window.

12 Click on the BTS tab.

13 Click on the MGLI.

14 Download the CAL file which has been updated with the RFDS offset data to the selected GLI device
by clicking on Device > Download Data from the tab menu bar and pulldown.

NOTE
The MGLI will automatically transfer the RFDS offset data from the CAL file to the RFDS.
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Program TSU NAM

Follow the procedure in Table 3-46 to program the TSU NAM. The
NAM must be programmed before it can receive and process test calls,
or be used for any type of RFDS test.

Prerequisites

� MGLI is INS.

� TSU is powered up and has a code load.

Table 3-46: Program NAM Procedure

Step Action

1 Select the RFDS tab.

2 Select the TSU tab.

3 Click on the TSU menu.

4 Click on the Program TSU NAM menu item.

5 Enter the appropriate information in the boxes  (see Table 3-40 and Table 3-41) .

6 Click on the OK button to display the status report.

7 Click on the OK button to close the status report window.
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Alarm Verification

The alarms testing should be performed at a convenient point in the
optimization/ATP process, since the LMF is necessary to ensure that the
SC4812ET Lite is generating the appropriate alarms.

The SC 4812ET Lite is capable of concurrently monitoring 10 customer
defined input signals and four customer defined outputs, which interface
to the 50–pair punchblock. All alarms are defaulted to “Not Equipped”
during ATP testing. Testing of these inputs is achieved by triggering the
alarms and monitoring the LMF for state–transition messages from the
active MGLI2.

Alarm Reporting Display

The Alarm Monitor window can be displayed to list alarms that occur
after the window is displayed. To access the Alarm Monitor window,
select Util > Alarm Monitor.

The following buttons are included.

� The Options button allows for a severity level (Warning, Minor,
Major, Critical, and Unknown) selection. The default is all levels.
To change the level of alarms reported click on the Options button
and highlight the desired alarm level(s). To select multiple levels press
the Ctrl key (for individual selections) or Shift key (for a range of
selections) while clicking on the desired levels.

� The Pause button can be used to pause/stop the display of alarms.
When the Pause button is clicked the name of the button changes to
Continue. When the Continue button is click the display of alarms
will continue. Alarms that occur between the time the Pause button is
clicked and the Continue button is clicked will not be displayed.

� The Clear button can be used to clear the Alarm Monitor display.
New alarms that occur after the Clear button is clicked will be
displayed.

� The Dismiss button is used to dismiss/close the Alarm Monitor
display.
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Alarm Testing Set–up

Prepare for any alarm testing by following the procedures in Table 3-47.

Table 3-47: Alarm Testing Preparation

Step Action

1 If it has not already been done, refer to the procedure in Table 3-6 to interface the CDMA LMF
computer terminal to the frame LAN A connector.

2 If it has not already been done, refer to Table 3-7 to start a GUI LMF session.

3 Click on Util in the menu bar and select Alarm Monitor... from the pulldown.

� An Alarm Monitor window will open.

 

Heat Exchanger Alarm Test

Table 3-48 gives instructions on testing the Heat Exchanger alarm.

Table 3-48: Heat Exchanger Alarm

Step Action

1 Set one of the two DC PDA heat exchanger circuit breakers to  OFF. This will generate a heat
exchanger alarm. Be sure that the CDMA LMF reports the correct alarm condition.

2 Alarm condition will be reported as BTS Relay #14, BTS Relay #15, BTS Relay #16, BTS Relay
#17, BTS Relay #18, with Contact Alarm Open*Clear*, respectively.

3 Set the circuit breaker turned off in step 1 to  ON. Ensure that the alarm conditions have cleared on
the CDMA LMF with Contact Alarm Closed*Clear* for each reported BTS relay.

NOTE
The heat exchanger will go through the start–up sequence.

Door Alarm

Table 3-49 gives instructions on testing the door alarms.

Table 3-49: ACLC and Power Entry Door Alarm

Step Action

1 Close the ACLC and power entry compartment doors on the frame. Ensure that no alarms are reported
on the CDMA LMF.

2 Individually open and then close the ACLC and power entry compartment door. Ensure that the
CDMA LMF reports an alarm when each door is opened.

3 Alarm condition will be reported as BTS Relay #27 contact.
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AC Fail Alarm

Table 3-50 gives instructions on testing the AC Fail Alarm.

Table 3-50: AC Fail Alarm

Step Action

1 * IMPORTANT

� Back–up batteries must be installed when performing this test.

� To prevent inadvertently shutting down the RF compartment electronics, the batteries should be
charged before performing this test.

Set the ACLC MAIN circuit breaker to  OFF.

� The CDMA LMF should report an alarm for an AC Fail condition as BTS Relay #21, BTS Relay
#23, BTS Relay #24, and BTS Relay #29 contacts, respectively.

� On the MAP, the MAJOR ALARM (red), MINOR ALARM (amber), and RECTIFIER FAIL (red)
LEDs should light.

� On the rectifiers, the DC and PWR LEDs should light red.

2 Set the ACLC MAIN circuit breaker to  ON.

� On the CDMA LMF, the AC Fail alarm should clear.

� On the MAP, the  MAJOR ALARM, MINOR ALARM, and RECTIFIER FAIL LEDs should
extinguish.

� On the rectifiers, the DC and PWR LEDs should change to green.

Minor Alarm

Table 3-51 gives instructions on performing a test to display a minor
alarm.

Table 3-51: Minor Alarm

Step Action

1 Set the TCP switch on the MAP to  OFF. This will generate a minor alarm.

� The CDMA LMF should report the minor alarm as BTS Relay #24 contacts.

� The TC DISABLE (red) and MINOR ALARM (amber) LEDs on the MAP should light.

2 Set the TCP switch to  ON. The alarm condition indications should clear.

 

Rectifier Alarms

The following series of tests are for single rectifier modules in a multiple
rectifier system. The systems include a three rectifier and a four rectifier
system.

Single Rectifier Failure 
(Three Rectifier System)

Table 3-52 gives instructions on testing single rectifier failure or minor
alarm in a three (3) rectifier system (single–carrier system). Procedures
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in this test are for a frame configured for single carrier operation with
rectifiers installed in rectifier shelf positions 2, 3, and 4, from left to
right when facing the frame.

Table 3-52: Single Rectifier Fail or Minor Alarm, Single–Carrier System

Step Action

1 ! CAUTION
Only perform this test if the rectifier current load displayed on the AMP indicator on the MAP is 
125 amps or less. Sufficient current capability to support a greater load may not be available when
one rectifier is removed from the bus.

On the ACLC, set the RECT. 2/4 circuit breaker to  OFF.

� The DC and PWR LEDs should light red on the rectifier in shelf position 2.

� The MINOR ALARM (amber) and RECTIFIER FAIL (red) LEDs on the MAP should light.

� The CDMA LMF should report an alarm condition as BTS Relay #21 and BTS Relay #24
contacts, respectively.

2 Set the RECT. 2/4 circuit breaker on the ACLC to  ON.

� All alarm indications should clear on the rectifier, MAP, and CDMA LMF.

 

Multiple Rectifier Failure 
(Three Rectifier System)

Table 3-53 gives instructions on testing multiple rectifier failure or major
alarm in a three (3) rectifier system (single–carrier system). Procedures
in this test are for a frame configured for single carrier operation with
rectifiers installed in rectifier shelf positions 2, 3, and 4, from left to
right when facing the frame.

Table 3-53: Multiple Rectifier Failure or Major Alarm, Single–Carrier System

Step Action

1 ! CAUTION
Only perform this test if the rectifier current load displayed on the AMP indicator on the MAP is 65
amps or less. Sufficient current capability to support a greater load may not be available when two
rectifiers are removed from the bus.

On the ACLC, set the RECT. 1/3 circuit breaker to  OFF.

� The DC and PWR LEDs should light red on the rectifiers in shelf positions 1 and 3.

� The MAJOR ALARM (red), MINOR ALARM (amber), and RECTIFIER FAIL (red) LEDs on the
MAP should light.

� The CDMA LMF should report an alarm condition as BTS Relay #21, BTS Relay #24, and BTS
Relay #29 contacts, respectively.

2 Set the RECT. 1/3 circuit breaker on the ACLC to  ON.

� All alarm indications should clear on the rectifiers, MAP, and CDMA LMF.
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Single Rectifier Failure 
(Four Rectifier System)

Table 3-54 gives instructions on testing single rectifier failure or minor
alarm in a four (4) rectifier system (two–carrier system).

Table 3-54: Single Rectifier Fail or Minor Alarm, Two–Carrier System

Step Action

1 ! CAUTION
Only perform this test if the rectifier current load displayed on the AMP indicator on the MAP is 
125 amps or less. Sufficient current capability to support a greater load may not be available when
two rectifiers are removed from the bus in the following steps.

Unseat the rectifier in shelf position 4 from its connection at the rear of the shelf, but do not
completely remove it from the shelf.

� The rectifier 4 DC and PWR LEDs may light red momentarily and extinguish. There should be no
other indications on the frame or CDMA LMF.

2 On the ACLC, set the RECT. 2/4 circuit breaker to  OFF.

� The rectifier 2 DC and PWR LEDs should light red.

� The MINOR ALARM (amber) and RECTIFIER FAIL (red) LEDs on the MAP should light.

� The CDMA LMF should report an alarm condition as BTS Relay #21 and BTS Relay #24
contacts, respectively.

3 Re–seat the rectifier in shelf position 4 into its connection at the rear of the shelf.

4  On the ACLC, set the RECT. 2/4 circuit breaker to  ON.

� The rectifier DC and PWR LEDs should light green.

� All alarm indications should clear on the rectifiers, MAP, and CDMA LMF.
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Multiple Rectifier Failure 
(Four Rectifier System)

Table 3-55 gives instructions on testing multiple rectifier failure or major
alarm in a four (4) rectifier system (two–carrier system).

Table 3-55: Multiple Rectifier Failure or Major Alarm, Two–Carrier System

Step Action

1 ! CAUTION
Only perform this test if the rectifier current load displayed on the AMP indicator on the MAP is 
125 amps or less. Sufficient current capability to support a greater load may not be available when
two rectifiers are removed from the bus.

On the ACLC, set the RECT. 2/4 circuit breaker to  OFF.

� The DC and PWR LEDs should light red on the rectifiers in shelf positions 2 and 4.

� The MAJOR ALARM (red), MINOR ALARM (amber), and RECTIFIER FAIL (red) LEDs on the
MAP should light.

� The CDMA LMF should report an alarm condition as BTS Relay #21, BTS Relay #24, and BTS
Relay #29 contacts, respectively.

2 Set the RECT. 2/4 circuit breaker on the ACLC to  ON.

� All alarm indications should clear on the rectifiers, MAP, and CDMA LMF.

 

Battery Over Temperature
Alarm (Optional)

Use special care to avoid damaging insulation on cables, or
damaging battery cases when using a heat gun.

CAUTION

Table 3-56 gives instructions on testing the battery over–temperature
alarm system.

Table 3-56: Battery Over–Temperature Alarm

Step Action

1 Use a low–powered heat gun to gently heat the battery over–temperature sensor (see location in
Figure 3-21).

! CAUTION
To avoid damaging the cable insulation, do not hold the hot air gun closer than three (3) inches from
the sensor.
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Table 3-56: Battery Over–Temperature Alarm

Step Action

2 NOTE
When the over–temperature alarm point is reached, an audible click will sound as DC PDA relay K1
contacts engage and relay K2 contacts disengage (make–before–break operation).

When the sensor is heated to approximately 51° C, a battery over–temperature alarm is generated with
the following indications.

� On the MAP, the CHARGE DISABLE LED (red) should light and the MAIN CONN. ENABLE
LED (green) should extinguish.

� The CDMA LMF should display an alarm condition as BTS Relay #22 contacts.

3 Switch the hot air gun to cool. Cool the sensor until the K1 and K2 contacts return to normal position
(K1 open and K2 closed). The following indications that alarms have cleared should occur:

� On the MAP, the CHARGE DISABLE LED (red) should extinguish and the MAIN CONN.
ENABLE (green) LED should light.

� The alarm reported on CDMA LMF will clear
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Figure 3-21: Battery Over–Temperature Sensor

Bus Bar

6 AWG Cables

Battery Overtemp Sensor

Negative Temperature Compensation Sensor

SC4812ETL0014–1
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Rectifier Over Temperature
Alarm

Table 3-57 gives instructions on testing the rectifier over–temperature
alarm system.

Table 3-57: Rectifier Over–Temperature Alarm

Step Action

1 Remove the 14 tamper–resistant Torx fasteners securing the rear access panel to the rear of the frame
(Figure 2-1), and remove the rear access panel.

NOTE
Panel fastener type can be either T–27 button head or  T–30 pan head.

2 Looking up through the frame rear access opening, locate the rear of the MAP.

3 Remove the jumper plug from connector J8 on the rear panel of the MAP (Figure 3-22). The
following conditions should occur:

� Contacts on K1 and K2 change states (K1 now closed and K2 open).

� The CDMA LMF reports an alarm condition as BTS Relay #26 contacts.

4 Reinstall the jumper plug in connector J8, and verify that all alarm conditions have cleared.

5 Reinstall the frame rear access panel, securing it with the 14 tamper–resistant Torx fasteners removed
in step 1.

 

Figure 3-22: MAP Connector J8 (Rear of MAP)

SC4812ETL0021–1

J4 J5 J1

J12

J3 J8 J9 J7

J2

CONNECTOR J8

Before Leaving the site

If no further operations are required after performing the alarm tests,
complete the requirements in Table 5-8 before leaving the site.
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Notes
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Introduction

The automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the CDMA LMF GUI environment and
supported test equipment.

The operator can choose to save the results of these tests to a report file,
from which ATP reports are generated for later printout.

Perform the ATP test on out-of-service sectors or sites only. Because all
tests are controlled via the CDMA LMF computer using the GPIB
interface from the CDMA LMF computer, only recommended test
equipment supported by the CDMA LMF can be used.

Before using the LMF, use an editor to view the
”CAVEATS” section in the ”readme.txt” file in the c:\wlmf
folder for any applicable information.

IMPORTANT

*

The ATP test is to be performed on out-of-service sectors
only.

DO NOT substitute test equipment with other models not
supported by the LMF.

IMPORTANT

*

Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test
set components, if  required.

NOTE

The CFE selects the appropriate ATP tests to run to satisfy customer and
regulatory requirements for verifying cell site performance. These tests
can be run individually or as one of the following groups:

� All TX: TX tests verify the performance of the BTS transmit
elements. These include the GLI2, MCC, BBX2, BDC, and trunking
modules, the LPAs, and passive components including splitters,
combiners, bandpass filter(s), and RF cables.

� All RX: RX tests verify the performance of the BTS receive elements.
These include the MPC (for starter frames), , BBX2, MCC, and GLI2
modules, and the passive components including RX filter (starter
frame only), and RF cables.

� All TX/RX: Executes all TX and RX tests.

� Full Optimization: Executes the TX calibration, downloads BLO,
and executes the TX audit before running all TX and RX tests.
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Prerequisites

Before attempting to run any ATP tests, all applicable procedures
outlined in Chapter 3, Optimization/Calibration, must have been
completed successfully (i.e., code load and BLO calibration).

You cannot substitute test equipment with other models not
supported by the CDMA LMF.

NOTE

Before attempting to run any ATP tests, ensure the following:

� BTS has been optimized and calibrated (see Chapter 3).

� LMF is logged into the BTS

� CSMs, GLI2s, BBX2s, MCCs and TSU (if the RFDS is installed)
have correct code load and data load

� Primary CSM and GLI2 are INS_ACT

� MCCs are INS_ACT

� BBX2s are OOS-RAM

� BBX2s are calibrated and BLOs are downloaded

� Test cables are calibrated

� Test equipment is selected

� Test equipment is connected for ATP tests

� Test equipment has been warmed up 60 minutes and calibrated

� GPIB is on

Before the FER is run, be sure that all LPAs are turned
OFF (circuit breakers pulled) or that all transmitter
connectors are properly terminated.

All transmit connectors must be properly terminated for all
ATP tests.

Failure to observe these warnings may result in bodily
injury or equipment damage.

WARNING

TX/RX Antenna Connections

Refer to Figure 1-6 or Figure 1-7 for identification of the transmit and
receive antenna connections where measurement are to be taken.
Directional couplers for signal sampling by the RFDS, if installed, are
integral to the SC4812ET Lite transmit and receive paths in the DRDCs
and TRDCs. As a result, all ATP measurement connections are made at
the antenna connectors on the RF interface panel.
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Required Test Equipment

The following test equipment is required:

� LMF

� Power meter (used with HP8921A/600 and Advantest R3465)

� Communications test set

Before installing any test equipment directly to any TX
OUT connector, verify that there are no CDMA channels
keyed.

At active sites, have the OMCR/CBSC place the carrier
assigned to the LPAs under test OOS. Failure to do so can
result in serious personal injury and/or equipment damage.

WARNING

You must recalibrate the test equipment before using it to
perform the TX Acceptance Tests.

NOTE

Acceptance Test Equipment
Set Up

Follow the steps in Table 4-1  to set up test equipment for all tests.

Table 4-1: Set Up Test Equipment – TX Output Verify/Control Tests

Step Action

1 If it has not already been done, interface the LMF computer to the BTS (refer to Table 3-6 and
Figure 3-10).

2 If it has not already been done, refer to Table 3-7 to start a GUI LMF session and log into the BTS.

3 If it has not already been done, refer to Figure 3-17 or Figure 3-18, as applicable for the test
equipment being used, to connect test equipment for acceptance testing.

* IMPORTANT
CDMA LMF–based measurement commands factor in TX test cable loss between the RFM frame and
test equipment. No additional attenuation can be inserted as the additional losses would not be
factored in.
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All–inclusive Tests

The all–inclusive acceptance tests are performed from the LMF GUI
environment. These tests execute various combinations of individual
acceptance tests with a single command. This allows verification of
multiple aspects of BTS performance while minimizing time needed for
individual test set up and initiation.

There are three abbreviated acceptance tests which evaluate different
performance aspects of the BTS. This allows the CFE to select testing to
meet the specific requirements for individual maintenance and
performance verification situations. The following summarizes the
coverage of each abbreviated test:

� All TX/RX. Performs all transmit and receive ATPs on the selected
MCCs and BBX2s.

� All TX. Performs complete set of transmit ATPs on the selected
MCCs and BBX2s. Testing is the equivalent of performing all of the
following individual tests:

– TX Mask Test

– Rho Test

– Pilot Time Offset Test

– Code Domain Power Test

� All RX. Performs complete receive ATP on the selected MCCs and
BBX2s. Testing is the equivalent of performing the following:

– FER Test
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All TX/RX ATP Test
Follow the procedures in Table 4-2 to perform the abbreviated,
all–inclusive transmit and receive test.

Table 4-2: All TX/RX ATP Test Procedure

Step Action

1 Set up the test equipment initially for abbreviated tests per Table 4-1.

2 Select the BBX2s and MCCs to be tested.

3 From the Tests menu, select All TX/RX.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.

 

All TX ATP Test
Follow the procedures in Table 4-3 to perform the abbreviated,
all–inclusive transmit test.

Table 4-3: All TX ATP Test Procedure

Step Action

1 Set up the test equipment for abbreviated tests per Table 4-1.

2 Select the BBX2s and MCCs to be tested.

3 From the Tests menu, select All TX.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

. . . continued on next page
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Table 4-3: All TX ATP Test Procedure

Step Action

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.

 

All RX ATP Test
Follow the procedures in Table 4-4 to perform the abbreviated,
all–inclusive receive test.

Table 4-4: All RX ATP Test Procedure

Step Action

1 Set up the test equipment for abbreviated tests per Table 4-1.

2 Select the BBX2s and MCCs to be tested.

3 From the Tests menu, select All RX.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.

 

4



Individual Acceptance Tests–Introduction

08/01/2001 4-71X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Individual Acceptance Tests

The following individual ATP tests can be used to evaluate specific
aspects of BTS operation against individual performance requirements.
All testing is performed using the CDMA LMF GUI environment.

TX Testing

TX tests verify any given transmit antenna path and output power
control. All tests are performed using the external calibrated test set. All
measurements are via the appropriate TX OUT connector.

TX tests verify TX operation of the entire CDMA Forward Link using
all BBX2s assigned to all respective sector/antennas. Each BBX2 is
keyed up to generate a CDMA carrier (using both bbx level and bay
level offsets) at the CDF file carrier output power level (as specified in
the site documentation).

RX Testing

RX testing verifies any given receive antenna path. All tests are
performed using the external calibrated test set to inject a CDMA RF
carrier with all zero longcode at the specified RX frequency  via the
appropriate RX IN connector.

RX tests verify RX operation of the entire CDMA Reverse Link using
all equipped MCCs assigned to all respective sector/antennas.

Individual Tests

Spectral Purity TX Mask

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification (as defined
in IS–97) with respect to the assigned cdf file values.

Waveform Quality (Rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in IS–97.
Rho represents the correlation between the actual and perfect CDMA
modulation spectrums. 1.0000 represents 100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Walsh
code 0).

Code Domain Power/Noise Floor

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
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done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 + 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures < –27 dB (with respect to total CDMA channel
power).

BTS Frame Error Rate

This test verifies the BTS receive Frame Error Rate (FER) on all Traffic
Channel elements currently configured on all equipped MCCs (fullrate at
one percent FER) at an RF input level of –119 dBm on the main RX
antenna paths using all equipped MCCs and BBX2s at the site. The
diversity RX antenna paths are also tested using the lowest equipped
MCC/CE ONLY.

There are no pass/fail criteria associated with FER readings
taken at level below –119 dBm, other than to verify that
the FER measurement reflects changes in the RX input
signal level.

NOTE
4
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Background

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency per the current CDF file assignment.  All tests are
performed using the external calibrated test set controlled by the same
command. All measurements are via the appropriate TX OUT connector.

Pilot gain will be set to 541 for each antenna, and the forward link will
be disabled for all Traffic CHannel (TCH) elements from the MCCs. The
BBX2 will be keyed up using both bbxlvl and bay level offsets, to
generate a CDMA carrier (with pilot channel element only).  RF output
will be set at 40 dBm as measured at the appropriate TX output.

The calibrated communications test set will measure and return the
attenuation level of all spurious and IM products with respect to the
mean power of the CDMA channel measured in a 1.23 MHz bandwidth,
in dB, verifying that results meet system tolerances at the following test
points (see also Figure 4-1):

� For 800 MHz:

– At least –45 dB @ + 750 kHz from center frequency

– At least –45 dB @ – 750 kHz from center frequency

– At least –60 dB @ –1980 kHz from center frequency

– At least –60 dB @  + 1980 kHz from center frequency

� For 1.9 GHz:

– At least –45 dB @ + 900 kHz from center frequency

– At least –45 dB @ – 900 kHz from center frequency

The BBX2 will then dekey, and if selected, the redundant BBX2 will be
assigned to the current TX antenna path under test. The test will then be
repeated.

4



TX Spectral Purity Transmit Mask Acceptance Test – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/20014-10

Spectral Purity TX Mask
Acceptance Test

Follow the steps in Table 4-5 to verify the transmit spectral mask
specification on all TX antenna paths using all BBXs equipped at the
BTS.

Table 4-5: Test Spectral Purity Transmit Mask

Step Action

1 Set up the test equipment for TX acceptance tests per Table 4-1.

2 Select the BBX2s to be tested.

3 From the Tests menu, select TX Mask.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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Background

This test verifies the transmitted pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT connector.

Pilot gain will be set to 262 for each antenna, and all TCH elements
from the MCCs will be forward link disabled. The BBX2 will be keyed
up using both bbxlvl and bay level offsets to generate a CDMA carrier
(with pilot channel element only, Walsh code 0). RF output power is set
at 40 dBm as measured at the appropriate TX output.

The calibrated communications test set will measure and return the pilot
channel element digital waveform quality (rho) percentage, verifying
that the result meets system tolerances:

Waveform quality (Rho) should be > 0.912.

The BBX2 will then dekey, and if selected, the redundant BBX2 will be
assigned to the current TX antenna path under test. The test will then be
repeated.

Waveform Quality (Rho)
Acceptance Test

Follow the steps in Table 4-6 to verify the pilot channel element
waveform quality (rho) on the specified TX antenna paths using BBXs
equipped at the BTS.

Table 4-6: Test Waveform Quality (Rho)

Step Action

1 Set up the test equipment for TX acceptance tests per Table 4-1.

2 Select the BBX2s to be tested.

3 From the Tests menu, select Rho.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

This test verifies the transmitted pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency  per the current
CDF file assignment. All tests will be performed using the external
calibrated test set controlled by the same command. All measurements
will be via the TX OUT connector.

The pilot gain will be set to 262 for each antenna and all TCH elements
from the MCCs will be forward link disabled. The BBX2 will be keyed
up using both bbxlvl and bay level offsets to generate a CDMA carrier
(with pilot channel element only, Walsh code 0). TX power output is set
at 40 dBm as measured at the TX output.

The calibrated communications test set will measure and return the Pilot
Time Offset in �s, verifying that results meet system tolerances:

Pilot Time Offset should be within 3 �s of the target PT Offset 
(zero �s).

The BBX2 will then dekey, and if selected, the redundant BBX2 will be
assigned to the current TX antenna path under test. The test will then be
repeated.

This test also executes and returns the TX Frequency and
TX Waveform Quality (rho) ATP tests, however, only Pilot
Time Offset results are written to the ATP test report.

NOTE

Pilot Time Offset Acceptance
Test

Follow the steps in Table 4-7 to verify the Pilot Time Offset on the
specified TX antenna paths using BBXs and BDCs equipped at the BTS.

Table 4-7: Test Pilot Time Offset

Step Action

1 Set up the test equipment for TX acceptance tests per Table 4-1.

2 Select the BBX2s to be tested.

3 From the Tests menu, select Pilot Time Offset.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.
. . . continued on next page
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Table 4-7: Test Pilot Time Offset

Step Action

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

This test verifies the Code Domain Power and Noise Floor of each BBX
carrier keyed up at a specific frequency  per the current CDF file
assignment. All tests are performed using the external calibrated test set
controlled by the same command. All measurements are via the
appropriate TX OUT connector.

Pilot gain will be set to 262 for each antenna and all equipped MCCs
will be configured to supply all odd–numbered Walsh code Traffic
channel elements by enabling Orthagonal Channel Noise Source
(OCNS) on all odd MCC/CEs, (maximum 32 full rate channels with an
OCNS gain of 81).  All even–numbered Walsh code Traffic channel
elements will not  have OCNS enabled, and are considered “OFF”.  All
equipped MCCs will be forward–link enabled for the antenna/sector
under test.

The BBX2 will be keyed up using both bbxlvl and bay level offsets, to
generate a CDMA carrier consisting of pilot and OCNS channels.  RF
output power is set at 40 dBm as measured at the appropriate TX output.

The calibrated communications test set will measure and return the
channel element power (dB) of all specified Walsh channels within the
CDMA spectrum. Additional calculations will be performed to verify the
following parameters are met (Figure 4-2):

� Traffic channel element power level will be verified by calculating the
ratio of PILOT power to OCNS gain of all traffic channels (root sum
of the square (RSS) of each OCNS gain divided by the Pilot power).
This value should be 10.2 dB + 2.0 dB.

� Noise floor (unassigned  “OFF” even numbered Walsh channels)  are
verified to be < –27 dB (with respect to total CDMA channel power).

The BBX2 will then dekey, and if selected, the redundant BBX2 will be
assigned to the current TX antenna path under test. The test will then be
repeated. Upon completion of the test, OCNS channels will be disabled
on the specified MCC/CEs.

Code Domain Power/Noise
Floor Test

Follow the steps in Table 4-8 to verify the Code Domain Power/Noise
floor of each BBX carrier keyed up at a specific frequency.
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Table 4-8: Test Code Domain Power/Noise Floor

Step Action

1 Set up the test equipment for TX acceptance tests per Table 4-1.

2 Select the BBX2s and MCCs to be tested.

3 From the Tests menu, select TX Mask.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 Click OK. The status report window is displayed and a Directions pop-up is displayed.

7 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

8 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR: 
< –27 dB SPEC.

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

MAX OCNS
CHANNEL

MIN OCNS
CHANNEL

8.2 dB 12.2 dB

MAX NOISE
FLOOR

Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR:
< –27 dB

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

FAILURE – DOES NOT
MEET MIN OCNS SPEC.

FAILURE – EXCEEDS
MAX OCNS SPEC. 8.2 dB 12.2 dB

FAILURE – EXCEEDS MAX
NOISE FLOOR SPEC.

Code Domain Power/Noise Floor (OCNS Pass) Example

Figure 4-2: Code Domain Analyzer CD Power/Noise Floor Display Examples

Code Domain Power/Noise Floor (OCNS Failure) Example
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Background

This test verifies the BTS Frame Erasure Rate (FER) on all TCHs
currently configured on all equipped MCCs (fullrate at 1% FER) at –119
dBm on the main RX antenna paths.  The test is performed on all
diversity RX antenna path using only the lowest equipped MCC/CE. All
tests are performed using the external calibrated test set as the signal
source controlled by the same command. All measurements are via the
LMF.

Pilot gain will be set to 262 for each TX antenna, and the forward link
for all TCH elements from the MCCs will be disabled. The BBX2 will
be keyed up using only bbxlvl level offsets, to generate a CDMA
carrier (with pilot channel element only). TX power output is set at +10
dBm. (The BBX must be keyed in order to enable the RX receive
circuitry.)

The LMF will prompt the MCC/CE under test to measure all–zero
longcode and provide the Frame Erasure Rate (FER) report on the
selected active MCC on the Reverse Link for both the main and diversity
RX antenna paths, verifying results meet the following specification:

FER returned less than 1% and Total Frames measured is 1500.

The BBX2 will then dekey, and if selected, the redundant BBX2 will be
assigned to the current RX antenna paths under test. The test will then be
repeated.
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FER Acceptance Test

Follow the steps in Table 4-9 to verify the FER on all RX antenna paths
using all BBXs equipped at the BTS.

Table 4-9: Test FER

Step Action

1 Set up the test equipment for RX acceptance tests per Table 4-1.

2 Select the BBX2s and MCCs to be tested.

3 From the Tests menu, select FER.

4 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier pick
list.

NOTE
To select multiple items, hold down the Shift or Ctrl key while making the selections.

5 Enter the appropriate channel number in the Carrier n Channels box.

6 From the RX Branch pick list, select the branch/branches to be tested.

7 Select the desired rate from the Rate Set pick list (1 = 9600, 2 = 14400).

8 Click OK. The status report window is displayed and a Directions pop-up is displayed.

9 Follow the cable connection directions as they are displayed. The test results are displayed in the
status report window.

10 Click Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Background

Each time an ATP test is run, an ATP report is updated and must be
saved using the Save Results button to close the status report window.
The ATP report will not be updated if the status reports window is closed
using the Dismiss button.

ATP Report

A separate report is created for each BTS and includes the following for
each test:

� Test name

� PASS or FAIL

� Description information (if applicable)

� BBX number

� Channel number

� Carrier number

� Sector number

� Upper test limit

� Lower test limit

� Test result

� Time stamp

� Details/Warning information (if applicable)

Follow the procedures in the Table 4-10 to view and create a printable
file for the ATP report.

Table 4-10: Generating an ATP Report

Step Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station pick list.

3 Click on the Report button.

4 Click on a column heading to start the report.

5 If not desiring a printable file copy, click on the Dismiss button.

6 If requiring a printable file copy, select the desired file, type in the pick list and click on the Save
button.
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Updating CBSC Calibration
Data Files

After completing the TX calibration and audit, updated CAL file
information must be moved from the LMF Windows environment back
to the CBSC, a Unix environment. The following procedures detail
moving files from one environment to the other.

Copying CAL files from LMF to a Disk

Follow the procedures in Table 5-1 to copy the CAL files from a CDMA
LMF computer to a 3.5 diskette.

Table 5-1: Copying CAL Files to a Diskette

Step Action

1 With Windows running on the CDMA LMF computer, insert a disk into Drive A:.

2 Launch the Windows Explorer Program from your Programs menu list.

3 Select the applicable wlmf/cdma/bts–# folder.

4 Drag the bts–#.cal file to Drive A.

5 Repeat Steps 3 and 4, as required, for other bts–# folders.

 

Copying CAL Files from Diskette to the CBSC

Follow the procedures in Table 5-2 to copy CAL files from a diskette to
the CBSC.

Table 5-2: Copying CAL Files from Diskette to the CBSC

Step Action

1 Log in to the CBSC on the OMC–R Unix workstation using your account name and password.

2 Place your diskette containing calibration file(s) in the workstation diskette drive.

3 Type in eject –q and press the Enter key.

4 Type in mount and press the Enter key.

NOTE
� Check to see that the message “floppy/no_name” is displayed on the last line.

� If the eject command was previously entered, floppy/no_name will be appended with a number.
Use the explicit floppy/no_name reference displayed.

5 Type in cd /floppy/no_name and press the Enter key.

6 Type in ls –lia and press the Enter key. Verify that the bts–#.cal file is on the diskette.

7 Type in cd and press the Enter key.

8 Type in pwd and press the Enter key. Verify you are in your home directory (/home/<name>).

. . . continued on next page
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Table 5-2: Copying CAL Files from Diskette to the CBSC

Step Action

9 With Solaris versions of Unix, create a Unix–formatted version of the bts–#.cal file in your home
directory by entering the following command:

dos2unix  /floppy/no_name/bts–#.cal  bts–#.cal and press the Enter key (where # is BTS
number).

NOTE
Other versions of Unix do not support the dos2unix command. In these cases, use the Unix cp
(copy) command. The copied files will contain DOS line feed characters which must be edited out
with a Unix text editor.

10 Type in ls –l *.cal and press the Enter key. Verify the cal files have been copied.

11 Type in eject and press the Enter key.

12 Remove the diskette from the workstation.
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Removing External Test
Equipment

Perform the procedure in Table 5-3 to disconnect the test equipment and
configure the BTS for active service.

Table 5-3: Remove External Test Equipment

Step Action

1 Disconnect all external test equipment from all TX and RX connectors at the rear of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the frame RF interface panel.

! CAUTION
Verify that all sector antenna feed lines are connected to the correct ports on the frame. Crossed
antenna cables will cause system degradation of call processing.

Reset All Devices and Initialize
Site Remotely

Generally, devices in the BTS should not be left with data and code
loaded from the CDMA LMF. The configuration data and code loads
used for normal operation could be different from those stored in the
CDMA LMF files. By resetting all devices, the required data and code
can be loaded from the CBSC when spans are again active.

To reset all devices and have the OMCR/CBSC bring up the site
remotely, perform the procedure in Table 5-4.

Table 5-4: Reset BTS Devices and Remote Site Initialization

Step Action

1 Terminate the CDMA LMF session by following the procedures in Table 5-6.

2 NOTE
In the following step, performing Table 2-6 DC voltage measurements other than those using the MAP
VOLT and AMP indicators is not necessary if DC power system components have not been replaced
during the optimization and/or ATP process.

Cycle BTS power off, as specified in Table 2-9, and on, as specified in Table 2-5, Table 2-6, and step 1
of Table 2-7, respectively.

3 Reconnect spans by following the procedure in Table 5-7.

4 Notify the OMCR/CBSC to take control of the site and download code and data to the BTS.

5 Verify the CBSC can communicate with the GLIs.

 

Bringing Modules into Service
with the CDMA LMF

Whenever possible, have the CBSC/MM bring up the site
and enable all devices at the BTS.

IMPORTANT

*
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If there is a reason code and/or data should or could not be loaded
remotely from the CBSC, follow the steps outlined in Table 5-5 as
required to bring BTS processor modules from OOS to INS state.

Table 5-5: Bring Modules into Service

Step Action

1 In the CDMA LMF GUI environment, select the device(s) you wish to enable.

NOTE
� The MGLI, CSM, and applicable BDC must be INS before an MCC can be enabled to INS.

� Processors which must be enabled and the order of enabling are as follows:

– MGLI

– GLI

– CSMs

– MCCs

2 Click on Device from the menu bar.

3 Click on Enable from the Device menu. A status report window is displayed.

NOTE
If a BBX is selected, a transceiver parameters window is displayed to collect keying information. Do
not enable the BBX.

4 Click Cancel to close the transceiver parameters window, if applicable.

5 Click OK to close the status report window.

The selected devices that successfully change to INS change color to green.
 

Terminating LMF
Session/Removing Terminal

Perform the procedure in Table 5-6 as required to terminate the LMF
GUI session and remove the CDMA LMF computer.

Table 5-6: Remove LMF

Step Action

! CAUTION
Do not power down the CDMA LMF terminal without performing the procedure below.
Corrupted/lost data files may result.

1 Log out of all BTS sessions and exit CDMA LMF by clicking on the File selection in the menu bar
and selecting Exit from the File menu list.

2 Click Yes in the Confirm Logout pop–up message which appears.

3 In the Windows Task Bar, click Start and select Shutdown.

4 Click Yes when the Shut Down Windows message appears

5 Wait for the system to shut down and the screen to go blank.

. . . continued on next page
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Table 5-6: Remove LMF

Step Action

6 Disconnect the CDMA LMF terminal Ethernet port from the BTS frame.

7 Disconnect the CDMA LMF terminal serial port, the RS–232–to–GPIB interface box, and the
GPIB cables as required for equipment transport.

 

Connecting BTS T1/E1 Spans

Before leaving the site, connect any T1 or E1 span connectors removed
previously to allow the LMF to control the BTS. Refer to Table 5-7 and
Figure 3-7.

Table 5-7: Connect T1 or E1 Spans

Step Action

1 Re–connect any disconnected span connectors to the Span I/O A and B boards.

2 If equipped, ensure the CSU is powered on.

3 Verify span status, ensuring the OMC–R/CBSC can communicate with the BTS.

Before Leaving the site

Be sure all requirements listed in Table 5-8 are completed before leaving
the site.

Table 5-8: Check Before Leaving the Site

Step Action

1 All battery circuit breakers (for occupied shelves) are  ON (pushed in).

2 Both heat exchanger circuit breakers on the DC PDA are set to  ON (pushed in), and the heat
exchanger blowers are running.

3 The External Blower Assembly (EBA) power cable is connected, and the EBA is running.

4 The MAP power switch is set to  ON, and the POWER (green) LED is lighted.

5 The BATT TEST switch on the MAP is set to  OFF, and the BATT. TEST (amber) LED is not lighted.

6 No alarm conditions are being reported to the CBSC with all frame doors closed.
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5



08/01/2001 1X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Chapter 6: Basic Troubleshooting

Table of Contents

Basic Troubleshooting Overview 6-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Overview 6-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Installation 6-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Log into Cell-Site 6-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Communicate with Power Meter 6-5. . . . . . . . . . . . . . . . . . . . . . . 
Cannot Communicate with Communications Analyzer 6-6. . . . . . . . . . . . 

Troubleshooting: Download 6-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Download DATA to Any Device (Card) 6-7. . . . . . . . . . . . . . . . . . 
Cannot ENABLE Device 6-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
LPA Errors 6-9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Calibration 6-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Bay Level Offset Calibration Failure 6-10. . . . . . . . . . . . . . . . . . . . . . . . . . . 
Calibration Audit Failure 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Basic Troubleshooting – RF Path Fault Isolation 6-12. . . . . . . . . . . . . . . . . . . . . . . . 
Overview 6-12. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
If Every Test Fails 6-12. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Verify BLO Checkbox 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
If Faults Are Isolated 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Fault Isolation Flowchart 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Flowchart Prerequisites 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
TX Power Output Fault Isolation Flowchart 6-14. . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Transmit ATP 6-15. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Perform Txmask Measurement 6-15. . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Perform Rho or Pilot Time Offset Measurement 6-15. . . . . . . . . . . 
Cannot Perform Code Domain Power and Noise Floor Measurement 6-16. 
Cannot Perform Carrier Measurement 6-16. . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Receive ATP 6-17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Multi–FER Test Failure 6-17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: CSM Checklist 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Problem Description 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Intermittent 19.6608 MHz Reference Clock / GPS Receiver Operation 6-18
No GPS Reference Source 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Checksum Failure 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GPS Bad RX Message Type 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
CSM Reference Source Configuration Error 6-19. . . . . . . . . . . . . . . . . . . . . 

6



Table of Contents  – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/2001

Takes Too Long for CSM to Come INS 6-19. . . . . . . . . . . . . . . . . . . . . . . . 

SCCP Backplane Troubleshooting 6-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Introduction 6-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Connector Functionality 6-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
SCCP Backplane Troubleshooting Procedure 6-21. . . . . . . . . . . . . . . . . . . . 
Digital Control Problems 6-21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
DC Power Problems 6-24. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
TX and RX Signal Routing Problems 6-25. . . . . . . . . . . . . . . . . . . . . . . . . . 

RFDS – Fault Isolation 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Introduction 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
All tests fail 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
All RX and TX paths fail 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
All tests fail on a single antenna 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Module Front Panel LED Indicators and Connectors 6-28. . . . . . . . . . . . . . . . . . . . . 
Module Status Indicators 6-28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
LED Status Combinations for All Modules 
(except GLI2, CSM, BBX2, MCC24, MCC8E) 6-28. . . . . . . . . . . . . . . . . . 
DC/DC Converter LED Status Combinations 6-28. . . . . . . . . . . . . . . . . . . . 
CSM LED Status Combinations 6-29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GLI2 LED Status Combinations 6-31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GLI2 Pushbuttons and Connectors 6-32. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
BBX2 LED Status Combinations 6-33. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
MCC24 LED Status Combinations 6-33. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
LPA Shelf LED Status Combinations 6-34. . . . . . . . . . . . . . . . . . . . . . . . . . 

Basic Troubleshooting – Span Control Link 6-35. . . . . . . . . . . . . . . . . . . . . . . . . . . 
Span Problems (No Control Link) 6-35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Set BTS Site Span Configuration 6-36. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6



Basic Troubleshooting Overview

08/01/2001 6-11X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Overview

The information in this chapter addresses some of the scenarios likely to
be encountered by Customer Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides “what to do if” basic troubleshooting
suggestions when the BTS equipment does not perform per the
procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained from experience in Motorola labs and
classrooms.
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Cannot Log into Cell-Site

Table 6-1: Login Failure Troubleshooting Procedures

� Step Action

1 If MGLI2 LED is solid RED, it implies a hardware failure. Reset MGLI2 by
re-seating it. If this persists, install RGLI2 card in MGLI2 slot and retry. A Red
LED may also indicate no termination on an external LAN connector (power entry
compartment at rear of frame).

2 Verify that the span line is disconnected at the Span I/O card. If the span is still
connected, verify the CBSC has disabled the BTS.

3 Try ‘ping’ing the MGLI2.

4 Verify the LMF is connected to the primary LAN (LAN A) at the LAN shelf
below the SCCP cage. If LAN A is not the active LAN, force a LAN switch to
LAN A by following the procedure in Table 6-2.

5 Verify the LMF was configured properly.

6 If a Xircom parallel BNC LAN interface is being used, verify the BTS-LMF cable
is RG-58 (flexible black cable of less than 2.5 feet length).

7 Verify the external LAN connectors are properly terminated (power entry
compartment at rear of frame).

8 Verify a T-adapter is not used on LMF computer side connector when connected
to the primary LAN at the LAN shelf.

9 Try connecting to the Ethernet Out port in the power entry compartment (rear of
frame). Use a TRB–to–BNC (triax–to–coax) adapter at the LAN connector for this
connection.

10 Re-boot the CDMA LMF and retry.

11 Re-seat the MGLI2 and retry.

12 Verify GLI2 IP addresses are configured properly by following the procedure in
Table 6-3.

 

Table 6-2: Force Ethernet LAN A to Active State as Primary LAN

� Step Action

1 If LAN A is not the active LAN, make certain all external LAN connectors are
terminated with 50Ω loads or cabled to another frame.

2 If it has not already been done, connect the LMF computer to the stand–alone or
starter frame, as applicable (Table 3-6).

3 If it has not already been done, start a GUI LMF session and log into the BTS on
the active LAN (Table 3-7).

. . . continued on next page
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Table 6-2: Force Ethernet LAN A to Active State as Primary LAN

� ActionStep

4 Remove the 50Ω termination from the LAN B IN connector in the power entry
compartment at the rear of the stand–alone or starter frame. The CDMA LMF
session will become inactive.

5 Disconnect the LMF computer from the LAN shelf LAN B connector and connect
it to the LAN A connector.

6 If the LAN was successfully forced to an active state (the cards in any cage can be
selected and statused), proceed to step 13.

7 With the 50Ω termination still removed from the LAN B IN connector, remove
the 50Ω termination from LAN B OUT connector. If more than one frame is
connected to the LAN, remove the termination from the last frame in the chain.

8 If the LAN was successfully forced to an active state (the cards in any cage can be
selected and statused), proceed to step 13.

9 With the 50Ω terminations still removed from LAN B, unseat each GLI card in
each frame connected to the LAN, until all are disconnected from the shelf
backplanes.

10 Reseat each GLI card until all are reconnected.

11 Allow the GLIs to power up, and attempt to select and status cards in the CCP
shelves. If LAN A is active, proceed to step 13.

12 If LAN A is still not active, troubleshoot or continue troubleshooting following
the procedures in Table 6-1.

13 Replace the 50Ω terminations removed from the LAN B IN and OUT connectors.
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Table 6-3: GLI IP Address Setting

� Step Action

1 If it has not previously been done, establish an MMI communication session with
the GLI card as described in Table 3-11.

2 Enter the following command to display the IP address and subnet mask settings
for the card:

config lg0 current

A response similar to the following will be displayed:

GLI2>config lg0 current

lg0: IP address is set to 
DEFAULT (configured based on card location)

lg0: netmask is set to 
DEFAULT (255.255.255.128)

3 If the IP address setting response shows an IP address rather than “Default
(configured based on card location),” enter the following:

config lg0 ip default

A response similar to the following will be displayed:

GLI2>config lg0 ip default

_param_config_lg0_ip(): param_delete(): 0x00050001
lg0: ip address set to DEFAULT

4 If the GLI subnet mask setting does not display as “DEFAULT
(255.255.255.128),” set it to default by entering the following command:

config lg0 netmask default

A response similar to the following will be displayed:

GLI2>config lg0 netmask default

_param_config_lg0_netmask(): param_delete(): 0x00050001
lg0: netmask set to DEFAULT

. . . continued on next page
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Table 6-3: GLI IP Address Setting

� ActionStep

5 Set the GLI route default to default by entering the following command:

config route default default

A response similar to the following will be displayed:

GLI2>config route default default

_esh_config_route_default(): param_delete(): 0x00050001
route: default gateway set to DEFAULT

6 NOTE
Changes to the settings will not take effect unless the GLI is reset.

When changes are completed, close the MMI session, and reset the GLI card.

7 Once the GLI is reset, re–establish MMI communication with it and issue the
following command to confirm its IP address and subnet mask settings:

config lg0 current

A response similar to the following will be displayed:

GLI2>config lg0 current

lg0: IP address is set to 
DEFAULT (configured based on card location)

lg0: netmask is set to 
DEFAULT (255.255.255.128)

8 Repeat steps 1 through 7 for all remaining GLI2s, including those in any
additional, inter–connected frames.

 

Cannot Communicate with
Power Meter

Table 6-4: Troubleshooting a Power Meter Communication Failure

� Step Action

1 Verify Power Meter is connected to LMF with GPIB adapter.

2 Verify cable setup as specified in Chapter 3.

3 Verify the GPIB address of the Power Meter is set to 13. Refer to Test Equipment
setup section of Chapter 3 for details.

. . . continued on next page
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Table 6-4: Troubleshooting a Power Meter Communication Failure

� ActionStep

4 Verify that Com1 port is not used by another application.

5 Verify that the communications analyzer is in Talk&Listen mode, not Control
mode.

 

Cannot Communicate with
Communications Analyzer

Table 6-5: Troubleshooting a Communications Analyzer Communication Failure

� Step Action

1 Verify analyzer is connected to LMF with GPIB adapter.

2 Verify cable setup.

3 Verify the GPIB address is set to 18.

4 Verify the GPIB adapter DIP switch settings are correct. Refer to Test Equipment
setup section for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
then power-cycle the GPIB Box and retry.

6 If a Hyperterm window is open for MMI, close it.

7 Verify the LMF GPIB address is set to 18.

8 Verify the analyzer is in Talk&Listen mode, not Control mode.
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Table 6-6: Troubleshooting Code Download Failure

� Step Action

1 Verify T1 or E1 span is disconnected from the BTS at CSU.

2 Verify LMF can communicate with the BTS device using the Status function.

3 Communication to MGLI2 must first be established before trying to talk to any
other BTS device. MGLI2 must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If card LED is solid RED, it implies hardware failure. Reset card by re-seating it.
If this persists, replace card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat card and try again.

7 If BBX2 reports a failure message and is OOS_RAM, the code load was OK.
Status it to verify the load.

8 If the download portion completes and the reset portion fails, reset the device by
clicking on the device and selecting DEVICE > RESET.

 

Cannot Download DATA to Any
Device (Card)

Table 6-7: Troubleshooting Data Download Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 Verify the ROM and RAM code loads are of the same release by statusing the
card. Refer to Chapter 3, “Download the BTS” for more information.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow on the LMF) with data downloaded to the
device. The color of the device on the LMF changes to green, once it is
enabled.

The three states that devices can be displayed:

� Enabled (green, INS)

� Disabled (yellow, OOS_RAM)

� Reset (blue, OOS_ROM)

Table 6-8: Troubleshooting Device Enable (INS) Failure

� Step Action

1 Re-seat card and repeat code and data load procedure.

2 If CSM cannot be enabled, verify the CDF file has correct latitude and longitude
data for cell site location and GPS sync.

3 Ensure primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify 19.6608 MHz CSM clock is present; MCCs will not go INS without it.

5 BBXs should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time,” verify the CSM is enabled.
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LPA Errors

Table 6-9: LPA Errors

� Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers,
then connect an MMI cable to the LPA and set up a HyperTerminal connection.
Enter ALARMS in the Hyperterminal window. The resulting hyperTerminal
display may provide an indication of the problem. (Call Field Support for further
assistance.)
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Bay Level Offset Calibration
Failure

Table 6-10: Troubleshooting BLO Calibration Failure

� Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup
section) and connection is made to the proper TX port.

2 Verify the parameters in the bts–#.cdf file are set correctly for the following
bands:

For 1900 MHz:
Bandclass=1; Freq_Band=16

For 800 MHz:
Bandclass=0; Freq_Band=8

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the
LPA by pulling the circuit breaker, and, after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors
from the power sensor.

5 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
power-cycle (turn power off and on) the GPIB Box and retry.

6 Verify the power sensor is functioning properly by checking it with the 1–mW (0
dBm) Power Ref signal.

7 If communication between the LMF and Power Meter is working, the Meter
display will show “RES :’’

8 Verify the combiner frequency is the same as the test freq/chan.
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Calibration Audit Failure

Table 6-11: Troubleshooting Calibration Audit Failure

� Step Action

1 Verify Power Meter is configured correctly (refer to the test equipment setup
section).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors
from the power sensor.

3 Verify that no LPA is in alarm state (rapidly flashing red LED). Reset the LPA by
pulling the circuit breaker, and, after 5 seconds, pushing back in.

4 Verify the power sensor is functioning properly by checking it with the 1 mW (0
dBm) Power Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Download Code > Download Data>Enable. 
Re-try the audit.

6 Verify GPIB adapter is not locked up. Under normal conditions, only 2 green
LEDs must be ‘ON’ (Power and Ready). If any other LED is continuously ‘ON’,
power-cycle (turn power off and on) the GPIB Box and retry.
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Overview

The optimization (RF path characterization or calibration) and
post-calibration (audit) procedures measure and limit-check the BTS
reported transmit and receive levels of the path from each BBX2 to the
back of the frame. When a fault is detected, it is specific to a receive or
transmit path. The troubleshooting process in this section determines the
most probable cause of the fault.

As the calibration and audit tests are performed, results are displayed in
the LMF test status report window. When faults are encountered, the test
procedure in progress continues running and displaying any further
faults. If it appears that there are major faults, the test can be aborted.

The test results can be saved to a bts–<#>.rpt file in the
wlmf\cdma\bts–<#> folder. To do this, close the test status report
window using the Save Results button.

Closing the test status report window with the Dismiss
button will delete the test results without saving them.

IMPORTANT

*

If a test is re–run or a new calibration, audit, or test is run and the results
are saved, the previous test results in the bts–<#>.rpt file are
overwritten. To prevent losing previous test results in the bts–<#>.rpt
file, refer to the procedure in Table 4-10 before performing further
testing with the LMF.

If there are major faults, recheck the test equipment attachments for
errors. If none are found, close the test status report window using the
Save Results button, and save the contents of the resulting
bts–<#>.rpt file as described in Table 4-10. Also, note other specifics
about the failure, and proceed with the fault isolation procedure.

If Every Test Fails

Check the calibration equipment for proper operation by manually
setting the signal generator output attenuator to the lowest output power
setting. Connect the output port to the spectrum analyzer RF input port.
Set the signal generator output attenuator to –90 dBm, and switch on the
RF output. Verify that the spectrum analyzer can receive the signal,
indicate the correct signal strength (accounting for the cable insertion
loss), and indicate the approximate frequency.
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Verify BLO Checkbox

When performing a calibration with the TX Calibration... or All
Cal/Audit... functions, the Verify BLO checkbox should normally be
checked. When a calibration fails, determine if any items such as
directional couplers or combiners have been added to the TX path. If
additional items have been installed in the path, try re–running the
calibration with Verify BLO unchecked. If calibration still does not
pass, refer to the following paragraphs and use the TX output fault
isolation flowchart to identify the most probable cause of the failure.

If Faults Are Isolated

If the fault reports are isolated between successful path checks, the root
cause of the faults most likely lies with one or more of the Field
Replaceable Unit (FRU) modules. If more than one failure was reported,
look for a common denominator in the data. For example, if any TX test
fails on one sector only, the BBX2 assigned to that sector (Table 1-5) is a
likely cause. Also, look at the severity of the failure. If the path loss is
just marginally out of the relaxed specification limit during the
post-calibration TX audit, suspect excessive cable loss. If limits are
missed by a wide margin, suspect mis–wired cables or total device
failure. Use the TX output fault isolation flowchart in Figure 6-1 to
identify the strongest possible cause for a failed TX test.

Fault Isolation Flowchart

The flowchart covers the transmit path. Transmit paths usually fail the
lower test limit, indicating excessive loss in some component in the BTS
site or mis–wiring. A failure of an upper limit usually indicates a
problem with the test setup or external equipment. Before replacing a
suspected FRU, always repeat and verify the test results to rule out a
transient condition. If a BBX2 fails an upper limit in the post–calibration
audit procedure, re–calibrate and verify the out–of–tolerance condition
for that BBX2 and/or sector before replacement.

Flowchart Prerequisites

Before entering the fault isolation sequence outlined in the flowchart, be
sure the following have been completed:

� GLIs, MCCs, and BBXs have been downloaded with the correct ROM
code, RAM code, and data (Table 3-13, Table 3-14, and Table 3-15).

� MGLI, CSMs, and MCCs are enabled (Table 3-14, Table 3-17, and
Table 3-18, respectively)

� Be sure the LED on the correct CCD card is solid green.

� Be sure no alarms are being reported by opening an LMF alarm
window as outlined in Table 3-47.
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TX Power Output Fault
Isolation Flowchart

Figure 6-1: TX Output Fault Isolation Flowchart
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Cannot Perform Txmask
Measurement

Table 6-12: Troubleshooting TX Mask Measurement Failure

� Step Action

1 Verify that TX audit passes for the BBX2(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED). Re-set the
LPA by pulling the circuit breaker, and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot
Time Offset Measurement

Table 6-13: Troubleshooting Rho and Pilot Time Offset Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the
CDF file.

3 Re–load MGLI2 data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the
LPA by pulling the circuit breaker, and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may
indicate that the GPS is still phasing (i.e. trying to reach and maintain 0 freq.
error). Go to the freq. bar in the upper right corner of the Rho meter and select Hz.
Press <Shift–avg> and enter 10, to obtain an average Rho value. This is an
indication the GPS has not stabilized before going INS and may need to be
re-initialized.
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Cannot Perform Code Domain
Power and Noise Floor
Measurement

Table 6-14: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the
CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).

 

Cannot Perform Carrier
Measurement

Table 6-15: Troubleshooting Carrier Measurement Failure

� Step Action

1 Perform the test manually, using the spread CDMA signal. Verify High Stability
10 MHz Rubidium Standard is warmed up (60 minutes) and properly connected to
test set-up.
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Multi–FER Test Failure

Table 6-16: Troubleshooting Multi-FER Failure

� Step Action

1 Verify test equipment set up is correct for a FER test.

2 Verify test equipment is locked to 19.6608 and even second clocks. The yellow
LED (REF UNLOCK) must be OFF.

3 Verify MCCs have been loaded with data and are INS–ACT.

4 Disable and re-enable the MCC (1 or more based on extent of failure).

5 Disable, re-load code and data, and re-enable MCC (one or more MCCs based on
extent of failure).

6 Verify antenna connections to frame are correct based on the directions messages.
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Problem Description

Many Clock Synchronization Manager (CSM) board problems may be
resolved in the field before sending the boards to the factory for repair.
This section describes known CSM problems identified in field returns,
some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz
Reference Clock / GPS
Receiver Operation

If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB,” then replace with version ‘‘BC’’ or higher, and return model AB
to the repair center.

No GPS Reference Source

Check the CSM boards for proper hardware configuration.

RF–GPS (Local GPS) – CSM kit SGLN1145, which should be installed
in Slot l, has an on-board GPS receiver; while kit SGLN4132, in Slot 2,
does not have a GPS receiver.

Remote GPS (R–GPS) – Kit SGLN4132, which should be installed in
both Slot 1 and Slot 2, does not have a GPS receiver.

Any incorrectly configured board must be returned to the repair center.
Do not attempt to change hardware configuration in the field. Also,
verify the GPS antenna is not damaged and is installed per recommended
guidelines.

Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance, or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return CSM board
back to repair center if the attempt to reload fails.

GPS Bad RX Message Type

This is believed to be caused by a later version of CSM software (3.5 or
higher) being downloaded, via LMF, followed by an earlier version of
CSM software (3.4 or lower), being downloaded from the CBSC.
Download again with CSM software code 3.5 or higher. Return CSM
board back to repair center if attempt to reload fails.

6



Troubleshooting: CSM Checklist – continued

08/01/2001 6-191X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

CSM Reference Source
Configuration Error

This is caused by incorrect reference source configuration performed in
the field by software download. CSM kit SGLN1145 and SGLN4132
must have proper reference sources configured (as shown below) to
function correctly.

CSM Kit No. Hardware Configuration CSM Slot No. Reference Source Configuration

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

2 Primary = Remote GPS
Backup = Either LFR or HSO

SGLN4132 Without GPS Receiver 1 Primary = Remote GPS
Backup = Either LFR or HSO

2 Primary = Mate GPS
Backup = Either LFR or HSO

Takes Too Long for CSM to
Come INS

This may be caused by a delay in GPS acquisition. Check the accuracy
flag status and/or current position. Refer to the CSM system time/GPS
and LFR/HSO verification section in Chapter 3. At least 1 satellite
should be visible and tracked for the “surveyed” mode and 4 satellites
should be visible and tracked for the “estimated” mode. Also, verify
correct base site position data used in “surveyed” mode.

6



SCCP Backplane Troubleshooting

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/20016-20

Introduction

The SCCP backplane is a multi–layer board that interconnects all the
SCCP modules.  The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This will
allow the Cellular Field Engineer (CFE) to:

� Determine which connector(s) is associated with a specific problem
type.

� Allow the isolation of problems to a specific cable or connector.

Span Line Connector

The span line input is an 8 pin RJ–45 connector that provides a primary
and secondary (if used) span line interface to each GLI2 in the SCCP
shelf.  The span line is used for MM/EMX switch control of the Master
GLI2 and also all the BBX2 traffic.

Power Input (Return A and B connectors)

Provides a 27 volt input for use by the power supply modules.

Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the SCCP backplane. These include
a VCC/Ground input connector, a Harting style multiple pin interface,
and a +15V/Analog Ground output connector. The Transceiver Power
Module converts 27/48 Volts to a regulated +15, +6.5, +5.0 volts to be
used by the SCCP shelf cards.

GLI2 Connector

This connector consists of a Harting 4SU digital connector and a
6–conductor  coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLI2s in the SCCP backplane.

GLI2 Ethernet “A” and “B” Connections

These SMB connectors are located on the SCCP backplane and connect
to the GLI2 board. This interface provides all the control and data
communications over the Ethernet LAN between the master GLI2, the
other GLI2, and the LMF.

BBX2 Connector

Each BBX2 connector consists of a Harting 2SU/1SU digital connector
and two 6–conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBX2s in the SCCP backplane.
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CIO Connectors

� RX RF antenna path signal inputs are routed through RX paths of the
DRDCs or TRDCs at the RF interface panel (rear of frame), and
through coaxial cables to the two MPC modules. The three “A” (main)
signals go to one MPC; the three “B” (diversity) to the other. The
MPC outputs the low–noise–amplified signals via the SCCP
backplane to the CIO where the signals are split and sent to the
appropriate BBX2.

� A digital bus then routes the baseband signal through the BBX2, to
the backplane, and then on to the MCC24/MCC8E slots.

� Digital TX antenna path signals originate at the MCC24/MCC8Es.
Each output is routed from the MCC24/MCC8E slot through the
backplane to the appropriate BBX2.

� TX RF path signal originates from the BBX2, travels through the
backplane to the CIO, through the CIO, and then through
multi-conductor coaxial cabling to the trunking module and LPAs in
the LPA shelf.

SCCP Backplane
Troubleshooting Procedure

The following tables provide standard procedures for troubleshooting
problems that appear to be related to a defective SCCP backplane. The
tables are broken down into possible problems and steps which should
be taken in an attempt to find the root cause.

It is important to note that all steps be followed before
replacing ANY SCCP backplane.

IMPORTANT

*

Digital Control Problems

No GLI2 Control via LMF (all GLI2s)

Table 6-17: No GLI2 Control via LMF (all GLI2s)

Step Action

1 Check the Ethernet LAN for proper connection, damage,
shorts, or opens.

2 Be sure the LAN IN and OUT connectors in the power entry
compartment are properly terminated.

3 Be sure the proper IP address is entered in the Network Login
tab of the LMF login screen.

4 Verify SCCP backplane Shelf ID DIP switch is set correctly.
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Table 6-17: No GLI2 Control via LMF (all GLI2s)

Step Action

5 Visually check the master GLI2 connectors (both module and
backplane) for damage.

6 Replace the master GLI2 with a known good GLI2.

No GLI2 Control through Span Line Connection (All GLI2s)

Table 6-18: No GLI2 Control through Span Line Connection (Both
GLI2s)

Step Action

1 Verify SCCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLI2s are correctly configured in the
OMCR/CBSC data base.

3 Verify the span configurations set in the GLI2s match those in
the OMC–R/CBSC database (refer to Table 6-29).

4 Visually check the master GLI2 connectors (both module and
backplane) for damage.

5 Replace the master GLI2 with a known good GLI2.

6 Check the span line inputs from the top of the frame to the
master GLI2 for proper connection and damage.

Table 6-19: MGLI2 Control Good – No Control over Co–located
GLI2

Step Action

1 Verify that the BTS and GLI2s are correctly configured in the
OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or
opens.

3 Visually check all GLI2 connectors (both module and
backplane) for damage.

4 Replace the remaining GLI2 with a known good GLI2.

 

No AMR Control (MGLI2 good)

Table 6-20: MGLI2 Control Good – No Control over AMR

Step Action

1 Visually check the master GLI2 connectors (both module and
backplane) for damage.

2 Replace the master GLI2 with a known good GLI2.

3 Replace the AMR with a known good AMR.
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No BBX2 Control in the Shelf

Table 6-21: MGLI2 Control Good – No Control over Co–located
BBX2s

Step Action

1 Visually check all GLI2 connectors (both module and
backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check BBX2 connectors (both module and
backplane) for damage.

4 Replace the BBX2 with a known good BBX2.

No (or Missing) Span Line Traffic

Table 6-22: BBX2 Control Good – No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI2 connectors (both module and
backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check all span line distribution (both connectors and
cables) for damage.

4 If the problem seems to be limited to one BBX2, replace the
BBX2 with a known good BBX2.

No (or Missing) MCC24/MCC8E Channel Elements

Table 6-23: No MCC24/MCC8E Channel Elements

Step Action

1 Verify CEs on a co–located MCC24/MCC8E (MccType=2)

2 If the problem seems to be limited to 1 MCC24/MCC8E,
replace the MCC24/MCC8E with a known good
MCC24/MCC8E.

– Check connectors (both module and backplane) for
damage.

3 If no CEs on any MCC24/MCC8E:

– Verify clock reference to CIO.
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DC Power Problems

Potentially lethal voltage and current levels are routed to
the BTS equipment. This test must be carried out with a
second person present, acting in a safety role. Remove all
rings, jewelry, and wrist watches prior to beginning this
test.

WARNING

No DC Input Voltage to SCCP Shelf Power Supply Modules

Table 6-24: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the frame. Determine if any
circuit breakers are tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the SCCP
shelf  and attempt to reset it.

– If breaker trips again, there is probably a cable or breaker
problem within the frame or DC PDA.

– If breaker does not trip, there is probably a defective
module or sub–assembly within the shelf. Perform the
tests in Table 2-3 to attempt to isolate the module.

2 Verify that the PS1 and PS2 circuit breakers on the DC PDA
are functional.

3 Remove the frame rear access panel (Figure 2-1), and use a
voltmeter to determine if the input voltage is being routed to
the SCCP backplane. Measure the DC voltage level between:

� The PWR_IN_A and PWR_RTN_A contacts on the
extreme right side at the rear of the backplane

� The PWR_IN_B and PWR_RTN_B contacts on the
extreme right side at the rear of the backplane

– If the voltage is not present, there is probably a cable or
circuit breaker problem within the frame or DC PDA.

4 If everything appears to be correct, visually inspect the PS1
and PS2 power supply module connectors.

5 Replace the power supply modules with a known good
module.

6 If steps 1 through 4 fail to indicate a problem, an SCCP
backplane failure has occurred (possibly an open trace).
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI2,
BBX2, or Switchmodule

Table 6-25: No DC Input Voltage to any SCCP Shelf Module

Step Action

1 Verify steps outlined in Table 6-24 have been performed.

2 Inspect the defective module connectors (both module and
backplane) for damage.

3 Replace suspect module with known good module.

TX and RX Signal Routing
Problems

Table 6-26: TX and RX Signal Routing Problems

Step Action

1 Inspect all Harting Cable connectors and backplane
connectors for damage in all the affected board slots.

2 Perform steps outlined in the RF path troubleshooting
flowchart in Figure 6-1.
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Introduction

The RFDS is used to perform Pre–Calibration Verification and
Post-Calibration Audits which  limit-check the RFDS-generate and
reported receive levels of every path from the RFDS through the
directional coupler coupled paths. In the event of test failure, refer to the
following tables.

All tests fail

Table 6-27: RFDS Fault Isolation – All tests fail

Step Action

1 Check the calibration equipment for proper operation by manually setting the signal generator output
attenuator to the lowest output power setting and connecting the output port to the spectrum analyzer
rf input port.

2 Set the signal generator output attenuator to –90 dBm, and switch on the rf output. Verify that the
spectrum analyzer can receive the signal, indicate the correct signal strength, (accounting for the cable
insertion loss), and the approximate frequency.

3 Visually inspect RF cabling. Make sure each directional coupler forward and reflected port connects to
the RFDS antenna select unit on the RFDS.

4 Check the wiring against the site documentation wiring diagram or the BTS Site Installation manual.

5 Verify RGLI and TSU have been downloaded.

6 Check to see that all RFDS boards show green on the front panel indicators. Visually check for
external damage.

7 If any boards that do not show green replace the RFDS with a known–good unit. Re–test after
replacement.

 

All RX and TX paths fail

If every receive or transmit path fails, the problem most likely lies with
the rf converter board or the transceiver board. Replace the RFDS with a
known–good unit and retest.

All tests fail on a single
antenna

If all path failures are on one antenna port, forward and/or reflected,
make the following checks.

Table 6-28: RFDS Fault Isolation – All tests fail on single antenna path

Step Action

1 Visually inspect the site interface cabinet internal cabling to the suspect directional coupler antenna
port.

2 Verify the forward and reflected ports connect to the correct RFDS antenna select unit positions on the
RFDS backplane. Refer to the installation manual for details.

. . . continued on next page
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Table 6-28: RFDS Fault Isolation – All tests fail on single antenna path

Step Action

3 Replace the RFDS with a known–good unit.

4 Replace the RF cables between the affected directional coupler and RFDS.

NOTE
Externally route the cable to bypass suspect segment.
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Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for
All Modules (except GLI2, CSM,
BBX2, MCC24, MCC8E)

PWR/ALM LED

The following list describes the states of the module status indicator.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED – module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status
Combinations

The PWR CNVTR has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

PWR/ALM LED

The following list describes the states of the bi-color LED.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED –  module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status Combinations
PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS–RAM code from the Flash
EPROM, if available. If not available, the OOS–ROM code is loaded
from the Flash EPROM.

� Solid GREEN – module is INS_ACT or INS_STBY no alarm.

� Solid RED – Initial power up or module is operating in a fault (alarm)
condition.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Long RED/Short GREEN – OOS_ROM alarm.

� Rapidly Flashing GREEN – OOS_RAM no alarm or 
INS_ACT in DUMB mode.

� Short RED/Short GREEN – OOS_RAM alarm.

� Long GREEN/Short RED – INS_ACT  or INS_STBY alarm.

� Off – no DC power  or on-board fuse is open.

� Solid YELLOW – After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

Figure 6-2: CSM Front Panel Indicators & Monitor Ports

 . . . continued on next page
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector – Only accessible behind front panel. The RS–232
MMI port connector is intended to be used primarily in the development
or factory environment, but may be used in the field for
debug/maintenance purposes.
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GLI2 LED Status Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown in Figure 6-3.

The indicators and controls consist of:

� Four LEDs

� One pushbutton

ACTIVE LED
Solid GREEN – GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off – GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER LED

� Solid GREEN – GLI2 is Master (sometimes referred to as MGLI2).

� Off – GLI2 is non-master (i.e., Slave).

ALARM LED

� Solid RED – GLI2 is in a fault condition or in reset.

� While in reset transition,  STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

� While in reset transition,  STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

� Off – No Alarm.

STATUS LED

� Flashing GREEN– GLI2 is in service (INS), in a stable operating
condition.

� On – GLI2 is in OOS RAM state operating downloaded code.

� Off – GLI2 is in OOS ROM state operating boot code.

SPANS LED

� Solid GREEN – Span line is connected and operating.

� Solid RED – Span line is disconnected or a fault condition exists.
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GLI2 Pushbuttons and
Connectors

RESET Pushbutton – Depressing the RESET pushbutton causes a
partial reset of the CPU and a reset of all board devices. GLI2 will be
placed in the OOS_ROM state

MMI Connector – The RS–232MMI port connector is intended to be
used primarily in the development or factory environment but may be
used in the field for debug/maintenance purposes.

MMI PORT
CONNECTOR

ACTIVE LED

S
TAT

U
S

R
E

S
E

T
A

LA
R

M
S

P
A

N
S

M
A

S
T

E
R

M
M

I
A

C
T

IV
E

STATUS LED

RESET
PUSHBUTTON

ALARM LED

SPANS LED

MASTER LED

Figure 6-3: GLI2 Front Panel Operating Indicators
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BBX2 LED Status
Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

� Solid GREEN – INS_ACT no alarm

� Solid RED Red – initializing or power-up alarm

� Slowly Flashing GREEN – OOS_ROM no alarm

� Long RED/Short GREEN – OOS_ROM alarm

� Rapidly Flashing GREEN – OOS_RAM no alarm

� Short RED/Short GREEN – OOS_RAM alarm

� Long GREEN/Short RED – INS_ACT  alarm

MCC24 LED Status
Combinations

The MCC24 module has LED indicators and connectors as described
below. See Figure 6-4. Note that the figure does not show the connectors
as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED

� RED – fault on module

ACTIVE LED

� Off – module is inactive, off-line, or not processing traffic.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Rapidly Flashing Green – OOS_RAM no alarm.

� Solid GREEN – module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

� Solid RED – module is powered but is in reset or the BCP is inactive.

MMI Connectors

� The RS–232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

� The RJ–11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.

 . . . continued on next page
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PWR/ALM LED

LENS
(REMOVABLE)

ACTIVE LED
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R
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Figure 6-4: MCC24 Front Panel LEDs and LED Indicators
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LPA Shelf LED Status
Combinations

LPA Module LED

Each LPA module is provided with a bi–color LED on the ETIB module
next to the MMI connector. Interpret this LED as follows:

� GREEN — LPA module is active and is reporting no alarms (Normal
condition).

� Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.

� Flashing RED — LPA is in alarm.
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Span Problems (No Control
Link)

Table 6-29: Troubleshoot Control Link Failure

� Step Action

1 Connect the CDMA LMF computer to the MMI port on the applicable MGLI2/GLI2 as shown in
Figure 6-5.

2 Start an MMI communication session with the applicable MGLI2/GLI2 by using the Windows
desktop shortcut icon (refer to Table 3-11).

3 Once the connection window opens, press the CDMA LMF computer Enter key until the GLI2>
prompt is obtained.

4 At the GLI2>  prompt, enter:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span B – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0–131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC–R/CBSC span configuration requires it.

5 The span configurations loaded in the GLI must match those in the OMCR/CBSC database for the
BTS. If they do not, proceed to Table 6-30.

6 Repeat steps 1 through 5 for all remaining GLIs.

7 If the span settings are correct, verify the edlc parameters using the show command.

Any alarm conditions indicate that the span is not operating correctly.

� Try looping back the span line from the DSX panel back to the MM, and verify that the looped
signal is good.

� Listen for control tone on the appropriate timeslot from the Base Site and MM.

8 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the dropdown menu.

9 If no TCHs in groomed MCCs (or in whole SCCP shelf) can process calls, verify that the ISB
cabling is correct and that ISB A and ISB B cables are not swapped.
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Figure 6-5: MGLI/GLI Board MMI Connection Detail
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Perform the following procedure ONLY if span
configurations loaded in the MGLI2/GLI2s do not match
those in the OMCR/CBSC data base, AND ONLY when the
exact configuration data is available. Loading incorrect
span configuration data will render the site inoperable.

IMPORTANT

*
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Table 6-30: Set BTS Span Parameter Configuration

� Step Action

1 If not previously done, connect the CDMA LMF computer to the MMI port on the applicable
MGLI2/GLI2 as shown in Figure 6-5.

2 If there is no MMI communication session in progress with the applicable MGLI2/GLI2, initiate
one by using the Windows desktop shortcut icon (refer to Table 3-11).

3 At the GLI2>  prompt, enter:

config  ni  format  <option>  <cr> 

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni format option 
Next available options:
   LIST –     option : Span Option
                    E1_1 : E1_1 – E1 HDB3 CRC4    no TS16
                    E1_2 : E1_2 – E1 HDB3 no CRC4 no TS16
                    E1_3 : E1_3 – E1 HDB3 CRC4    TS16
                    E1_4 : E1_4 – E1 HDB3 no CRC4 TS16
                    T1_1 : T1_1 – D4, AMI, No ZCS
                    T1_2 : T1_2 – ESF, B8ZS
                    J1_1 : J1_1 – ESF, B8ZS (Japan) – Default
                    J1_2 : J1_2 – ESF, B8ZS
                    T1_3 : T1_3 – D4, AMI, ZCS
>

NOTE
With this command, all active (in–use) spans will be set to the same format.

4 To set or change the span type, enter the correct option from the list at the entry prompt (>), as
shown in the following example:

> T1_2  <cr> 

NOTE
The entry is case–sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP:  Invalid command
GLI2>

5 An acknowledgement similar to the following will be displayed:

The value has been programmed. It will take effect after the next reset.
GLI2>

. . . continued on next page
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Table 6-30: Set BTS Span Parameter Configuration

� ActionStep

6 If the current MGLI/GLI span rate must be changed, enter the following MMI command:

config  ni  linkspeed   <cr> 

The terminal will display a response similar to the following:

Next available options:
 LIST –  linkspeed : Span Linkspeed
                   56K : 56K (default for T1_1 and T1_3 systems)

                   64K : 64K (default for all other span configurations)
>

NOTE
With this command, all active (in–use) spans will be set to the same linkspeed.

7 To set or change the span linkspeed, enter the required option from the list at the entry prompt (>),
as shown in the following example:

> 64K  <cr>

NOTE
The entry is case–sensitive and must be typed exactly as it appears in the list. If the entry is typed
incorrectly, a response similar to the following will be displayed:

CP: Invalid command

GLI2>

8 An acknowledgement similar to the following will be displayed:

The value has been programmed.  It will take effect after the next reset.
GLI2>

9 If the span equalization must be changed, enter the following MMI command:

config ni equal  <cr>

The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal span equal 
Next available options:
   LIST –       span : Span
                       a : Span A
                       b : Span B
                       c : Span C
                       d : Span D
                       e : Span E
                       f : Span F
>

. . . continued on next page
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Table 6-30: Set BTS Span Parameter Configuration

� ActionStep

10 At the entry prompt (>), enter the designator from the list for the span to be changed as shown in
the following example:

> a  <cr>
The terminal will display a response similar to the following:

COMMAND SYNTAX: config ni equal a equal 
Next available options:
   LIST –      equal : Span Equalization
                       0 : 0–131 feet (default for T1/J1)
                       1 : 132–262 feet
                       2 : 263–393 feet
                       3 : 394–524 feet
                       4 : 525–655 feet
                       5 : LONG HAUL
                       6 : 75 OHM
                       7 : 120 OHM (default for E1)
>

11 At the entry prompt (>), enter the code for the required equalization from the list as shown in the
following example:

> 0  <cr>
The terminal will display a response similar to the following:

> 0
The value has been programmed. It will take effect after the next reset.
GLI2>

12 Repeat steps 9 through 11 for each in–use span.

13 * IMPORTANT
After executing the config  ni  format, config ni linkspeed, and/or config  ni  equal commands,
the affected MGLI/GLI board MUST be reset and reloaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and
linkspeed used at the site.

Press the RESET button on the MGLI2/GLI2 for changes to take effect.

. . . continued on next page
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Table 6-30: Set BTS Span Parameter Configuration

� ActionStep

14 Once the MGLI/GLI has reset, execute the following command to verify span settings are as
required:

config ni current  <cr>  (equivalent of span view command)

The system will respond with a display similar to the following:

The frame format in flash is set to use T1_2.
Equalization:
  Span A – 0–131 feet
  Span B – 0–131 feet
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: 64K
Currently, the link is running at 64K 
The actual rate is 0

15 If the span configuration is not correct, perform the applicable step from this table to change it and
repeat steps 13 and 14 to verify required changes have been programmed.

16 Return to step 6 of Table 6-29.
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Verification of Test Equipment
Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

� Deliveries Per established procedures

� Floor Plan Verified

�

�

�

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

�

�

�

Factory Data:

BBX2

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

� Site Temperature

� Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

� Frame ID DIP Switches Per site equipage

� Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________
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Pre–Power and Initial Power
Tests

Table A3a: Pre–power Checklist

OK Parameter Specification Comments

� Pre–power–up tests Table 2-3

Table 2-4

�

�

�

�

�

�

�

�

�

�

Internal Cables:

Span

CSM

Power

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

LAN A IN & OUT terminators

LAN B IN & OUT terminators

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

installed

installed

� Air Impedance Cage (single cage) installed

� Initial power–up tests Table 2-4

Table 2-6

Table 2-7

�

�

Frame fans

LEDs

operational

illuminated

Comments:_________________________________________________________
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General Optimization Checklist

Table A3b: General Optimization Checklist

OK Parameter Specification Comments

�

�

�

Preparing the LMF

Load LMF software

Create site–specific BTS directory

Create HyperTerminal connection

Table 3-1

Table 3-2

Table 3-3

�

�

�

�

LMF–to–BTS Connection

Verify GLI2 ethernet address settings

Ping LAN A

Ping LAN B

Table 3-6

Table 6-3

Table 3-12

Table 3-12

�

�

�

�

�

�

�

�

�

�

Verify ROM code loads for software
release

Download/Enable MGLI2s

Download/Enable GLI2s

Set Site Span Configuration

Set CSM clock source

Enable CSMs

Download/Enable MCC24s/MCC8Es

Download BBX2s

Download TSU  (in RFDS)

Program TSU NAM

Table 3-13

Table 3-14

Table 3-14

Table 6-29

Table 3-16

Table 3-17

Table 3-15

Table 3-15

Table 3-39

Table 3-46

� Test Set Calibration Table 3-25

Comments:_________________________________________________________
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GPS Receiver Operation

Table A-4: GPS Receiver Operation

OK Parameter Specification Comments

� GPS Receiver Control Task State:

tracking satellites

Verify parameter

� Initial Position Accuracy: Verify Estimated
or Surveyed

� Current Position:
lat
lon
height

RECORD in
msec and cm also
convert to deg
min sec

� Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

� GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

� Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LFR Receiver Operation

Table A-5: LFR Receiver Operation

OK Parameter Specification Comments

� Station call letters M X Y Z
assignment.

As specified in site
documentation

� SN ratio is > 8 dB

� LFR Task State: 1fr

locked to station xxxx

Verify parameter

� Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LPA IM Reduction 

Table A-6: LPA IM Reduction

Parameter Comments

CARRIER
OK LPA

# 2:1
3–Sector

BP
3–Sector

Specification

� 1A C1 C1 No Alarms

� 1B C1 C1 No Alarms

� 1C C1 C1 No Alarms

� 1D C1 C1 No Alarms

� 3A C2 C2 No Alarms

� 3B C2 C2 No Alarms

� 3C C2 C2 No Alarms

� 3D C2 C2 No Alarms

Comments:_________________________________________________________
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TX Bay Level Offset / Power
Output Verification for
3–Sector Configurations 

1–Carrier
2–Carrier Non–adjacent Channels

Table A-7: TX BLO Calibration (3–Sector: 1–Carrier and 2–Carrier Non–adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1A = dB

BBX2–r, ANT–1A = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+5 dB)
prior to calibration

BBX2–2, ANT–2A = dB

BBX2–r, ANT–2A = dB

�
BBX2–3, ANT–3A = dB

BBX2–r, ANT–3A = dB

�
BBX2–4, ANT–1B = dB

BBX2–r, ANT–1B = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+5 dB)
prior to calibration

BBX2–5, ANT–2B = dB

BBX2–r, ANT–2B = dB

�
BBX2–6, ANT–3B = dB

BBX2–r, ANT–3B = dB

�
BBX2–1, ANT–1A = dB

BBX2–r, ANT–1A = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post–calibration

BBX2–2, ANT–2A = dB

BBX2–r, ANT–2A = dB

�

carrier 1
BBX2–3, ANT–3A = dB

BBX2–r, ANT–3A = dB

�
BBX2–4, ANT–1B = dB

BBX2–r, ANT–1B = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post–calibration

BBX2–5, ANT–2B = dB

BBX2–r, ANT–2B = dB

�

carrier 2
BBX2–6, ANT–3B = dB

BBX2–r, ANT–3B = dB

 

Comments:________________________________________________________

__________________________________________________________________
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2–Carrier Adjacent Channel

Table A-8: TX Bay Level Offset Calibration (3–Sector: 2–Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX2–1, ANT–1A = dB

BBX2–r, ANT–1A = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX2–2, ANT–2A = dB

BBX2–r, ANT–2A = dB

�
BBX2–3, ANT–3A = dB

BBX2–r, ANT–3A = dB

�
BBX2–4, ANT–1B = dB

BBX2–r, ANT–1B = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX2–5, ANT–2B = dB

BBX2–r, ANT–2B = dB

�
BBX2–6, ANT–3B = dB

BBX2–r, ANT–3B = dB

�
BBX2–1, ANT–1A = dB

BBX2–r, ANT–1A = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–2, ANT–2A = dB

BBX2–r, ANT–2A = dB

�

carrier 1
BBX2–3, ANT–3A = dB

BBX2–r, ANT–3A = dB

�
BBX2–4, ANT–1B = dB

BBX2–r, ANT–1B = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX2–5, ANT–2B = dB

BBX2–r, ANT–2B = dB

�

carrier 2
BBX2–6, ANT–3B = dB

BBX2–r, ANT–3B = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Antenna VSWR

Table A-9: TX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1A

   < (1.5 : 1)

�
VSWR –
Antenna 2A

   < (1.5 : 1)

�
VSWR –
Antenna 3A

   < (1.5 : 1)

�
VSWR –
Antenna 1B

   < (1.5 : 1)

�
VSWR –
Antenna 2B

   < (1.5 : 1)

�
VSWR –
Antenna 3B

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________

A
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RX Antenna VSWR

Table A-10: RX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1A

   < (1.5 : 1)

�
VSWR –
Antenna 2A

   < (1.5 : 1)

�
VSWR –
Antenna 3A

   < (1.5 : 1)

�
VSWR –
Antenna 1B

   < (1.5 : 1)

�
VSWR –
Antenna 2B

   < (1.5 : 1)

�
VSWR –
Antenna 3B

   < (1.5 : 1)

Comments:_________________________________________________________

Alarm Verification

Table A-11: CDI Alarm Input Verification

OK Parameter Specification Data

�

Verify CDI alarm input
operation per Table 3-5.

BTS Relay #XX –
Contact Alarm
Sets/Clears

Comments:_________________________________________________________
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Date Site

SCCP Shelf

Site I/O A & B
SCCP Shelf
CSM–1

CSM–2
HSO/LFR

CCD–1

CCD–2

AMR–1

AMR–2

MPC–1

MPC–2

Fans 1–2

GLI2–1

GLI2–2

BBX2–1

BBX2–2

BBX2–3

BBX2–4
BBX2–5

BBX2–6

BBX2–R1

MCC24–1

MCC24–2

MCC24–3

MCC24–4

CIO

SWITCH

PS–1

PS–2

A
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LPAs

LPA 1A

LPA 1B

LPA 1C

LPA 1D

LPA 3A

LPA 3B

LPA 3C

LPA 3D

A
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Appendix B: FRU Optimization/ATP Test Matrix
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Usage & Background

Periodic maintenance of a site may also mandate re–optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

Re–optimization steps listed for any assembly detailed in
the tables below must be performed anytime a RF cable
associated with it is replaced.

IMPORTANT

*

BTS Frame

Table B-1: When RF Optimization Is required on the BTS

Item Replaced Optimize:

SCCP Shelf All sector TX and RX paths to the SCCP
shelf

Multicoupler/
Preselector Card

The three or six affected sector RX paths for
the SCCP shelf in the BTS frames

BBX2 board RX and TX paths of the affected SCCP
shelf / BBX2 board

CIO Card All RX and TX paths of the affected
CDMA carrier

Any LPA Module The affected sector TX path.

DRDC or TRDC All affected sector RX and TX paths

RFDS The RFDS calibration RX & TX paths
(MONFWD/GENFWD)

Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table B-2: When to Optimize Inter–frame Cabling

Item Replaced Optimize:

Expansion frame–to–BTS
frame (RX) cables

The affected sector/antenna RX paths

Expansion frame–to–BTS
frame (TX) cables

The affected sector/antenna TX paths

B
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Detailed Optimization/ATP Test
Matrix

Table B-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumed that all modules are placed OOS–ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

Not every procedure required to bring the site back on line
is indicated in Table B-3. It is meant to be used as a
guideline ONLY. The table assumes that the user is familiar
enough with the BTS Optimization/ATP procedure to
understand which test equipment set ups, calibrations, and
BTS site preparation will be required before performing the
Table # procedures referenced.

IMPORTANT

*

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any SCCP BACKPLANE is replaced, it is assumed that only
power to the SCCP shelf being replaced is turned off via the breaker
supplying that shelf.

If any significant change in signal level results from any
component being replaced in the RX or TX signal flow
paths, it would be identified by re–running the RX and TX
calibration audit command.

NOTE

When the CIO is replaced, the SCCP shelf remains powered up. The
BBX2 boards may need to be removed, then re–installed into their
original slots, and re–downloaded (code and BLO data). RX and TX
calibration audits should then be performed.

B
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Table B-3: SC 4812ET Lite BTS Optimization and ATP Test Matrix
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Table 2-1

Initial Boards/Modules
Install, Preliminary
Operations, CDF Site
Equipage; etc.

� � � � � � � � � � � � � � � � � � �

Table 2-6 Initial Power-up � �

Table 3-6/

Table 3-7
Start LMF � �

Table 3-14/
Table 3-15

Download Code � � � � �

Table 3-17 Enable CSMs � �

Table 3-20 GPS &HSO Initialization /
Verification

� � � �

Table 3-21 LFR   Initialization /
Verification

� �

Table 3-34/
Table 3-35

TX Path Calibration � � �

Table 3-36 Download Offsets to BBX2 � �

Table 3-37 TX Path Calibration Audit � � � � � � � �

Table 3-45 RFDS Path Calibration � � � � � � � � � � � �

Table 4-5 Spectral Purity TX Mask � � � � � �

Table 4-6 Waveform Quality (rho) � � � � � � � �

Table 4-7 Pilot Time Offset � � � � � � � �

Table 4-8 Code Domain Power /
Noise Floor

� � �

Table 4-9 FER Test � � � � �

NOTE
Replace power supply modules one card at a time so that power to the SCCP shelf is not lost. If power
to the shelf is lost, all cards in the shelf must be downloaded again.
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Appendix C: BBX Gain Set Point vs. BTS Output Considerations
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Usage & Background

Table C-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX2 Gain Set Point  between 33.0 dBm and 44.0 dBm. The resultant
RF output (as measured at the top of the BTS in dBm) is shown in the
table.  The table assumes that the BBX2 Bay Level Offset (BLO) values
have been calculated.

As an illustration, consider a  BBX2 keyed up to produce a CDMA
carrier with only the Pilot channel (no MCCs forward link enabled).
Pilot gain is set to 262. In this case, the BBX2 Gain Set Point is shown
to correlate exactly to the actual RF output anywhere in the 33 to 44
dBm output range.  (This is the level used to calibrate the BTS).

Table C-1: BBX2 Gain Set Point vs. Actual BTS Output (in dBm)

dBm	

Gain

44 43 42 41 40 39 38 37 36 35 34 33

541 – – – – – – – 43.3 42.3 41.3 40.3 39.3

533 – – – – – – – 43.2 42.2 41.2 40.2 39.2

525 – – – – – – – 43 42 41 40 39

517 – – – – – – – 42.9 41.9 40.9 39.9 38.9

509 – – – – – – – 42.8 41.8 40.8 39.8 38.8

501 – – – – – – – 42.6 41.6 40.6 39.6 38.6

493 – – – – – – 43.5 42.5 41.5 40.5 39.5 38.5

485 – – – – – – 43.4 42.4 41.4 40.4 39.4 38.4

477 – – – – – – 43.2 42.2 41.2 40.2 39.2 38.2

469 – – – – – – 43.1 42.1 41.1 40.1 39.1 38.1

461 – – – – – – 42.9 41.9 40.9 39.9 38.9 37.9

453 – – – – – – 42.8 41.8 40.8 39.8 38.8 37.8

445 – – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 – – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 – – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 – – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 – – – – – 43 42 41 40 39 38 37

405 – – – – – 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table C-1: BBX2 Gain Set Point vs. Actual BTS Output (in dBm)

dBm	

Gain

333435363738394041424344

381 – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 – – – – 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 – – – – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 – – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 – – – 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 – – – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 – – 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 – – 43 42 41 40 39 38 37 36 35 34

286 – – 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 – 43 42 41 40 39 38 37 36 35 34 33

254 – 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 32.7

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 32.4

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 32.9 31.9

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 32.6 31.6

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 32.2 31.2
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Appendix D: CDMA Operating Frequency Information
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Introduction

Programming of each of the BTS BBX2 synthesizers is performed by the
BTS GLI2s via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX2.

1900 MHz PCS Channels

Figure D-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).
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Figure D-1: North America PCS Frequency Spectrum (CDMA Allocation) D
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Calculating 1900 MHz Center
Frequencies

Table D-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05 * 262 = 1943.10 MHz

� RX = TX – 80
Example: Channel 262
RX = 1943.10 – 50 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25
50 0032 1932.50 1852.50
75 004B 1933.75 1853.75
100 0064 1935.00 1855.00
125 007D 1936.25 1856.25
150 0096 1937.50 1857.50
175 00AF 1938.75 1858.75
200 00C8 1940.00 1860.00
225 00E1 1941.25 1861.25
250 00FA 1942.50 1862.50
275 0113 1943.75 1863.75
300 012C 1945.00 1865.00
325 0145 1946.25 1866.25
350 015E 1947.50 1867.50
375 0177 1948.75 1868.75
400 0190 1950.00 1870.00
425 01A9 1951.25 1871.25
450 01C2 1952.50 1872.50
475 01DB 1953.75 1873.75
500 01F4 1955.00 1875.00
525 020D 1956.25 1876.25
550 0226 1957.50 1877.50
575 023F 1958.75 1878.75

. . . continued on next page
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Table D-1: 1900 MHz TX and RX Frequency vs. Channel
Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

600 0258 1960.00 1880.00
625 0271 1961.25 1881.25
650 028A 1962.50 1882.50
675 02A3 1963.75 1883.75
700 02BC 1965.00 1885.00
725 02D5 1966.25 1886.25
750 02EE 1967.50 1887.50
775 0307 1968.75 1888.75
800 0320 1970.00 1890.00
825 0339 1971.25 1891.25
850 0352 1972.50 1892.50
875 036B 1973.75 1893.75
900 0384 1975.00 1895.00
925 039D 1976.25 1896.25
950 03B6 1977.50 1897.50
975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00
1025 0401 1981.25 1901.25
1050 041A 1982.50 1902.50
1075 0433 1983.75 1903.75
1100 044C 1985.00 1905.00
1125 0465 1986.25 1906.25
1150 047E 1987.50 1807.50
1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

Figure D-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure D-2: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation).
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Calculating 800 MHz Center
Frequencies

Table D-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1–777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013–1023
TX = 870 + 0.03 * (Channel# – 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 – 1023) = 869.76 MHz

� RX = TX – 45 MHz
Example: Channel 262
RX = 877.86 –45 = 832.86 MHz

Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500
. . . continued on next page
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Table D-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

50 0032 871.5000 826.5000

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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PN Offset Background

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 64 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBX2s, where the
corresponding I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table E-1.

PN Offset Usage 

There are three basic RF chip delays currently in use. It is important to
determine what RF chip delay is valid to be able to test the BTS
functionality.  This can be done by ascertaining  if the CDF file 
FineTxAdj  value was set to “on” when the MCC was downloaded with
“image data”. The FineTxAdj value is used to compensate for the
processing delay (approximately 20 �S) in the BTS using any type of
mobile meeting IS–97 specifications.

Observe the following guidelines:

� If the FineTxAdj value in the cdf file is 101 (65 HEX), the
FineTxAdj has not been set. The I and Q values from the 0 table
MUST be used.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

� If the FineTxAdj value in the cdf file is 197 (C5 HEX), FineTxAdj
has been set for the 13 chip table.

CDF file I and Q values can be represented in DECIMAL
or HEX. If using HEX, add 0x before the HEX value. If
necessary, convert HEX values in Table E-1 to decimal
before comparing them to cdf file I & Q value assignments.

IMPORTANT

*

– If you are using a Qualcomm mobile, use the I and Q values from
the 13 chip delay table.

– If you are using a mobile that does not have the 1 chip offset
problem, (any mobile meeting the IS–97 specification), use the 14
chip delay table.

E
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If the wrong  I and Q values are used with the wrong
FineTxAdj parameter, system timing problems will occur.
This will cause the energy transmitted to be “smeared”
over several Walsh codes (instead of the single Walsh code
that it was assigned to), causing erratic operation. Evidence
of smearing is usually identified by Walsh channels not at
correct levels or present when not selected in the Code
Domain Power Test.

IMPORTANT

*
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

0 17523 23459 4473 5BA3 29673 25581 73E9 63ED 4096 4096 1000 1000

1 32292 32589 7E24 7F4D 16146 29082 3F12 719A 9167 1571 23CF 0623
2 4700 17398 125C 43F6 2350 8699 092E 21FB 22417 7484 5791 1D3C

3 14406 26333 3846 66DD 7203 32082 1C23 7D52 966 6319 03C6 18AF
4 14899 4011 3A33 0FAB 19657 18921 4CC9 49E9 14189 2447 376D 098F

5 17025 2256 4281 08D0 28816 1128 7090 0468 29150 24441 71DE 5F79
6 14745 18651 3999 48DB 19740 27217 4D1C 6A51 18245 27351 4745 6AD7

7 2783 1094 0ADF 0446 21695 547 54BF 0223 1716 23613 06B4 5C3D
8 5832 21202 16C8 52D2 2916 10601 0B64 2969 11915 29008 2E8B 7150

9 12407 13841 3077 3611 18923 21812 49EB 5534 20981 5643 51F5 160B
10 31295 31767 7A3F 7C17 27855 28727 6CCF 7037 24694 28085 6076 6DB5

11 7581 18890 1D9D 49CA 24350 9445 5F1E 24E5 11865 18200 2E59 4718
12 18523 30999 485B 7917 30205 29367 75FD 72B7 6385 21138 18F1 5292

13 29920 22420 74E0 5794 14960 11210 3A70 2BCA 27896 21937 6CF8 55B1
14 25184 20168 6260 4EC8 12592 10084 3130 2764 25240 25222 6298 6286

15 26282 12354 66AA 3042 13141 6177 3355 1821 30877 109 789D 006D
16 30623 11187 779F 2BB3 27167 23525 6A1F 5BE5 30618 6028 779A 178C

17 15540 11834 3CB4 2E3A 7770 5917 1E5A 171D 26373 22034 6705 5612
18 23026 10395 59F2 289B 11513 23153 2CF9 5A71 314 15069 013A 3ADD

19 20019 28035 4E33 6D83 30409 30973 76C9 78FD 17518 4671 446E 123F
20 4050 27399 0FD2 6B07 2025 31679 07E9 7BBF 21927 30434 55A7 76E2

21 1557 22087 0615 5647 21210 25887 52DA 651F 2245 11615 08C5 2D5F
22 30262 2077 7636 081D 15131 18994 3B1B 4A32 18105 19838 46B9 4D7E

23 18000 13758 4650 35BE 9000 6879 2328 1ADF 8792 14713 2258 3979
24 20056 11778 4E58 2E02 10028 5889 272C 1701 21440 241 53C0 00F1

25 12143 3543 2F6F 0DD7 18023 18647 4667 48D7 15493 24083 3C85 5E13
26 17437 7184 441D 1C10 29662 3592 73DE 0E08 26677 7621 6835 1DC5

27 17438 2362 441E 093A 8719 1181 220F 049D 11299 19144 2C23 4AC8
28 5102 25840 13EE 64F0 2551 12920 09F7 3278 12081 1047 2F31 0417

29 9302 12177 2456 2F91 4651 23028 122B 59F4 23833 26152 5D19 6628
30 17154 10402 4302 28A2 8577 5201 2181 1451 20281 22402 4F39 5782

31 5198 1917 144E 077D 2599 19842 0A27 4D82 10676 21255 29B4 5307
32 4606 17708 11FE 452C 2303 8854 08FF 2296 16981 30179 4255 75E3

33 24804 10630 60E4 2986 12402 5315 3072 14C3 31964 7408 7CDC 1CF0
34 17180 6812 431C 1A9C 8590 3406 218E 0D4E 26913 115 6921 0073

35 10507 14350 290B 380E 17749 7175 4555 1C07 14080 1591 3700 0637
36 10157 10999 27AD 2AF7 16902 23367 4206 5B47 23842 1006 5D22 03EE

37 23850 25003 5D2A 61AB 11925 32489 2E95 7EE9 27197 32263 6A3D 7E07
38 31425 2652 7AC1 0A5C 27824 1326 6CB0 052E 22933 1332 5995 0534

39 4075 19898 0FEB 4DBA 22053 9949 5625 26DD 30220 12636 760C 315C
40 10030 2010 272E 07DA 5015 1005 1397 03ED 12443 4099 309B 1003

41 16984 25936 4258 6550 8492 12968 212C 32A8 19854 386 4D8E 0182
42 14225 28531 3791 6F73 18968 31109 4A18 7985 14842 29231 39FA 722F

43 26519 11952 6797 2EB0 25115 5976 621B 1758 15006 25711 3A9E 646F
44 27775 31947 6C7F 7CCB 26607 28761 67EF 7059 702 10913 02BE 2AA1

45 30100 25589 7594 63F5 15050 32710 3ACA 7FC6 21373 8132 537D 1FC4
46 7922 11345 1EF2 2C51 3961 22548 0F79 5814 23874 20844 5D42 516C

47 14199 28198 3777 6E26 19051 14099 4A6B 3713 3468 13150 0D8C 335E
48 17637 13947 44E5 367B 29602 21761 73A2 5501 31323 18184 7A5B 4708

49 23081 8462 5A29 210E 31940 4231 7CC4 1087 29266 19066 7252 4A7A
50 5099 9595 13EB 257B 22565 23681 5825 5C81 16554 29963 40AA 750B

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

51 32743 4670 7FE7 123E 28195 2335 6E23 091F 22575 6605 582F 19CD

52 7114 14672 1BCA 3950 3557 7336 0DE5 1CA8 31456 29417 7AE0 72E9
53 7699 29415 1E13 72E7 24281 30543 5ED9 774F 8148 22993 1FD4 59D1

54 19339 20610 4B8B 5082 29717 10305 7415 2841 19043 27657 4A63 6C09
55 28212 6479 6E34 194F 14106 17051 371A 429B 25438 5468 635E 155C

56 29587 10957 7393 2ACD 26649 23386 6819 5B5A 10938 8821 2ABA 2275
57 19715 18426 4D03 47FA 30545 9213 7751 23FD 2311 20773 0907 5125

58 14901 22726 3A35 58C6 19658 11363 4CCA 2C63 7392 4920 1CE0 1338
59 20160 5247 4EC0 147F 10080 17411 2760 4403 30714 5756 77FA 167C

60 22249 29953 56E9 7501 31396 29884 7AA4 74BC 180 28088 00B4 6DB8
61 26582 5796 67D6 16A4 13291 2898 33EB 0B52 8948 740 22F4 02E4

62 7153 16829 1BF1 41BD 23592 28386 5C28 6EE2 16432 23397 4030 5B65
63 15127 4528 3B17 11B0 19547 2264 4C5B 08D8 9622 19492 2596 4C24

64 15274 5415 3BAA 1527 7637 17583 1DD5 44AF 7524 26451 1D64 6753
65 23149 10294 5A6D 2836 31974 5147 7CE6 141B 1443 30666 05A3 77CA

66 16340 17046 3FD4 4296 8170 8523 1FEA 214B 1810 15088 0712 3AF0
67 27052 7846 69AC 1EA6 13526 3923 34D6 0F53 6941 26131 1B1D 6613

68 13519 10762 34CF 2A0A 19383 5381 4BB7 1505 3238 15969 0CA6 3E61
69 10620 13814 297C 35F6 5310 6907 14BE 1AFB 8141 24101 1FCD 5E25

70 15978 16854 3E6A 41D6 7989 8427 1F35 20EB 10408 12762 28A8 31DA
71 27966 795 6D3E 031B 13983 20401 369F 4FB1 18826 19997 498A 4E1D

72 12479 9774 30BF 262E 18831 4887 498F 1317 22705 22971 58B1 59BB
73 1536 24291 0600 5EE3 768 24909 0300 614D 3879 12560 0F27 3110

74 3199 3172 0C7F 0C64 22511 1586 57EF 0632 21359 31213 536F 79ED
75 4549 2229 11C5 08B5 22834 19046 5932 4A66 30853 18780 7885 495C

76 17888 21283 45E0 5323 8944 26541 22F0 67AD 18078 16353 469E 3FE1
77 13117 16905 333D 4209 18510 28472 484E 6F38 15910 12055 3E26 2F17

78 7506 7062 1D52 1B96 3753 3531 0EA9 0DCB 20989 30396 51FD 76BC
79 27626 7532 6BEA 1D6C 13813 3766 35F5 0EB6 28810 24388 708A 5F44

80 31109 25575 7985 63E7 27922 32719 6D12 7FCF 30759 1555 7827 0613
81 29755 14244 743B 37A4 27597 7122 6BCD 1BD2 18899 13316 49D3 3404

82 26711 28053 6857 6D95 26107 30966 65FB 78F6 7739 31073 1E3B 7961
83 20397 30408 4FAD 76C8 30214 15204 7606 3B64 6279 6187 1887 182B

84 18608 5094 48B0 13E6 9304 2547 2458 09F3 9968 21644 26F0 548C
85 7391 16222 1CDF 3F5E 24511 8111 5FBF 1FAF 8571 9289 217B 2449

86 23168 7159 5A80 1BF7 11584 17351 2D40 43C7 4143 4624 102F 1210
87 23466 174 5BAA 00AE 11733 87 2DD5 0057 19637 467 4CB5 01D3

88 15932 25530 3E3C 63BA 7966 12765 1F1E 31DD 11867 18133 2E5B 46D5
89 25798 2320 64C6 0910 12899 1160 3263 0488 7374 1532 1CCE 05FC

90 28134 23113 6DE6 5A49 14067 25368 36F3 6318 10423 1457 28B7 05B1
91 28024 23985 6D78 5DB1 14012 24804 36BC 60E4 9984 9197 2700 23ED

92 6335 2604 18BF 0A2C 23951 1302 5D8F 0516 7445 13451 1D15 348B
93 21508 1826 5404 0722 10754 913 2A02 0391 4133 25785 1025 64B9

94 26338 30853 66E2 7885 13169 29310 3371 727E 22646 4087 5876 0FF7
95 17186 15699 4322 3D53 8593 20629 2191 5095 15466 31190 3C6A 79D6

96 22462 2589 57BE 0A1D 11231 19250 2BDF 4B32 2164 8383 0874 20BF
97 3908 25000 0F44 61A8 1954 12500 07A2 30D4 16380 12995 3FFC 32C3

98 25390 18163 632E 46F3 12695 27973 3197 6D45 15008 27438 3AA0 6B2E
99 27891 12555 6CF3 310B 26537 22201 67A9 56B9 31755 9297 7C0B 2451

100 9620 8670 2594 21DE 4810 4335 12CA 10EF 31636 1676 7B94 068C

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

101 6491 1290 195B 050A 23933 645 5D7D 0285 25414 12596 6346 3134

102 16876 4407 41EC 1137 8438 18087 20F6 46A7 7102 19975 1BBE 4E07
103 17034 1163 428A 048B 8517 19577 2145 4C79 20516 20026 5024 4E3A

104 32405 12215 7E95 2FB7 28314 23015 6E9A 59E7 19495 8958 4C27 22FE
105 27417 7253 6B19 1C55 25692 16406 645C 4016 17182 19143 431E 4AC7

106 8382 8978 20BE 2312 4191 4489 105F 1189 11572 17142 2D34 42F6
107 5624 25547 15F8 63CB 2812 32729 0AFC 7FD9 25570 19670 63E2 4CD6

108 1424 3130 0590 0C3A 712 1565 02C8 061D 6322 30191 18B2 75EF
109 13034 31406 32EA 7AAE 6517 15703 1975 3D57 8009 5822 1F49 16BE

110 15682 6222 3D42 184E 7841 3111 1EA1 0C27 26708 22076 6854 563C
111 27101 20340 69DD 4F74 25918 10170 653E 27BA 6237 606 185D 025E

112 8521 25094 2149 6206 16756 12547 4174 3103 32520 9741 7F08 260D
113 30232 23380 7618 5B54 15116 11690 3B0C 2DAA 31627 9116 7B8B 239C

114 6429 10926 191D 2AAE 23902 5463 5D5E 1557 3532 12705 0DCC 31A1
115 27116 22821 69EC 5925 13558 25262 34F6 62AE 24090 17502 5E1A 445E

116 4238 31634 108E 7B92 2119 15817 0847 3DC9 20262 18952 4F26 4A08
117 5128 4403 1408 1133 2564 18085 0A04 46A5 18238 15502 473E 3C8E

118 14846 689 39FE 02B1 7423 20324 1CFF 4F64 2033 17819 07F1 459B
119 13024 27045 32E0 69A5 6512 31470 1970 7AEE 25566 4370 63DE 1112

120 10625 27557 2981 6BA5 17680 31726 4510 7BEE 25144 31955 6238 7CD3
121 31724 16307 7BEC 3FB3 15862 20965 3DF6 51E5 29679 30569 73EF 7769

122 13811 22338 35F3 5742 19241 11169 4B29 2BA1 5064 7350 13C8 1CB6
123 24915 27550 6153 6B9E 24953 13775 6179 35CF 27623 26356 6BE7 66F4

124 1213 22096 04BD 5650 21390 11048 538E 2B28 13000 32189 32C8 7DBD
125 2290 23136 08F2 5A60 1145 11568 0479 2D30 31373 1601 7A8D 0641

126 31551 12199 7B3F 2FA7 27727 23023 6C4F 59EF 13096 19537 3328 4C51
127 12088 1213 2F38 04BD 6044 19554 179C 4C62 26395 25667 671B 6443

128 7722 936 1E2A 03A8 3861 468 0F15 01D4 15487 4415 3C7F 113F
129 27312 6272 6AB0 1880 13656 3136 3558 0C40 29245 2303 723D 08FF

130 23130 32446 5A5A 7EBE 11565 16223 2D2D 3F5F 26729 16362 6869 3FEA
131 594 13555 0252 34F3 297 21573 0129 5445 12568 28620 3118 6FCC

132 25804 8789 64CC 2255 12902 24342 3266 5F16 24665 6736 6059 1A50
133 31013 24821 7925 60F5 27970 32326 6D42 7E46 8923 2777 22DB 0AD9

134 32585 21068 7F49 524C 28276 10534 6E74 2926 19634 24331 4CB2 5F0B
135 3077 31891 0C05 7C93 22482 28789 57D2 7075 29141 9042 71D5 2352

136 17231 5321 434F 14C9 28791 17496 7077 4458 73 107 0049 006B
137 31554 551 7B42 0227 15777 20271 3DA1 4F2F 26482 4779 6772 12AB

138 8764 12115 223C 2F53 4382 22933 111E 5995 6397 13065 18FD 3309
139 15375 4902 3C0F 1326 20439 2451 4FD7 0993 29818 30421 747A 76D5

140 13428 1991 3474 07C7 6714 19935 1A3A 4DDF 8153 20210 1FD9 4EF2
141 17658 14404 44FA 3844 8829 7202 227D 1C22 302 5651 012E 1613

142 13475 17982 34A3 463E 19329 8991 4B81 231F 28136 31017 6DE8 7929
143 22095 19566 564F 4C6E 31479 9783 7AF7 2637 29125 30719 71C5 77FF

144 24805 2970 60E5 0B9A 24994 1485 61A2 05CD 8625 23104 21B1 5A40
145 4307 23055 10D3 5A0F 22969 25403 59B9 633B 26671 7799 682F 1E77

146 23292 15158 5AFC 3B36 11646 7579 2D7E 1D9B 6424 17865 1918 45C9
147 1377 29094 0561 71A6 21344 14547 5360 38D3 12893 26951 325D 6947

148 28654 653 6FEE 028D 14327 20346 37F7 4F7A 18502 25073 4846 61F1
149 6350 19155 18CE 4AD3 3175 27477 0C67 6B55 7765 32381 1E55 7E7D

150 16770 23588 4182 5C24 8385 11794 20C1 2E12 25483 16581 638B 40C5

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

151 14726 10878 3986 2A7E 7363 5439 1CC3 153F 15408 32087 3C30 7D57

152 25685 31060 6455 7954 25594 15530 63FA 3CAA 6414 97 190E 0061
153 21356 30875 536C 789B 10678 29297 29B6 7271 8164 7618 1FE4 1DC2

154 12149 11496 2F75 2CE8 18026 5748 466A 1674 10347 93 286B 005D
155 28966 24545 7126 5FE1 14483 25036 3893 61CC 29369 16052 72B9 3EB4

156 22898 9586 5972 2572 11449 4793 2CB9 12B9 10389 14300 2895 37DC
157 1713 20984 06B1 51F8 21128 10492 5288 28FC 24783 11129 60CF 2B79

158 30010 30389 753A 76B5 15005 30054 3A9D 7566 18400 6602 47E0 19CA
159 2365 7298 093D 1C82 21838 3649 554E 0E41 22135 14460 5677 387C

160 27179 18934 6A2B 49F6 25797 9467 64C5 24FB 4625 25458 1211 6372
161 29740 23137 742C 5A61 14870 25356 3A16 630C 22346 15869 574A 3DFD

162 5665 24597 1621 6015 23232 32310 5AC0 7E36 2545 27047 09F1 69A7
163 23671 23301 5C77 5B05 32747 25534 7FEB 63BE 7786 26808 1E6A 68B8

164 1680 7764 0690 1E54 840 3882 0348 0F2A 20209 7354 4EF1 1CBA
165 25861 14518 6505 38B6 25426 7259 6352 1C5B 26414 27834 672E 6CBA

166 25712 21634 6470 5482 12856 10817 3238 2A41 1478 11250 05C6 2BF2
167 19245 11546 4B2D 2D1A 29766 5773 7446 168D 15122 552 3B12 0228

168 26887 26454 6907 6756 25939 13227 6553 33AB 24603 27058 601B 69B2
169 30897 15938 78B1 3E42 28040 7969 6D88 1F21 677 14808 02A5 39D8

170 11496 9050 2CE8 235A 5748 4525 1674 11AD 13705 9642 3589 25AA
171 1278 3103 04FE 0C1F 639 18483 027F 4833 13273 32253 33D9 7DFD

172 31555 758 7B43 02F6 27761 379 6C71 017B 14879 26081 3A1F 65E1
173 29171 16528 71F3 4090 26921 8264 6929 2048 6643 21184 19F3 52C0

174 20472 20375 4FF8 4F97 10236 27127 27FC 69F7 23138 11748 5A62 2DE4
175 5816 10208 16B8 27E0 2908 5104 0B5C 13F0 28838 32676 70A6 7FA4

176 30270 17698 763E 4522 15135 8849 3B1F 2291 9045 2425 2355 0979
177 22188 8405 56AC 20D5 11094 24150 2B56 5E56 10792 19455 2A28 4BFF

178 6182 28634 1826 6FDA 3091 14317 0C13 37ED 25666 19889 6442 4DB1
179 32333 1951 7E4D 079F 28406 19955 6EF6 4DF3 11546 18177 2D1A 4701

180 14046 20344 36DE 4F78 7023 10172 1B6F 27BC 15535 2492 3CAF 09BC
181 15873 26696 3E01 6848 20176 13348 4ED0 3424 16134 15086 3F06 3AEE

182 19843 3355 4D83 0D1B 30481 18609 7711 48B1 8360 30632 20A8 77A8
183 29367 11975 72B7 2EC7 26763 22879 688B 595F 14401 27549 3841 6B9D

184 13352 31942 3428 7CC6 6676 15971 1A14 3E63 26045 6911 65BD 1AFF
185 22977 9737 59C1 2609 32048 23864 7D30 5D38 24070 9937 5E06 26D1

186 31691 9638 7BCB 25A6 27701 4819 6C35 12D3 30300 2467 765C 09A3
187 10637 30643 298D 77B3 17686 30181 4516 75E5 13602 25831 3522 64E7

188 25454 13230 636E 33AE 12727 6615 31B7 19D7 32679 32236 7FA7 7DEC
189 18610 22185 48B2 56A9 9305 25960 2459 6568 16267 12987 3F8B 32BB

190 6368 2055 18E0 0807 3184 19007 0C70 4A3F 9063 11714 2367 2DC2
191 7887 8767 1ECF 223F 24247 24355 5EB7 5F23 19487 19283 4C1F 4B53

192 7730 15852 1E32 3DEC 3865 7926 0F19 1EF6 12778 11542 31EA 2D16
193 23476 16125 5BB4 3EFD 11738 20802 2DDA 5142 27309 27928 6AAD 6D18

194 889 6074 0379 17BA 20588 3037 506C 0BDD 12527 26637 30EF 680D
195 21141 31245 5295 7A0D 30874 29498 789A 733A 953 10035 03B9 2733

196 20520 15880 5028 3E08 10260 7940 2814 1F04 15958 10748 3E56 29FC
197 21669 20371 54A5 4F93 31618 27125 7B82 69F5 6068 24429 17B4 5F6D

198 15967 8666 3E5F 21DA 20223 4333 4EFF 10ED 23577 29701 5C19 7405
199 21639 816 5487 0330 31635 408 7B93 0198 32156 14997 7D9C 3A95

200 31120 22309 7990 5725 15560 26030 3CC8 65AE 32709 32235 7FC5 7DEB

. . . continued on next page
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PN Offset Programming Information – continued

08/01/2001 E-71X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

201 3698 29563 0E72 737B 1849 30593 0739 7781 23557 30766 5C05 782E

202 16322 13078 3FC2 3316 8161 6539 1FE1 198B 17638 5985 44E6 1761
203 17429 10460 4415 28DC 29658 5230 73DA 146E 3545 6823 0DD9 1AA7

204 21730 17590 54E2 44B6 10865 8795 2A71 225B 9299 20973 2453 51ED
205 17808 20277 4590 4F35 8904 27046 22C8 69A6 6323 10197 18B3 27D5

206 30068 19988 7574 4E14 15034 9994 3ABA 270A 19590 9618 4C86 2592
207 12737 6781 31C1 1A7D 18736 17154 4930 4302 7075 22705 1BA3 58B1

208 28241 32501 6E51 7EF5 26360 28998 66F8 7146 14993 5234 3A91 1472
209 20371 6024 4F93 1788 30233 3012 7619 0BC4 19916 12541 4DCC 30FD

210 13829 20520 3605 5028 19154 10260 4AD2 2814 6532 8019 1984 1F53
211 13366 31951 3436 7CCF 6683 28763 1A1B 705B 17317 22568 43A5 5828

212 25732 26063 6484 65CF 12866 31963 3242 7CDB 16562 5221 40B2 1465
213 19864 27203 4D98 6A43 9932 31517 26CC 7B1D 26923 25216 692B 6280

214 5187 6614 1443 19D6 23537 3307 5BF1 0CEB 9155 1354 23C3 054A
215 23219 10970 5AB3 2ADA 31881 5485 7C89 156D 20243 29335 4F13 7297

216 28242 5511 6E52 1587 14121 17663 3729 44FF 32391 6682 7E87 1A1A
217 6243 17119 1863 42DF 24033 28499 5DE1 6F53 20190 26128 4EDE 6610

218 445 16064 01BD 3EC0 20750 8032 510E 1F60 27564 29390 6BAC 72CE
219 21346 31614 5362 7B7E 10673 15807 29B1 3DBF 20869 8852 5185 2294

220 13256 4660 33C8 1234 6628 2330 19E4 091A 9791 6110 263F 17DE
221 18472 13881 4828 3639 9236 21792 2414 5520 714 11847 02CA 2E47

222 25945 16819 6559 41B3 25468 28389 637C 6EE5 7498 10239 1D4A 27FF
223 31051 6371 794B 18E3 28021 16973 6D75 424D 23278 6955 5AEE 1B2B

224 1093 24673 0445 6061 21490 32268 53F2 7E0C 8358 10897 20A6 2A91
225 5829 6055 16C5 17A7 23218 17903 5AB2 45EF 9468 14076 24FC 36FC

226 31546 10009 7B3A 2719 15773 23984 3D9D 5DB0 23731 12450 5CB3 30A2
227 29833 5957 7489 1745 27540 17822 6B94 459E 25133 8954 622D 22FA

228 18146 11597 46E2 2D4D 9073 22682 2371 589A 2470 19709 09A6 4CFD
229 24813 22155 60ED 568B 24998 25977 61A6 6579 17501 1252 445D 04E4

230 47 15050 002F 3ACA 20935 7525 51C7 1D65 24671 15142 605F 3B26
231 3202 16450 0C82 4042 1601 8225 0641 2021 11930 26958 2E9A 694E

232 21571 27899 5443 6CFB 31729 30785 7BF1 7841 9154 8759 23C2 2237
233 7469 2016 1D2D 07E0 24390 1008 5F46 03F0 7388 12696 1CDC 3198

234 25297 17153 62D1 4301 24760 28604 60B8 6FBC 3440 11936 0D70 2EA0
235 8175 15849 1FEF 3DE9 24103 20680 5E27 50C8 27666 25635 6C12 6423

236 28519 30581 6F67 7775 26211 30086 6663 7586 22888 17231 5968 434F
237 4991 3600 137F 0E10 22639 1800 586F 0708 13194 22298 338A 571A

238 7907 4097 1EE3 1001 24225 17980 5EA1 463C 26710 7330 6856 1CA2
239 17728 671 4540 029F 8864 20339 22A0 4F73 7266 30758 1C62 7826

240 14415 20774 384F 5126 19959 10387 4DF7 2893 15175 6933 3B47 1B15
241 30976 24471 7900 5F97 15488 25079 3C80 61F7 15891 2810 3E13 0AFA

242 26376 27341 6708 6ACD 13188 31578 3384 7B5A 26692 8820 6844 2274
243 19063 19388 4A77 4BBC 29931 9694 74EB 25DE 14757 7831 39A5 1E97

244 19160 25278 4AD8 62BE 9580 12639 256C 315F 28757 19584 7055 4C80
245 3800 9505 0ED8 2521 1900 23724 076C 5CAC 31342 2944 7A6E 0B80

246 8307 26143 2073 661F 16873 32051 41E9 7D33 19435 19854 4BEB 4D8E
247 12918 13359 3276 342F 6459 21547 193B 542B 2437 10456 0985 28D8

248 19642 2154 4CBA 086A 9821 1077 265D 0435 20573 17036 505D 428C
249 24873 13747 6129 35B3 24900 21733 6144 54E5 18781 2343 495D 0927

250 22071 27646 5637 6BFE 31435 13823 7ACB 35FF 18948 14820 4A04 39E4

. . . continued on next page
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PN Offset Programming Information – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/2001E-8

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

251 13904 1056 3650 0420 6952 528 1B28 0210 23393 1756 5B61 06DC

252 27198 1413 6A3E 0585 13599 19710 351F 4CFE 5619 19068 15F3 4A7C
253 3685 3311 0E65 0CEF 22242 18507 56E2 484B 17052 28716 429C 702C

254 16820 4951 41B4 1357 8410 18327 20DA 4797 21292 31958 532C 7CD6
255 22479 749 57CF 02ED 31287 20298 7A37 4F4A 2868 16097 0B34 3EE1

256 6850 6307 1AC2 18A3 3425 17005 0D61 426D 19538 1308 4C52 051C
257 15434 961 3C4A 03C1 7717 20444 1E25 4FDC 24294 3320 5EE6 0CF8

258 19332 2358 4B84 0936 9666 1179 25C2 049B 22895 16682 596F 412A
259 8518 28350 2146 6EBE 4259 14175 10A3 375F 27652 6388 6C04 18F4

260 14698 31198 396A 79DE 7349 15599 1CB5 3CEF 29905 12828 74D1 321C
261 21476 11467 53E4 2CCB 10738 22617 29F2 5859 21415 3518 53A7 0DBE

262 30475 8862 770B 229E 27221 4431 6A55 114F 1210 3494 04BA 0DA6
263 23984 6327 5DB0 18B7 11992 16999 2ED8 4267 22396 6458 577C 193A

264 1912 7443 0778 1D13 956 16565 03BC 40B5 26552 10717 67B8 29DD
265 26735 28574 686F 6F9E 26087 14287 65E7 37CF 24829 8463 60FD 210F

266 15705 25093 3D59 6205 20348 32574 4F7C 7F3E 8663 27337 21D7 6AC9
267 3881 6139 0F29 17FB 22084 17857 5644 45C1 991 19846 03DF 4D86

268 20434 22047 4FD2 561F 10217 25907 27E9 6533 21926 9388 55A6 24AC
269 16779 32545 418B 7F21 28949 29100 7115 71AC 23306 21201 5B0A 52D1

270 31413 7112 7AB5 1BC8 27786 3556 6C8A 0DE4 13646 31422 354E 7ABE
271 16860 28535 41DC 6F77 8430 31111 20EE 7987 148 166 0094 00A6

272 8322 10378 2082 288A 4161 5189 1041 1445 24836 28622 6104 6FCE
273 28530 15065 6F72 3AD9 14265 21328 37B9 5350 24202 6477 5E8A 194D

274 26934 5125 6936 1405 13467 17470 349B 443E 9820 10704 265C 29D0
275 18806 12528 4976 30F0 9403 6264 24BB 1878 12939 25843 328B 64F3

276 20216 23215 4EF8 5AAF 10108 25451 277C 636B 2364 25406 093C 633E
277 9245 20959 241D 51DF 17374 26323 43DE 66D3 14820 21523 39E4 5413

278 8271 3568 204F 0DF0 16887 1784 41F7 06F8 2011 8569 07DB 2179
279 18684 26453 48FC 6755 9342 32150 247E 7D96 13549 9590 34ED 2576

280 8220 29421 201C 72ED 4110 30538 100E 774A 28339 22466 6EB3 57C2
281 6837 24555 1AB5 5FEB 23690 25033 5C8A 61C9 25759 12455 649F 30A7

282 9613 10779 258D 2A1B 17174 23345 4316 5B31 11116 27506 2B6C 6B72
283 31632 25260 7B90 62AC 15816 12630 3DC8 3156 31448 21847 7AD8 5557

284 27448 16084 6B38 3ED4 13724 8042 359C 1F6A 27936 28392 6D20 6EE8
285 12417 26028 3081 65AC 18832 13014 4990 32D6 3578 1969 0DFA 07B1

286 30901 29852 78B5 749C 28042 14926 6D8A 3A4E 12371 30715 3053 77FB
287 9366 14978 2496 3A82 4683 7489 124B 1D41 12721 23674 31B1 5C7A

288 12225 12182 2FC1 2F96 17968 6091 4630 17CB 10264 22629 2818 5865
289 21458 25143 53D2 6237 10729 32551 29E9 7F27 25344 12857 6300 3239

290 6466 15838 1942 3DDE 3233 7919 0CA1 1EEF 13246 30182 33BE 75E6
291 8999 5336 2327 14D8 16451 2668 4043 0A6C 544 21880 0220 5578

292 26718 21885 685E 557D 13359 25730 342F 6482 9914 6617 26BA 19D9
293 3230 20561 0C9E 5051 1615 26132 064F 6614 4601 27707 11F9 6C3B

294 27961 30097 6D39 7591 26444 29940 674C 74F4 16234 16249 3F6A 3F79
295 28465 21877 6F31 5575 26184 25734 6648 6486 24475 24754 5F9B 60B2

296 6791 23589 1A87 5C25 23699 24622 5C93 602E 26318 31609 66CE 7B79
297 17338 26060 43BA 65CC 8669 13030 21DD 32E6 6224 22689 1850 58A1

298 11832 9964 2E38 26EC 5916 4982 171C 1376 13381 3226 3445 0C9A
299 11407 25959 2C8F 6567 18327 31887 4797 7C8F 30013 4167 753D 1047

300 15553 3294 3CC1 0CDE 20400 1647 4FB0 066F 22195 25624 56B3 6418

. . . continued on next page
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PN Offset Programming Information – continued

08/01/2001 E-91X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

301 17418 30173 440A 75DD 8709 29906 2205 74D2 30380 10924 76AC 2AAC

302 14952 15515 3A68 3C9B 7476 20593 1D34 5071 15337 23096 3BE9 5A38
303 52 5371 0034 14FB 26 17473 001A 4441 10716 22683 29DC 589B

304 27254 10242 6A76 2802 13627 5121 353B 1401 13592 10955 3518 2ACB
305 15064 28052 3AD8 6D94 7532 14026 1D6C 36CA 2412 17117 096C 42DD

306 10942 14714 2ABE 397A 5471 7357 155F 1CBD 15453 15837 3C5D 3DDD
307 377 19550 0179 4C5E 20844 9775 516C 262F 13810 22647 35F2 5877

308 14303 8866 37DF 22A2 19007 4433 4A3F 1151 12956 10700 329C 29CC
309 24427 15297 5F6B 3BC1 32357 21468 7E65 53DC 30538 30293 774A 7655

310 26629 10898 6805 2A92 26066 5449 65D2 1549 10814 5579 2A3E 15CB
311 20011 31315 4E2B 7A53 30405 29461 76C5 7315 18939 11057 49FB 2B31

312 16086 19475 3ED6 4C13 8043 26677 1F6B 6835 19767 30238 4D37 761E
313 24374 1278 5F36 04FE 12187 639 2F9B 027F 20547 14000 5043 36B0

314 9969 11431 26F1 2CA7 17064 22639 42A8 586F 29720 22860 7418 594C
315 29364 31392 72B4 7AA0 14682 15696 395A 3D50 31831 27172 7C57 6A24

316 25560 4381 63D8 111D 12780 18098 31EC 46B2 26287 307 66AF 0133
317 28281 14898 6E79 3A32 26348 7449 66EC 1D19 11310 20380 2C2E 4F9C

318 7327 23959 1C9F 5D97 24479 24823 5F9F 60F7 25724 26427 647C 673B
319 32449 16091 7EC1 3EDB 28336 20817 6EB0 5151 21423 10702 53AF 29CE

320 26334 9037 66DE 234D 13167 24474 336F 5F9A 5190 30024 1446 7548
321 14760 24162 39A8 5E62 7380 12081 1CD4 2F31 258 14018 0102 36C2

322 15128 6383 3B18 18EF 7564 16971 1D8C 424B 13978 4297 369A 10C9
323 29912 27183 74D8 6A2F 14956 31531 3A6C 7B2B 4670 13938 123E 3672

324 4244 16872 1094 41E8 2122 8436 084A 20F4 23496 25288 5BC8 62C8
325 8499 9072 2133 2370 16713 4536 4149 11B8 23986 27294 5DB2 6A9E

326 9362 12966 2492 32A6 4681 6483 1249 1953 839 31835 0347 7C5B
327 10175 28886 27BF 70D6 16911 14443 420F 386B 11296 8228 2C20 2024

328 30957 25118 78ED 621E 28070 12559 6DA6 310F 30913 12745 78C1 31C9
329 12755 20424 31D3 4FC8 18745 10212 4939 27E4 27297 6746 6AA1 1A5A

330 19350 6729 4B96 1A49 9675 17176 25CB 4318 10349 1456 286D 05B0
331 1153 20983 0481 51F7 21392 26311 5390 66C7 32504 27743 7EF8 6C5F

332 29304 12372 7278 3054 14652 6186 393C 182A 18405 27443 47E5 6B33
333 6041 13948 1799 367C 23068 6974 5A1C 1B3E 3526 31045 0DC6 7945

334 21668 27547 54A4 6B9B 10834 31729 2A52 7BF1 19161 12225 4AD9 2FC1
335 28048 8152 6D90 1FD8 14024 4076 36C8 0FEC 23831 21482 5D17 53EA

336 10096 17354 2770 43CA 5048 8677 13B8 21E5 21380 14678 5384 3956
337 23388 17835 5B5C 45AB 11694 27881 2DAE 6CE9 4282 30656 10BA 77C0

338 15542 14378 3CB6 382A 7771 7189 1E5B 1C15 32382 13721 7E7E 3599
339 24013 7453 5DCD 1D1D 32566 16562 7F36 40B2 806 21831 0326 5547

340 2684 26317 0A7C 66CD 1342 32090 053E 7D5A 6238 30208 185E 7600
341 19018 5955 4A4A 1743 9509 17821 2525 459D 10488 9995 28F8 270B

342 25501 10346 639D 286A 24606 5173 601E 1435 19507 3248 4C33 0CB0
343 4489 13200 1189 3390 22804 6600 5914 19C8 27288 12030 6A98 2EFE

344 31011 30402 7923 76C2 27969 15201 6D41 3B61 2390 5688 0956 1638
345 29448 7311 7308 1C8F 14724 16507 3984 407B 19094 2082 4A96 0822

346 25461 3082 6375 0C0A 24682 1541 606A 0605 13860 23143 3624 5A67
347 11846 21398 2E46 5396 5923 10699 1723 29CB 9225 25906 2409 6532

348 30331 31104 767B 7980 27373 15552 6AED 3CC0 2505 15902 09C9 3E1E
349 10588 24272 295C 5ED0 5294 12136 14AE 2F68 27806 21084 6C9E 525C

350 32154 27123 7D9A 69F3 16077 31429 3ECD 7AC5 2408 25723 0968 647B

. . . continued on next page
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PN Offset Programming Information – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/2001E-10

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

351 29572 5578 7384 15CA 14786 2789 39C2 0AE5 13347 13427 3423 3473

352 13173 25731 3375 6483 18538 31869 486A 7C7D 7885 31084 1ECD 796C
353 10735 10662 29EF 29A6 17703 5331 4527 14D3 6669 24023 1A0D 5DD7

354 224 11084 00E0 2B4C 112 5542 0070 15A6 8187 23931 1FFB 5D7B
355 12083 31098 2F33 797A 17993 15549 4649 3CBD 18145 15836 46E1 3DDC

356 22822 16408 5926 4018 11411 8204 2C93 200C 14109 6085 371D 17C5
357 2934 6362 0B76 18DA 1467 3181 05BB 0C6D 14231 30324 3797 7674

358 27692 2719 6C2C 0A9F 13846 19315 3616 4B73 27606 27561 6BD6 6BA9
359 10205 14732 27DD 398C 16958 7366 423E 1CC6 783 13821 030F 35FD

360 7011 22744 1B63 58D8 23649 11372 5C61 2C6C 6301 269 189D 010D
361 22098 1476 5652 05C4 11049 738 2B29 02E2 5067 28663 13CB 6FF7

362 2640 8445 0A50 20FD 1320 24130 0528 5E42 15383 29619 3C17 73B3
363 4408 21118 1138 527E 2204 10559 089C 293F 1392 2043 0570 07FB

364 102 22198 0066 56B6 51 11099 0033 2B5B 7641 6962 1DD9 1B32
365 27632 22030 6BF0 560E 13816 11015 35F8 2B07 25700 29119 6464 71BF

366 19646 10363 4CBE 287B 9823 23041 265F 5A01 25259 22947 62AB 59A3
367 26967 25802 6957 64CA 25979 12901 657B 3265 19813 9612 4D65 258C

368 32008 2496 7D08 09C0 16004 1248 3E84 04E0 20933 18698 51C5 490A
369 7873 31288 1EC1 7A38 24240 15644 5EB0 3D1C 638 16782 027E 418E

370 655 24248 028F 5EB8 20631 12124 5097 2F5C 16318 29735 3FBE 7427
371 25274 14327 62BA 37F7 12637 21959 315D 55C7 6878 2136 1ADE 0858

372 16210 23154 3F52 5A72 8105 11577 1FA9 2D39 1328 8086 0530 1F96
373 11631 13394 2D6F 3452 18279 6697 4767 1A29 14744 10553 3998 2939

374 8535 1806 2157 070E 16763 903 417B 0387 22800 11900 5910 2E7C
375 19293 17179 4B5D 431B 29822 28593 747E 6FB1 25919 19996 653F 4E1C

376 12110 10856 2F4E 2A68 6055 5428 17A7 1534 4795 5641 12BB 1609
377 21538 25755 5422 649B 10769 31857 2A11 7C71 18683 28328 48FB 6EA8

378 10579 15674 2953 3D3A 17785 7837 4579 1E9D 32658 25617 7F92 6411
379 13032 7083 32E8 1BAB 6516 17385 1974 43E9 1586 26986 0632 696A

380 14717 29096 397D 71A8 19822 14548 4D6E 38D4 27208 5597 6A48 15DD
381 11666 3038 2D92 0BDE 5833 1519 16C9 05EF 17517 14078 446D 36FE

382 25809 16277 64D1 3F95 25528 20982 63B8 51F6 599 13247 0257 33BF
383 5008 25525 1390 63B5 2504 32742 09C8 7FE6 16253 499 3F7D 01F3

384 32418 20465 7EA2 4FF1 16209 27076 3F51 69C4 8685 30469 21ED 7705
385 22175 28855 569F 70B7 31391 30311 7A9F 7667 29972 17544 7514 4488

386 11742 32732 2DDE 7FDC 5871 16366 16EF 3FEE 22128 28510 5670 6F5E
387 22546 20373 5812 4F95 11273 27126 2C09 69F6 19871 23196 4D9F 5A9C

388 21413 9469 53A5 24FD 30722 23618 7802 5C42 19405 13384 4BCD 3448
389 133 26155 0085 662B 20882 32041 5192 7D29 17972 4239 4634 108F

390 4915 6957 1333 1B2D 22601 17322 5849 43AA 8599 20725 2197 50F5
391 8736 12214 2220 2FB6 4368 6107 1110 17DB 10142 6466 279E 1942

392 1397 21479 0575 53E7 21354 26575 536A 67CF 26834 28465 68D2 6F31
393 18024 31914 4668 7CAA 9012 15957 2334 3E55 23710 19981 5C9E 4E0D

394 15532 32311 3CAC 7E37 7766 28967 1E56 7127 27280 16723 6A90 4153
395 26870 11276 68F6 2C0C 13435 5638 347B 1606 6570 4522 19AA 11AA

396 5904 20626 1710 5092 2952 10313 0B88 2849 7400 678 1CE8 02A6
397 24341 423 5F15 01A7 32346 20207 7E5A 4EEF 26374 15320 6706 3BD8

398 13041 2679 32F1 0A77 18600 19207 48A8 4B07 22218 29116 56CA 71BC
399 23478 15537 5BB6 3CB1 11739 20580 2DDB 5064 29654 5388 73D6 150C

400 1862 10818 0746 2A42 931 5409 03A3 1521 13043 22845 32F3 593D

. . . continued on next page
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PN Offset Programming Information – continued

08/01/2001 E-111X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY

Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

401 5850 23074 16DA 5A22 2925 11537 0B6D 2D11 24457 28430 5F89 6F0E

402 5552 20250 15B0 4F1A 2776 10125 0AD8 278D 17161 8660 4309 21D4
403 12589 14629 312D 3925 18758 21166 4946 52AE 21314 2659 5342 0A63

404 23008 29175 59E0 71F7 11504 30407 2CF0 76C7 28728 8803 7038 2263
405 27636 13943 6BF4 3677 13818 21767 35FA 5507 22162 19690 5692 4CEA

406 17600 11072 44C0 2B40 8800 5536 2260 15A0 26259 22169 6693 5699
407 17000 29492 4268 7334 8500 14746 2134 399A 22180 8511 56A4 213F

408 21913 5719 5599 1657 31516 17687 7B1C 4517 2266 17393 08DA 43F1
409 30320 7347 7670 1CB3 15160 16485 3B38 4065 10291 11336 2833 2C48

410 28240 12156 6E50 2F7C 14120 6078 3728 17BE 26620 13576 67FC 3508
411 7260 25623 1C5C 6417 3630 31799 0E2E 7C37 19650 22820 4CC2 5924

412 17906 27725 45F2 6C4D 8953 30746 22F9 781A 14236 13344 379C 3420
413 5882 28870 16FA 70C6 2941 14435 0B7D 3863 11482 20107 2CDA 4E8B

414 22080 31478 5640 7AF6 11040 15739 2B20 3D7B 25289 8013 62C9 1F4D
415 12183 28530 2F97 6F72 17947 14265 461B 37B9 12011 18835 2EEB 4993

416 23082 24834 5A2A 6102 11541 12417 2D15 3081 13892 16793 3644 4199
417 17435 9075 441B 2373 29661 24453 73DD 5F85 17336 9818 43B8 265A

418 18527 32265 485F 7E09 30207 28984 75FF 7138 10759 4673 2A07 1241
419 31902 3175 7C9E 0C67 15951 18447 3E4F 480F 26816 13609 68C0 3529

420 18783 17434 495F 441A 30079 8717 757F 220D 31065 10054 7959 2746
421 20027 12178 4E3B 2F92 30413 6089 76CD 17C9 8578 10988 2182 2AEC

422 7982 25613 1F2E 640D 3991 31802 0F97 7C3A 24023 14744 5DD7 3998
423 20587 31692 506B 7BCC 31205 15846 79E5 3DE6 16199 17930 3F47 460A

424 10004 25384 2714 6328 5002 12692 138A 3194 22310 25452 5726 636C
425 13459 18908 3493 49DC 19353 9454 4B99 24EE 30402 11334 76C2 2C46

426 13383 25816 3447 64D8 19443 12908 4BF3 326C 16613 15451 40E5 3C5B
427 28930 4661 7102 1235 14465 18214 3881 4726 13084 11362 331C 2C62

428 4860 31115 12FC 798B 2430 29433 097E 72F9 3437 2993 0D6D 0BB1
429 13108 7691 3334 1E0B 6554 16697 199A 4139 1703 11012 06A7 2B04

430 24161 1311 5E61 051F 32480 19635 7EE0 4CB3 22659 5806 5883 16AE
431 20067 16471 4E63 4057 30433 28183 76E1 6E17 26896 20180 6910 4ED4

432 2667 15771 0A6B 3D9B 21733 20721 54E5 50F1 1735 8932 06C7 22E4
433 13372 16112 343C 3EF0 6686 8056 1A1E 1F78 16178 23878 3F32 5D46

434 28743 21062 7047 5246 27123 10531 69F3 2923 19166 20760 4ADE 5118
435 24489 29690 5FA9 73FA 32260 14845 7E04 39FD 665 32764 0299 7FFC

436 249 10141 00F9 279D 20908 24050 51AC 5DF2 20227 32325 4F03 7E45
437 19960 19014 4DF8 4A46 9980 9507 26FC 2523 24447 25993 5F7F 6589

438 29682 22141 73F2 567D 14841 25858 39F9 6502 16771 3268 4183 0CC4
439 31101 11852 797D 2E4C 28014 5926 6D6E 1726 27209 25180 6A49 625C

440 27148 26404 6A0C 6724 13574 13202 3506 3392 6050 12149 17A2 2F75
441 26706 30663 6852 77C7 13353 30175 3429 75DF 29088 10193 71A0 27D1

442 5148 32524 141C 7F0C 2574 16262 0A0E 3F86 7601 9128 1DB1 23A8
443 4216 28644 1078 6FE4 2108 14322 083C 37F2 4905 7843 1329 1EA3

444 5762 10228 1682 27F4 2881 5114 0B41 13FA 5915 25474 171B 6382
445 245 23536 00F5 5BF0 20906 11768 51AA 2DF8 6169 11356 1819 2C5C

446 21882 18045 557A 467D 10941 27906 2ABD 6D02 21303 11226 5337 2BDA
447 3763 25441 0EB3 6361 22153 32652 5689 7F8C 28096 16268 6DC0 3F8C

448 206 27066 00CE 69BA 103 13533 0067 34DD 8905 14491 22C9 389B
449 28798 13740 707E 35AC 14399 6870 383F 1AD6 26997 8366 6975 20AE

450 32402 13815 7E92 35F7 16201 21703 3F49 54C7 15047 26009 3AC7 6599

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

451 13463 3684 3497 0E64 19355 1842 4B9B 0732 17460 5164 4434 142C

452 15417 23715 3C39 5CA3 20428 24685 4FCC 606D 17629 17126 44DD 42E6
453 23101 15314 5A3D 3BD2 31950 7657 7CCE 1DE9 10461 21566 28DD 543E

454 14957 32469 3A6D 7ED5 19686 29014 4CE6 7156 21618 21845 5472 5555
455 23429 9816 5B85 2658 31762 4908 7C12 132C 11498 28149 2CEA 6DF5

456 12990 4444 32BE 115C 6495 2222 195F 08AE 193 9400 00C1 24B8
457 12421 5664 3085 1620 18834 2832 4992 0B10 16140 19459 3F0C 4C03

458 28875 7358 70CB 1CBE 27061 3679 69B5 0E5F 13419 7190 346B 1C16
459 4009 27264 0FA9 6A80 22020 13632 5604 3540 10864 3101 2A70 0C1D

460 1872 28128 0750 6DE0 936 14064 03A8 36F0 28935 491 7107 01EB
461 15203 30168 3B63 75D8 19553 15084 4C61 3AEC 18765 25497 494D 6399

462 30109 29971 759D 7513 27422 29877 6B1E 74B5 27644 29807 6BFC 746F
463 24001 3409 5DC1 0D51 32560 18580 7F30 4894 21564 26508 543C 678C

464 4862 16910 12FE 420E 2431 8455 097F 2107 5142 4442 1416 115A
465 14091 20739 370B 5103 19029 26301 4A55 66BD 1211 4871 04BB 1307

466 6702 10191 1A2E 27CF 3351 24027 0D17 5DDB 1203 31141 04B3 79A5
467 3067 12819 0BFB 3213 21549 22325 542D 5735 5199 9864 144F 2688

468 28643 19295 6FE3 4B5F 26145 27539 6621 6B93 16945 12589 4231 312D
469 21379 10072 5383 2758 30737 5036 7811 13AC 4883 5417 1313 1529

470 20276 15191 4F34 3B57 10138 21399 279A 5397 25040 8549 61D0 2165
471 25337 27748 62F9 6C64 24748 13874 60AC 3632 7119 14288 1BCF 37D0

472 19683 720 4CE3 02D0 30625 360 77A1 0168 17826 8503 45A2 2137
473 10147 29799 27A3 7467 16897 29711 4201 740F 4931 20357 1343 4F85

474 16791 27640 4197 6BF8 28955 13820 711B 35FC 25705 15381 6469 3C15
475 17359 263 43CF 0107 28727 20159 7037 4EBF 10726 18065 29E6 4691

476 13248 24734 33C0 609E 6624 12367 19E0 304F 17363 24678 43D3 6066
477 22740 16615 58D4 40E7 11370 28239 2C6A 6E4F 2746 23858 0ABA 5D32

478 13095 20378 3327 4F9A 18499 10189 4843 27CD 10952 7610 2AC8 1DBA
479 10345 25116 2869 621C 17892 12558 45E4 310E 19313 18097 4B71 46B1

480 30342 19669 7686 4CD5 15171 26710 3B43 6856 29756 20918 743C 51B6
481 27866 14656 6CDA 3940 13933 7328 366D 1CA0 14297 7238 37D9 1C46

482 9559 27151 2557 6A0F 17275 31547 437B 7B3B 21290 30549 532A 7755
483 8808 28728 2268 7038 4404 14364 1134 381C 1909 16320 0775 3FC0

484 12744 25092 31C8 6204 6372 12546 18E4 3102 8994 20853 2322 5175
485 11618 22601 2D62 5849 5809 25112 16B1 6218 13295 26736 33EF 6870

486 27162 2471 6A1A 09A7 13581 19183 350D 4AEF 21590 10327 5456 2857
487 17899 25309 45EB 62DD 29477 32594 7325 7F52 26468 24404 6764 5F54

488 29745 15358 7431 3BFE 27592 7679 6BC8 1DFF 13636 7931 3544 1EFB
489 31892 17739 7C94 454B 15946 27801 3E4A 6C99 5207 5310 1457 14BE

490 23964 12643 5D9C 3163 11982 22157 2ECE 568D 29493 554 7335 022A
491 23562 32730 5C0A 7FDA 11781 16365 2E05 3FED 18992 27311 4A30 6AAF

492 2964 19122 0B94 4AB2 1482 9561 05CA 2559 12567 6865 3117 1AD1
493 18208 16870 4720 41E6 9104 8435 2390 20F3 12075 7762 2F2B 1E52

494 15028 10787 3AB4 2A23 7514 23341 1D5A 5B2D 26658 15761 6822 3D91
495 21901 18400 558D 47E0 31510 9200 7B16 23F0 21077 12697 5255 3199

496 24566 20295 5FF6 4F47 12283 27039 2FFB 699F 15595 24850 3CEB 6112
497 18994 1937 4A32 0791 9497 19956 2519 4DF4 4921 15259 1339 3B9B

498 13608 17963 3528 462B 6804 27945 1A94 6D29 14051 24243 36E3 5EB3
499 27492 7438 6B64 1D0E 13746 3719 35B2 0E87 5956 30508 1744 772C

500 11706 12938 2DBA 328A 5853 6469 16DD 1945 21202 13982 52D2 369E

. . . continued on next page
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Table E-1: PnMaskI and PnMaskQ Values for PilotPn

14–Chip Delay 13–Chip Delay 0–Chip Delay
 Pilot I Q I Q I Q I Q I Q I Q
  PN (Dec.) (Hex.) (Dec.) (Hex.) (Dec.)   (Hex.)

501 14301 19272 37DD 4B48 19006 9636 4A3E 25A4 11239 25039 2BE7 61CF

502 23380 29989 5B54 7525 11690 29870 2DAA 74AE 30038 24086 7556 5E16
503 11338 8526 2C4A 214E 5669 4263 1625 10A7 30222 21581 760E 544D

504 2995 18139 0BB3 46DB 21513 27985 5409 6D51 13476 21346 34A4 5362
505 23390 3247 5B5E 0CAF 11695 18539 2DAF 486B 2497 28187 09C1 6E1B

506 14473 28919 3889 70F7 19860 30279 4D94 7647 31842 23231 7C62 5ABF
507 6530 7292 1982 1C7C 3265 3646 0CC1 0E3E 24342 18743 5F16 4937

508 20452 20740 4FE4 5104 10226 10370 27F2 2882 25857 11594 6501 2D4A
509 12226 27994 2FC2 6D5A 6113 13997 17E1 36AD 27662 7198 6C0E 1C1E

510 1058 2224 0422 08B0 529 1112 0211 0458 24594 105 6012 0069
511 12026 6827 2EFA 1AAB 6013 17257 177D 4369 16790 4534 4196 11B6
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Purpose

This appendix provides information on setting up the HP8921 with PCS
interface, the HP8935, the Advantest R3465, and the HP437 and
Gigatronics 8542 power meters. The Cybertest test set doesn’t require
any setup.

HP8921A Test Equipment
Connections

The following diagram depicts the rear panels of the HP 8921A test
equipment as configured to perform automatic tests. All test equipment
is  controlled by the LMF via an IEEE–488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-4). If there is  a communications problem between the LMF and
any piece of test equipment, you should verify that the GPIB addresses
have been set correctly and that the GPIB cables are firmly connected to
the test equipment.

Figure F-1 shows the connections when not using an external 10 MHz
Rubidium reference.

Table F-1: HP8921A/600 Communications Test Set Rear Panel Connections Without Rubidium Reference

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC–female – SMC–female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC–female – SMC–female

IQ RF IN IQ RF OUT SMC–female – SMC–female

DET OUT AUX DSP IN SMC–female – SMC–female

CONTROL I/O CONTROL I/O 45–pin custom BUS

10 MHZ OUT SYNTH REF IN BNC–male – BNC–male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ OUT REF IN BNC–male – BNC–male
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REAR PANEL
COMMUNICATIONS TEST SET
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Figure F-1: HP8921A/600 Cables Connection for 10 MHz Signal and GPIB without Rubidium Reference
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Figure F-2  shows the connections when using an external 10 MHz
Rubidium reference.

Table F-2: HP8921A/600 Communications Test Set Rear Panel Connections With Rubidium Reference

From Test Set: To Interface:

8921A 83203B CDMA 83236A PCS
Connector Type

CW RF OUT CW RF IN SMC–female – SMC–female

114.3 MHZ IF OUT 114.3 MHZ IF IN SMC–female – SMC–female

IQ RF IN IQ RF OUT SMC–female – SMC–female

DET OUT AUX DSP IN SMC–female – SMC–female

CONTROL I/O CONTROL I/O 45–pin custom BUS

10 MHZ OUT REF IN BNC–male – BNC–male

HPIB INTERFACE HPIB INTERFACE HPIB cable

10 MHZ INPUT 10 MHZ OUT BNC–male – BNC–male
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Figure F-2: HP8921A Cables Connection for 10 MHz Signal and GPIB with Rubidium Reference
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HP8921A System Connectivity
Test

Follow the steps outlined in Table F-3 to verify that the connections
between the PCS Interface and the HP8921A are correct and cables are
intact.  The software also performs basic functionality checks of each
instrument.

Disconnect other GPIB devices, especially system
controllers, from the system before running the
connectivity software.

IMPORTANT

*

Table F-3: System Connectivity

Step Action

* IMPORTANT
– Perform this procedure after test equipment has been allowed to warm–up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select it by pressing the cursor control knob. In
the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select it by pressing the cursor control knob. In
the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.  The software will prompt you through the
connectivity setup.

7 Do the following when the test is complete,

� position cursor on STOP TEST and select it

� OR press the [K5] pushbutton.

8 To return to the main menu, press the [K5] pushbutton.

9 Press the [PRESET] pushbutton.
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Setting HP8921A and
HP83236A/B GPIB Address

Table F-4: Setting HP8921A GPIB Address

Step Action

1 If you have not already done so, turn the HP8921A power on.

2 Verify that the GPIB addresses are set correctly.

� HP8921A HP–IB Adrs = 18, accessed by pushing LOCAL and selecting More and I/O Configure
on the HP8921A/600. (Consult test equipment OEM documentation for additional info as required).

� HP83236A (or B) PCS Interface GPIB address=19. Set dip switches as follows:

– A1=1, A2=1, A3=0, A4=0, A5=1, HP–IB/Ser = 1

Pretest Setup for HP8921A

Before the HP8921A CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-5: Pretest Setup for HP8921A

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the CURSOR CONTROL knob.

3 Position the cursor at IO CONFIG (under To Screen and More) and select it.

4 Select Mode and set for Talk&Lstn.

Pretest Setup for HP8935

Before the HP8935 CDMA analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-6: Pretest Setup for HP8935

Step Action

1 Unplug the memory card if it is plugged in.

2 Press the Shift button and then press the I/O Config button.

3 Press the Push to Select knob.

4 Position the cursor at IO CONFIG and select it.

5 Select Mode and set for Talk&Lstn.
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Advantest R3465 Connection

The following diagram depicts the rear panels of the Advantest test
equipment as configured to perform automatic tests. All test equipment
is  controlled by the LMF via an IEEE–488/GPIB bus. The LMF expects
each piece of test equipment to have a factory-set GPIB address (refer to
Table F-7). If there is  a communications problem between the LMF and
any piece of test equipment, you should verify that the GPIB addresses
have been set correctly and that the GPIB cables are firmly connected to
the test equipment.

Figure F-3 shows the connections when not using an external 10 MHz
Rubidium reference.

Figure F-3: Cable Connections for Test Set without 10 MHz Rubidium Reference
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Figure F-4 shows the connections when using an external 10 MHz
Rubidium reference.
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Figure F-4: Cable Connections for Test Set with 10 MHz Rubidium Reference
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R3465 GPIB Address & Clock
setup

Table F-7 describes the steps to set the GPIB address and clock for the
Advantest R3465 equipment.

Table F-7: Advantest R3465 GPIB Address and Clock Setup

Step Action

1 Communications test set GPIB address=18 (perform the following to view/set as required)

Perform the following to set the standard parameters on the test set:

� Push the SHIFT then PRESET pushbutton (just below the CRT display).

� Push the LCL pushbutton (CW in Measurement just below the CRT display)
– Push the GPIB and Others CRT menu key to view the current address.

– If required, change GPIB address to 18 (rotate the vernier knob to set, push the vernier knob to
enter)

2 Verify the current Date and Time in upper/right of the CRT display (perform the following to set if
required)

Communications test set GPIB address=18 (perform the following to view/set as required)

� Push the Date/Time CRT menu key

� If required, change to correct Date/Time (rotate the vernier knob to select and set, push the vernier
knob to enter)

�  Push the SHIFT then PRESET pushbutton (just below the CRT display).

 

Pretest Setup for Advantest
R3465

Before the Advantest R3465 analyzer is used for LMF controlled testing
it must be set up correctly for automatic testing.

Table F-8: Pretest Setup for Advantest R346

Step Action

1 Press the SHIFT button so the LED next to it is illuminated.

2 Press the RESET button.
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Calibrating HP437 Power Meter

Precise transmit output power calibration measurements are made using
a bolometer–type broadband power meter with a sensitive power sensor.
Follow the steps outlined in Table F-9 to enter information unique to the
power sensor before calibrating the test setup. Refer to Figure F-5 as
required.

This procedure must be done in conjunction with the
automated calibration to enter power sensor specific
calibration values.

IMPORTANT

*

CONNECT POWER
SENSOR WITH POWER
METER TURNED OFF

CONNECT POWER SENSOR
TO POWER REFERENCE
WHEN CALIBRATING UNIT.
POWER REFERENCE IS
ENABLED USING THE SHIFT 	
KEYS

SHIFT (BLUE) PUSHBUTTON –
ACCESSES FUNCTION AND

DATA ENTRY KEYS IDENTIFIED
WITH LIGHT BLUE TEXT ON
THE FRONT PANEL ABOVE

THE BUTTONS

FW00308

Figure F-5: Power Meter Detail

Table F-9: Power Meter Calibration Procedure

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with ac power applied to the meter.
Disconnection could result in destruction of the sensing element or mis–calibration.

1 – Make sure the power meter AC LINE pushbutton is OFF.

– Connect the power sensor cable to the SENSOR input.

2 Set the AC LINE pushbutton to ON.

NOTE
The calibration should be performed only after the power meter and sensor have been allowed to
warm–up and stabilize for a minimum of 60 minutes.

3 Perform the following to set or verify the GPIB address:

– To enter the SPECIAL data entry function, press [SHIFT] then [PRESET].

– Use the [�] or [
] button to select HP–IB ADRS; then press [ENTER].

– Use the [�] or [
] button to select HP–IB ADRS 13; then press [ENTER].

– To EXIT the SPECIAL data entry function press [SHIFT] then [ENTER].

. . . continued on next page
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Table F-9: Power Meter Calibration Procedure

Step Action

4 Perform the following to set or verify the correct power sensor model:

– Press [SHIFT]  then [�] to select SENSOR.

– Identify the power sensor model number from the sensor label.  Use the [�] or [
] button to
select the appropriate model; then press [ENTER].

NOTE
Be sure the PWR REF (power reference) output is OFF (observe that the triangular indicator is NOT
displayed as shown in Step 7). If on, press [SHIFT] then [	] to turn it off.

5 Press [ZERO].  Display will show “Zeroing ******.”  Wait for process to complete.

6 Connect the power sensor to the POWER REF output.

7 To turn on the PWR REF, perform the following:

– Press [SHIFT] then [	].

– Verify that the triangular indicator (below) appears in the display above “PWR REF”.

8 Perform the following to set the REF CF %:

– Press ([SHIFT] then [ZERO]) for CAL.

– Enter the sensor’s REF CF % from the sensor’s decal using the arrow keys and press [ENTER].
(The power meter will display ”CAL *****” for a few seconds.)

NOTE
If the REF CAL FACTOR (REF CF) is not shown on the power sensor, assume it to be 100%.

9 Perform the following to set the CAL FAC %:

– Press [SHIFT] then [FREQ] for CAL FAC.

– ������������	
�����
������
���
��
��	����
����
���	
�������	����
����
���	�������
����������Enter
the sensor’s calibration % (CF%) using the arrow keys and press [ENTER].

When complete, the power meter will typically display 0.05 dBm. (Any reading between 0.00 and
0.10 is normal.)

10 To turn off the PWR REF, perform the following:

– Press [SHIFT] then [	].

– Disconnect the power sensor from the POWER REF output.
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Calibrating Gigatronics 8542
power meter

Precise transmit output power calibration measurements are made using
a bolometer–type broadband power meter with a sensitive power sensor.
Follow the steps in Table F-10 to enter information unique to the power
sensor.

Table F-10: Calibrate Gigatronics 8542 Power Meter

Step Action

! CAUTION
Do not connect/disconnect the power meter sensor cable with AC power applied to the meter.
Disconnection could result in destruction of the sensing element or miscalibration.

NOTE
Allow the power meter and sensor to warm up and stabilize for a minimum of 60 minutes before
performing the calibration procedure.

1 � Make sure the power meter POWER pushbutton is OFF.

� Connect the power sensor cable to the SENSOR input.

� Set the POWER pushbutton to ON.

2 Verify the Power GPIB mode and address:

� Press MENU. Use the 
 arrow key to select CONFIG MENU, and press ENTER.

� Use the 
 arrow key to select GPIB, and press ENTER.

� Use the 
� arrow keys as required to set MODE to 8541C or 8542C (as appropriate).

� Press 	 and use the 
� arrow keys as required to set ADDRESS to 13.

� Press ENTER.

3 � Connect the power sensor to the CALIBRATOR output connector.

� Press ZERO.

� Wait for the process to complete. Sensor factory calibration data is read to power meter during this
process.

� Disconnect the power sensor from the CALIBRATOR output.
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Figure F-6: Gigatronics 8542C Power Meter Detail
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Calibrating Test Cable Setup
using HP PCS Interface (HP83236)

Table F-11 covers the procedure to calibrate the test equipment using 
the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

This calibration method must be executed with great care.
Some losses are measured close to the minimum limit of
the power meter sensor (–30 dBm).

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Table F-11: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP83236 Manual Control System card into memory card slot.

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP83236A:
Set channel number=<chan#>:

– Position cursor at Channel
Number and select it.

– Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

– When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP83236B:
Set channel frequency:

– Position cursor at Frequency Band and press Enter.

– Select User Defined Frequency.

– Go Back to Previous Menu.

– Position the cursor to 83236 generator frequency and
enter actual RX frequency.

– Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

. . . continued on next page
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Table F-11: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

8 Set RF Generator level:

– Position the cursor at RF Generator Level and select it.

– Enter –10 using the numeric keypad; press [Enter] and the screen will go blank.

– When the screen reappears, the value –10 dBm will be displayed on the RF Generator Level line.

9 Set the user fixed Attenuation Setting to 0 dBm:

– Position cursor at Analyzer Attenuation and select it
– Position cursor at User Fixed Atten Settings and select it.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

– Position cursor at Show Frequency and Level Details and select it.
– Under HP83236 Frequencies and Levels, record the Generator Level.
– Under HP83236B Frequencies and Levels, record the Generator Frequency Level (1850 – 1910

MHz).

– Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor. Record the
calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = –1.4 dB
(B) 20 dB Attenuator = –20.1 dB
(B) Directional Coupler = –29.8 dB

. . . continued on next page
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Table F-11: Calibrating Test Cable Setup (using the HP PCS Interface)

Step Action

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = –1.4 –29.8 –20.1 = –51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to –119 dBm.

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP–IB) address:

– under To Screen, select More

– select IO CONFIG

– Set HP–IB Adrs to 18

– set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

– Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

– Use the cursor control to set RF Display to Freq

25 Refer toChapter 3 for assistance in setting the cable loss values into the LMF.
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Calibrating Test Cable Setup
using Advantest R3465

Be sure the GPIB Interface is OFF for this procedure.

NOTE

Advantest R3465 Manual Test setup and calibration must be performed
at both the TX and RX frequencies.

Table F-12: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

* IMPORTANT
– This procedure can only be performed after test equipment has been allowed to warm–up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key

4 Select the Setup CRT menu key

5 Using the vernier knob and the cursor keys set the following parameters

NOTE
Fields not listed remain at default

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key

7 Press FREQ key in the ENTRY area

8 Set the frequency to the desired value using the keypad entry keys

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

15 Record the power meter reading  ________________________

. . . continued on next page
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Table F-12: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm.  Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re–zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one–at–a–time between the “RF OUT” port and the power sensor (see Figure F-8, “Setups
A, B, and C”).  Record the calibrated loss value displayed on the power meter for each connection.

Example: (A) 1st Test Cable =  –0.5 dB
(B) 2nd Test Cable =  –1.4 dB
(C) 20 dB Attenuator =  –20.1 dB
(D) 30 dB Directional Coupler =  –29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area

21 Using the keypad entry keys, set the test frequency to the RX frequency

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Chapter 3 for assistance in setting the cable loss values into the LMF.
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Exception Procedure –
Downloading Device ROM
Code

This procedure is not part of a normal optimization.

Perform this procedure only on an exception basis when no alternative
exists to load a BTS device with the correct version of ROM code.

An MGLI or GLI must be INS (green) before ROM code
can be downloaded to non–GLI devices.

NOTE

Release 2.9.x RAM code must NOT be downloaded to a
device loaded with Release 2.8.x ROM code, and Release
2.8.x RAM code must NOT be downloaded to a device
loaded with Release 2.9.x ROM code.

All devices in a BTS must have the same Release–level
ROM and RAM code before the optimization and ATP
procedures can be performed.

If a newly–installed Release 8–equipped BTS is to be
upgraded to Release 2.9.x, the optimization and
Acceptance Test Procedures (ATP) should be accomplished
with the Release 2.8.x code and software. Following the
optimization, the site code and software should be
upgraded to Release 2.9.x by the CBSC. It is not necessary
to perform the optimization and ATPs again after the
upgrade.

If a replacement device with Release 2.8.x ROM code
must be used in a Release 2.9.x–equipped BTS, the device
ROM code can be changed using the CDMA LMF before
the performing the BTS optimization and ATPs. A device
loaded with Release 2.9.x ROM code can not be converted
back to Release 2.8.x ROM code in the field without
Motorola assistance.

CAUTION

If it is necessary to download ROM code to a device from the CDMA
LMF, the procedure in Table G-1 includes steps for both ROM and RAM
code download using the CDMA LMF.

Prerequisites

Prior to performing this procedure, ensure the correct ROM and RAM
code files exist on the CDMA LMF for each of the devices to be loaded.

F



Downloading ROM Code with the LMF – continued

PRELIMINARY
1X SC�4812ET Lite BTS Optimization/ATP 08/01/2001G-2

The Release level of the ROM code to be downloaded
must be the same as the Release level of the ROM code
resident in the other devices in the BTS. Release 2.9.x
ROM code must not be downloaded to a frame having
Release 2.8.x code, and Release 2.8.x code must not be
downloaded to a frame having Release 2.9.x code.

This procedure should only be used to upgrade
replacement devices for a BTS. It should NOT be used to
upgrade all devices in a BTS. If a BTS is to be upgraded
from Release 2.8.x to Release 2.9.x, optimization and ATP
must first be performed with the BTS in a Release 2.8.x
configuration. Following this, the upgrade from Release
2.8.x to Release 2.9.x should be done by the CBSC.

CAUTION

Table G-1: Download ROM and RAM Code to Devices

Step Action

1 Click on the device to be loaded.

2 From the Device pull down menu, select Status.

A status report window will appear

3 Make a note of the number in the HW Bin Type column.

NOTE
“HW Bin Type” is the Hardware Binary Type for the device. This number is used as the last four digits
in the filename of a device’s binary ROM code file. Using this part of the filename, the ROM code file
can be matched to the device in which it is to be loaded.

4 Click OK to close the status window.

5 Click on the device to be loaded.

* IMPORTANT
The CDMA LMF will not automatically select ROM code files for download. ROM code files must
be selected manually.

6 From the Device pull down menu, select Download Code Manual.

A file selection window will appear.

7 Double–click on the version folder with the desired version number for the ROM code file.

8 Double–click the Code folder.

A list of ROM and RAM code files will be displayed.
. . . continued on next page
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Table G-1: Download ROM and RAM Code to Devices

Step Action

! CAUTION
A ROM code file with the correct hardware binary type (HW Bin Type) must be chosen. Using a file
with the wrong HW Bin Type can result in unpredictable operation and damage to the device.

9 Click on the ROM code file with the filename which matches the device type and HW Bin Type
number noted in step 3 (e.g., file bbx_rom.bin.0604 is the ROM code file for a BBX with a HW Bin
Type of 0604).

The file should be highlighted.

10 Click on the Load button.

A status report window is displayed showing the result of the download.

11 Click OK to close the status window.

12 From the Util pull down menu, select Tools, then Update NextLoad.

13 Select the version number of the folder that was used for the ROM code download and click Save.

A pop–up message will appear showing the CDF file has been updated.

14 Click on the OK button to dismiss the pop–up message.

15 Click on the device that was loaded with ROM code.

NOTE
RAM code is automatically selected for download.

16 From the Device pull down menu, select Download Code to download RAM code.

A status report is displayed showing the result of the download.

17 Click OK to close the status window.

18 Observe the downloaded device to ensure it is OOS–RAM (yellow) for non–GLI devices or INS
(green) for GLIs.

19 Click on the device which was loaded with code.

20 From the Device pull down menu, select Status.

Verify that the correct ROM and RAM version numbers are displayed in the status report window.

21 Click OK to close the status window.

NOTE
Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the data
download portion of the Download RAM Code and Data to Non–GLI Devices procedure, Table 3-15,
to download data to other device types after their ROM code has been upgraded and RAM code
downloaded.
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Purpose

This procedure is a guide to performing calibration of new BTS
expansion carriers while the system remains in service. This procedure
also supports BTS recalibration following replacement of RF chain
components while the remainder of the site stays in service.

Motorola recommends performing this procedure during a maintenance
window.

This procedure cannot be performed on BTSs with 2–to–1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1A, 1B, 1C, and 1D can be calibrated while LPAs
3A, 3B, 3C, and 3D remain in service and vice versa.

Equipment Warm up

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test equipment set. Calibrate the test
equipment after it has been allowed to warm-up and
stabilize for a minimum of 60 minutes.

IMPORTANT

*

If any component of the test equipment set (for example, a
test cable, RF adapter, signal generator) has been replaced,
the test equipment set must be recalibrated. Failure to do so
could introduce measurement errors which ultimately result
in degradation of system performance.

CAUTION

1X Test Equipment
Requirements

Calibration of 1X carrier functions requires using either of the following
test equipment combinations:

� An Advantest R3267 spectrum analyzer with an Advantest R3562
signal generator

� An Agilent E4406A Transmitter Test Set with an Agilent E4432A
signal generator

� An Agilent 8935 series E6380A equipped with option 200 (if
purchased new) or option R2K (if retrofitted) and an Agilent E4432B
signal generator

These test equipment combinations are capable of calibrating the BTS
for both IS–95 A and B mode operation as well as IS–2000 CDMA 1X
operation.
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IS–95A/B communication test sets such as the
HP8921A/600 and Advantest R3561L can not calibrate 1X
carrier functions.

IMPORTANT

*

Calibration and test set–up for the HP 8921A/600 and Advantest
R3561L test sets is included only for situations where it is necessary to
use them for calibration of IS–95A/B mode operation.
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Power Delta Calibration
Introduction

The ISC procedure has several differences from a normal calibration
procedure. One of these is the use of a spectrum
analyzer/communications test set instead of a power meter to measure
power. Power meters are broadband measurement devices and cannot be
used to measure power during ISC because other carriers are operating.
A spectrum analyzer can be used because it measures power at a given
frequency. Measuring power using a spectrum analyzer is less accurate
than using a power meter, therefore,  compensation is required for the
accuracy difference (delta) between the power meter and the spectrum
analyzer.

Agilent E4406A Power Delta
Calibration

The Agilent E4406A transmitter tester and E4432B signal generator test
equipment combination can be used for ISC of IS–2000 CDMA 1X as
well as IS–95A/B operation modes. The power delta calibration is
performed on the E4406A, but the E4432B is required to generate the
reference signal used to calculate the power delta offset. After the offset
value has been calculated, add it to the TX cable loss value in the LMF.

Follow the procedure in Table H-1 to perform the Agilent E4406A
Power Delta Calibration procedure.

Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter 3.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable from the E4432B RF OUTPUT connector the HP437 power meter power
sensor (see Figure H-1).

3 Set the E4432B signal generator as follows:

– Press  Preset  to exit any modes for which the signal generator is configured

– Press  Frequency  and enter the frequency of the channel to be calibrated on the numeric keypad

– Using the soft keys to the right of the screen, select the frequency range to be measured; for
example  MHz

– Press  Amplitude  and, using the numeric keypad, set signal amplitude to  0 (zero)

– Using the soft keys, set the measurement type to  dBm

. . . continued on next page
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Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

4 On the E4432B, press RF On/Off to toggle the RF output to  RF ON.

– Note that the RF On/Off status in the screen display changes.

5 Measure and record the value reading on the HP437 power meter as result A____________________.

6 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

– Note that the RF On/Off status in the screen display changes.

7 Disconnect the short RF cable from the HP437 power meter power sensor, and connect it to the RF
INPUT connector on the E4406A transmitter tester (see Figure H-2).

8 * IMPORTANT
Do not change the frequency and amplitude settings on the E4432B when performing the following
steps.

Set the E4406A as follows:

– Press  Preset  to exit any modes for which the transmitter tester is configured

– Press  MODE  and, using the soft keys to the right of the screen, select  cdmaOne

– Press  MEASURE  and, using the soft keys, select  spectrum

– Press  Frequency  and, using the soft keys, select  Center Frequency

– Enter the frequency of the channel to be calibrated using the numeric keypad

– Using the soft keys, select the frequency range to be measured; for example,  MHz

– Press Input/Output and, using the soft keys, select  Input Atten

– Using the numeric keypad, set Input Atten  to  0 (zero) and, using the soft keys, select  dB

– Using the soft keys, select  External Atten  and then select Mobile
– Using the numeric keypad, set Mobile to  0 (zero) and, using the soft keys, select  dB

– Using the soft keys, select  Base

– Using the numeric keypad, set Base to  0 (zero) and, using the soft keys, select  dB

– Press  MEASURE  and, using the soft keys, select  Channel Power

9 On the E4432B signal generator, press RF On/Off to toggle the RF output to  RF ON.

– Note that the RF On/Off status in the screen display changes.

10 Read the measured Channel Power from the E4406A screen display and record it as 
result B____________________.

11 On the E4432B, press RF On/Off to toggle the RF output to  RF OFF.

– Note that the RF On/Off status in the screen display changes.

. . . continued on next page
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Table H-1: Agilent E4406A Power Delta Calibration Procedure

Step Action

12 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Agilent measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see step 4 in
Table H-6).

 

Figure H-1: Delta Calibration Setup – Agilent E4432B to HP437
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Advantest R3267 Power Delta
Calibration

The Advantest R3267 spectrum analyzer and R3562 signal generator test
equipment combination can be used for ISC of IS–2000 CDMA 1X as
well as IS–95A/B operation modes. The power delta calibration is
performed on the R3267. After the offset value has been calculated, add
it to the TX cable loss value.

Follow the procedure in Table H-2 to perform the Advantest R3267
Power Delta Calibration procedure.

Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

1 * IMPORTANT
Warm-up test equipment for a minimum of 60 minutes prior to this procedure. After it is warmed up
and stabilized, calibrate the test equipment as described in the “Test Set Calibration” section of
Chapter 3.

Press the SHIFT and the PRESET keys located on the right side of the control panel.

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 On the CRT, select RX Control by pressing ACTIVE key 1.

4 On the CRT, select Frequency Setup by pressing ACTIVE key 3.

5 On the CRT, highlight Frequency by adjusting the DISPLAY CONTROL knob.

6 Press FREQ key in the ENTRY section of the control panel.

7 Set the frequency to the desired value using the keypad ENTRY section keys.

8 Press the LEVEL key in the ENTRY section of the control panel.

9 Set the level to 0 dBm using the keypad ENTRY section keys.

10 On the CRT, verify OFF is highlighted in Modulation, if not press the ACTIVE key 5 to toggle it
OFF.

11 On the CRT, verify OFF is highlighted in Output, if not press the ACTIVE key 6 to toggle it OFF.

12 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

13 Connect the RF cable from the R3562 signal generator RF OUT port to the power sensor, refer to
Figure H-3.

14 On the R3562 CRT, set the Output to ON by pressing ACTIVE key 6.

15 Record the Power Meter reading as result A________________________

16 On the R3562 CRT, set the Output to OFF by pressing ACTIVE key 6.

. . . continued on next page
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Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

17 Connect the RF cable from R3562 signal generator RF OUT port to the R3267 spectrum analyzer
INPUT Port, refer to Figure H-4.

18 On the R3562 CRT, set the Output to ON by pressing ACTIVE key 6.

19 On the R3267, press the POWER key in the MEASUREMENT section of the control panel.

20 Press the LEVEL key in the ENTRY section of the control panel.

21 Set the REF LEVEL to 10 dBm using the keypad ENTRY section keys.

22 On the CRT, select dB/div by pressing ACTIVE key 1.

23 On the CRT, select 10 dB/div by pressing ACTIVE key 1.

24 Press the FREQ key in ENTRY section of the control panel.

25 Set the frequency to the desired value using the keypad ENTRY section keys.

26 On the CRT, select more 1/2 by pressing ACTIVE key 7.

27 Press the Preselector CRT menu key to highlight 3.66G.

28 Press the POWER key in the MEASUREMENT section of the control panel.

29 Press the SPAN key in the ENTRY section of the control panel.

30 On the CRT, select Zero Span by pressing ACTIVE key 2.

31 Press the COUPLE key in the ENTRY section of the control panel.

32 On the CRT, select RBW and highlight MNL by pressing ACTIVE key 3.

33 Set RBW to 30 kHz using keypad ENTRY section keys.

34 On the CRT, select VBW and highlight MNL by pressing ACTIVE key 2.

35 Set VBW to 1 MHz using keypad ENTRY section keys.

36 Press the MKR key in the DISPLAY CONTROL section of the control panel.

37 On the CRT, select Normal Marker by pressing ACTIVE key 1.

38 Record the Marker Level reading as result B________________________

39 Press Single in ENTRY section of control panel.

. . . continued on next page
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Table H-2: Advantest R3267 Power Delta Calibration Procedure

Step Action

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.7 dBm – (–1.25 dBm) = 0.55 dB

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see step 4 in
Table H-6).

 

Figure H-3: Delta Calibration Setup – Advantest R3562 to HP437
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Agilent 8935 series E6380A
Power Delta Calibration

The Agilent E6380A (formerly HP8935) communications test set
modified with either option 200 or R2K and E4432B signal generator
test equipment combination can be used for ISC of IS–2000 CDMA 1X
as well as IS–95A/B operation modes. The power delta calibration is
performed on the E6380A. After the offset value has been calculated,
add it to the TX cable loss value.

Follow the procedure in Table H-3 to perform the Agilent E6380A
Power Delta Calibration procedure.

Table H-3: Agilent E6380A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter 3.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable between the E6380A Duplex Out port and the HP437 power sensor (see
Figure H-5).

3 Set the E6380A signal source as follows:

– Measure mode to CDMA Gen
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

4 Measure and record the power value reading on the HP437 Power Meter.

5 Record the Power Meter reading as result A ________________________.

6 Turn off the E6380A signal source output, and disconnect the HP437.

NOTE
Leave the settings on the source E6380A for convenience in the following steps.

7 Connect the short RF cable between the E6380A Duplex Out port and the RF–IN/OUT port (see
Figure H-6).

8 Ensure that the source E6380A settings are the same as in Step 3.

. . . continued on next page
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Table H-3: Agilent E6380A Power Delta Calibration Procedure

Step Action

9 Set the E6380A as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Anl Dir to Fwd

10 Turn on the E6380A signal output.

11 Set the Chn Pwr Cal to Calibrate and select to calibrate.

12 Measure and record the channel power reading on the measuring E6380A as result
B ________________________.

13 Turn off the E6380A signal output and disconnect the equipment.

14 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-6).

 

 
Figure H-5: Delta Calibration Setup – E6380A to HP437
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Figure H-6: Delta Calibration Setup – E6380A to E6380A
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HP8921A Power Delta
Calibration

Use the HP8921A communications test set to measure power during ISC
only for IS–95A and B operation of 800 MHz systems. After the offset
value has been calculated, add it to the TX cable loss value.

Follow the procedure in Table H-4 to perform the HP8921A Power Delta
Calibration procedure.

This procedure requires two HP8921A communication test
sets.

NOTE

Table H-4: HP8921A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter 3.

1 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

2 Connect a short RF cable between the HP8921A Duplex Out port and the HP437 power sensor (see
Figure H-7).

3 Set the HP8921A signal source as follows:

– Measure mode to CDMA Generator
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

4 Measure and record the power value reading on the HP437 Power Meter.

5 Record the Power Meter reading as result A ________________________.

6 Turn off the source HP8921A signal output, and disconnect the HP437.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

7 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF–IN port (see Figure H-8).

8 Ensure that the source HP8921A settings are the same as in Step 3.

. . . continued on next page
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Table H-4: HP8921A Power Delta Calibration Procedure

Step Action

9 Set the measuring HP8921A as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Analyzer Direction to Fwd

10 Turn on the source HP8921A signal output.

11 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

12 Turn off the source HP8921A signal output and disconnect the equipment.

13 Compute the delta between HP437 and HP8921A using the following formula:

Delta = A – B
Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-6).

 

Figure H-7: Delta Calibration Setup – HP8921A to HP437
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Figure H-8: Delta Calibration Setup – HP8921A to
HP8921A
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Advantest R3465 Power Delta
Calibration

Use the Advantest R3465 spectrum analyzer to measure power during
ISC only for IS–95A and B operation. After the offset value has been
calculated, add it to the TX cable loss value.

Follow the procedure in Table H-5 to perform the Advantest 3465 Power
Delta Calibration procedure.

Table H-5: Advantest Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes. After it is warmed up and stabilized, calibrate the test equipment as described in the
“Test Set Calibration” section of Chapter 3.

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF, if not press the Output key to toggle it OFF.

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA signal generator RF OUT port to the power sensor,
refer to Figure H-9.

12 Press the Output CRT menu key to toggle the Output to ON.

13 Record the Power Meter reading as result A________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L signal generator RF OUT port to the R3465 INPUT Port,
refer to Figure H-10.

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

. . . continued on next page
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Table H-5: Advantest Power Delta Calibration Procedure

Step Action

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL. using keypad entry keys enter 30 kHz.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B________________________.

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table H-6).
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Figure H-9: Delta Calibration Setup – R3561L to HP437
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Figure H-10: Delta Calibration Setup – R3561L to R3465
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In–Service Calibration for 1X
Upgrade

This feature does NOT have fault tolerance at this time.
The system has no safe–guards to prevent actions which
will put the BTS out of service. If possible, perform this
procedure during a maintenance window.

Follow the procedures in this section precisely, otherwise
the entire BTS will most likely go OUT OF SERVICE.

At the CBSC, only perform operations on expansion
hardware when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

IMPORTANT

*

Prerequisites
� Expansion hardware has been added in the CBSC database, and the

CDF file has been generated.

� The expansion devices have been inserted into the C–CCP cage and
are in the OOS_MANUAL state at the CBSC MM.

� The site specific CDF (with the expansion hardware) and CAL files
have been loaded onto the LMF.

� The LMF has the same code and dds files as the CBSC to download.

Do not download code or data to any cards other than those
you are working on. Downloading code or data to other
cards will take the site OUT OF SERVICE.

The code file version numbers must match the version
numbers required for the upgrade cards (refer to NO TAG).
If the numbers do not match, the site may go OUT OF
SERVICE.

It is mandatory that the bts–#.cdf  and cbsc–#.cdf
files on the LMF computer for this BTS are copies of the
corresponding files created in the CBSC database (see
NO TAG).

The CAL file loaded on the LMF computer for this BTS
must have come from the CBSC.

IMPORTANT

*

� Test equipment has been configured per Figure H-11, Figure H-12,
Figure H-13, or Figure H-14.
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� An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in–service calibration.

� Test equipment has been calibrated after 1 hour warm up.

� A short RF cable and two BNC–N adapters are available to perform
Cable Calibration.

� The Power Delta Calibration has been performed (see Table H-1,
Table H-2, Table H-3, Table H-4, or Table H-5).
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Figure H-13: Optimization/ATP Test Setup Using RFDS – Agilent Test Equipment
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Figure H-14: Optimization/ATP Test Setup Using RFDS – Advantest R3267/R3562 Test Equipment
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Follow the procedure in Table H-6 to perform the In–Service
Calibration.

Table H-6: In–Service Calibration

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In–Service Calibration:

– Start the LMF by double–clicking the LMF icon on the Windows desktop.

– Click Tools > Options from the menu bar at the login screen.

– Check only the applicable spectrum analyzer check box on the Test Equipment tab.
Ensure that the GPIB address is 18.

– Uncheck any other other equipment that is selected.

– Click the Apply button.

– Select the BTS Options tab in the LMF Options window.

– Check the In–Service Calibration check box.

– Click the Apply button.

– Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

– Select the target BTS icon.

– Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

– Click Util > Cable Calibration from the menu bar at the main window.

– Set the desired channel(s) and select TX and RX CABLE CAL in the cable calibration pop–up
window.

– Click the OK button to perform cable calibration.

– Follow the on–screen instructions to complete the cable loss measurement.

NOTE
– The measured value is input automatically to the cable loss file.

– To view the cable loss file, click Util > Examine > Cable Loss.

. . . continued on next pageH
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Table H-6: In–Service Calibration

Step Action

4 Add the spectrum analyzer power delta to the TX Cable Loss.

– Click Util > Edit > Cable Loss > TX.

– Add the value computed in Table H-4, Table H-5, or Table H-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

– Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

– Example: 5.65 dBm + (–0.29 dBm) = 5.36 dBm

– Example: –5.65 dBm + 0.55 dBm = –5.10 dBm

– Example: –5.65 dBm + (–0.29 dBm) = –5.94 dBm

5 Input the Coupler Loss for the TX tests:

– Click Util > Edit > Coupler Loss > TX from the menu bar at the main window.

– Enter the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the coupler loss file, click Util > Examine > Coupler Loss.

6 Input the Coupler Loss for the RX tests:

– Click Util > Edit > Coupler Loss > RX from the menu bar at the main window.

– Enter the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the couper loss file, click Util > Examine > Coupler Loss.

7 If it was not previously done, have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in–service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 8, 9, and 10.

. . . continued on next page
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Table H-6: In–Service Calibration

Step Action

8 Download code and data to the target devices:

– Click Tools > Update NextLoad > CDMA to set the code version that will be downloaded.

– Check the appropriate code version in the pop up window and click the Save button to close.

– Select the target BBX(s) on the C–CCP cage picture.

– Click Device > Download Code/Data to start downloading code and data.

! CAUTION
Perform the All Cal/Audit procedure on OOS devices only.

9 Run the All Cal/Audit procedure:

– Select the target BBX(s) on the C–CCP cage picture.

– Click Tests > All Cal/Audit from the menu bar at the main window.

– Select the target carrier and confirm the channel number in the pop up window.

– Leave the Verify BLO check box checked and click the OK button to start calibration.

– Follow the on–screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

10 Save the result and download the BLO data to the target BBX(s):

– Click the Save Result button on the result screen.
The window closes automatically.

11 Logout from the BTS and close the LMF session:

– Click Select > Logout to close the BTS connection.

– Close the LMF window.

12 Restore the new “bts–*.cal” file to the CBSC (refer to Table 5-2).

13 Enable the target device(s) from the CBSC.

 

H
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Index

Numbers
10 MHz Rubidium Standard, optional test equipment,

1-11

10BaseT/10Base2 converter
LMF to BTS connection, 3-21
remove from BTS, 5-4

2–way splitter, optional test equipment, 1-10

50–pair punchblock, 3-18

A
Abbreviated

RX acceptance test, all–inclusive, 4-4
TX acceptance test, all–inclusive, 4-4

Acceptance Test Procedure. See ATP

ACTIVE LED
GLI, 6-31
MCC, 6-33

Alarm and Span Line Cable Pin/Signal Information,
3-18

ALARM LED, GLI, 6-31

Alarm Monitor window, 3-86

Alarm Reporting Display, 3-86

All RX ATP Test Procedure, 4-6

All tests fail on a single antenna, Troubleshooting,
RFDS, 6-26

All TX ATP Test Procedure, 4-5

All TX/RX ATP Test Procedure, 4-5

Applying AC Power, 2-12

ATP
all inclusive TX acceptance test outline, 4-4
automated introduction, 4-1
code domain noise floor acceptance test procedure,

4-16

code domain power acceptance test procedure, 4-16
failure report generation, 4-20
FER test, frame error rate testing, 4-19
pilot time offset, 4-13
prerequisites, 4-2
spectral purity TX mask, 4-10
test matrix/detailed optimization, B-2
waveform quality (Rho), 4-12
waveform quality (RHO) acceptance test procedure,

4-12

Attenuator, required test equipment, 1-9

B
Basic Troubleshooting Overview, 6-1

Battery Charge Test (Connected Batteries), 2-15

Battery Discharge Test, 2-16

Bay Level offset calibration failure, 6-10

BBX
carrier spectral purity, 4-9
gain set point vs SIF output considerations, C-1
primary and redundant, TX tests to be performed,

4-7

BBX2 Connector, 6-20

BBX2 LED Status Combinations, 6-33

BDC, pilot gain setting, 4-18

Bringing modules into service, prepare to leave the
site, 5-3

Broad Band Receiver. See BBX

BTS
download, 3-32
Ethernet LAN interconnect diagram, 3-29
LMF connection, 3-15, 3-21
log out of session, 5-4
RX sensitivity/frame error rate, 4-8
system software download, 3-3
when to optimize, B-1
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BTS Frame Erasure Rate. See FER

BTS Log In Procedure, GUI, 3-24

BTS login
CLI environment, 3-25
General, 3-23
GUI environment, 3-24

BTS Logout
CLI environment, 3-27
GUI environment, 3-26

Create CAL File, 3-76

bts–nnn.cal File, 3-10

C
Cables Connection for 10 MHz Signal and GPIB ,

F-2, F-4

Calibrate BLO, 3-65

Calibrating Cables, 3-59

Calibrating Test Cable Setup, PCS Interface
HP83236B, F-14

Calibrating Test Equipment, 3-59

Calibration
data file calibration, BLO, 3-67
power meter, Gigatronics 8542B, F-12

Calibration Audit failure, 6-11

calibration data file, description of, BLO, 3-67

Cannot communicate to Communications Analyzer,
6-6

Cannot communicate to Power Meter, 6-5

Cannot Download DATA to any device card, 6-7

Cannot ENABLE device, 6-8

Cannot Log into cell–site, 6-2

Cannot perform carrier measurement, 6-16

Cannot perform Code Domain Noise Power
measurement, 6-16

Cannot perform Rho or pilot time offset
measurement, 6-15

Cannot perform Txmask measurement, 6-15

cbsc folder, 3-11

CDF
site configuration, 3-2

site equipage verification, 3-3
site type and equipage data information, 2-1

CDMA
allocation diagram for the North American, cellular

telephone frequency spectrum, D-4
optimization/ATP test matrix, B-1
subscriber mobile radiotelephone, optional test

equipment, 1-11

cdma Folder, 3-9

CDMA LMF and Logical BTS, 3-22

Cell Site
equipage verification, 2-1
types configuration, 3-2

Cell Site Data File. See CDF

Channel Service Unit, 3-15

CIO Connectors, 6-21

Clock Sync Module. See CSM

Code domain power/noise floor
acceptance test, 4-15
analyzer display, 4-17

code Folder, 3-11

Communication test set, rear panel, F-2, F-4

Communications test set. See Test equipment

Connect BTS E1/T1 spans, 5-5

Connect BTS T1/E1 spans, 5-5

Connecting test equipment to the BTS, 3-48

Connector Functionality
Backplane, Troubleshooting, 6-20
Troubleshooting, Backplane, 6-20

Control, TX output verification, 4-3

Copy CBSC CDF Files to the LMF, 3-5

Copying CAL files from CDMA LMF to the CBSC,
5-1

Copying CAL files to the CBSC, 5-1

CSM, and LFR primary functions, 3-38

CSM frequency verification, 3-40

CSM LED Status Combinations, 6-29

D
data Folder, 3-12

DC Power Pre–test (BTS Frame), 2-7
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DC Power Problems, C–CCP Backplane
Troubleshooting, 6-24

DC/DC Converter LED Status Combinations, 6-28

Detailed, optimization/ATP test matrix, B-2

Devices, download. See Download

Digital Control Problems, 6-21
C–CCP Backplane Troubleshooting, 6-21

Digital multimeter, required test equipment, 1-9

Directional coupler, required test equipment, 1-9

Documents, required, 1-12

Download
See also Devices
BTS, 3-32
BTS system software, 3-3

Download BLO Procedure, 3-73

Download from the CBSC, prepare to leave the site,
5-3

download ROM and RAM code, G-2

Download/Enable MCCs, 3-37

Download/Enable MGLIs, 3-34

Duplexer, optional test equipment, 1-10

E
E1, isolate BTS from the E1 spans, 3-14

Enable CSMs & BDCs, 3-36

End LMF session, 5-4

Equipment Overview, 1-15

Equipment warm-up, 3-50

establish MMI communication, 3-27

Ethernet LAN
interconnect diagram, 3-29
transceiver, 1-7

Ethernet LAN termination, 2-3

Every test fails, Troubleshooting, RFDS, 6-26

F
Failure report generation, 4-20

FER, acceptance test, 4-19

Files
calibration data file, BLO, 3-67
intermediate file, 4-20

Filtronics, low IM Duplexer (Cm035–f2) or
equivalent, optional test equipment, 1-10

Fluke, model 8062A with Y8134 test lead kit, test
equipment, 1-9

Folder Structure Overview, 3-9

Frame, equipage preliminary operations, 2-1

FREQ Monitor Connector, CSM, 6-30

Frequency counter, optional test equipment, 1-10

G
Gain set point, C-1

Generating an ATP Report, 4-20

General optimization checklist, test data sheets, A-4

Gigatronics 8542B power meter, illustration, F-13

GLI Connector, 6-20

GLI Ethernet A and B Connections, 6-20

GLI LED Status Combinations, 6-31

GLI Pushbuttons and Connectors, 6-32

GLI2 Front Panel Operating Indicators, 6-32

GPIB, F-1, F-5, F-7
cables, 1-8

GPS, receiver operation, test data sheets, A-5

GPS Initialization/Verification
estimated position accuracy, 3-41
surveyed position accuracy, 3-41

GPS satellite system, 3-37

Group Line Interface. See GLI

H
Hardware Requirements, 1-6

High Stability 10 MHz Rubidium Standard, optional
test equipment, 1-11

High–impedance conductive wrist strap, required test
equipment, 1-9

HP 83236A, F-5

HP 8921A/600 test set, 1-8

HP8921A, F-5
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HSO Initialization/Verification, 3-38

Huber & Suhner, required test equipment, 1-9

HyperTerminal, Creating named HyperTerminal
connection, 3-7

HyperTerminal , create named connection, 3-7

I
I and Q values, E-1

Initial HP8921A setup, F-14

Initial Installation of Boards/Modules, preliminary
operations, 2-1

Initial power tests, test data sheets, A-3

Inter–frame cabling, when to optimize, B-1

Intermediate file, generate ATP file using, 4-20

IS–97 specification, E-1

L
LAN

BTS frame interconnect, illustration, 3-29
optional test equipment, 1-10

LAN connectors, external, 2-3

LAN termination, 2-3

LED Status Combinations for all Modules except
GLI2 CSM BBX2 MCC24 MCC8E, 6-28

LFR, receiver operation, test data sheets, A-6

LMF, F-1, F-7
BTS connection, 3-21
logout procedure, 5-4
platform requirements, 1-6
remove from BTS, 5-4
shut down UNIX, 5-4
terminal, 1-6
to BTS connection, 3-14, 3-15
TX acceptance tests, 4-3
view CDF information, 3-3

lmf Folder, 3-9

loads folder, 3-11

Local Maintenance Facility. See LMF

Log out
of BTS, 5-4
of LMF PC, 5-4

Logging Into a BTS, 3-23

Logging Out, 3-25

LORAN–C Initialization/Verification, 3-46

LPA errors, 6-9

LPA Module LED, 6-34

LPA Shelf LED Status Combinations, 6-34

M
Master Group Line Interface. See MGLI

MASTER LED, GLI, 6-31

MCC LED Status Combinations, 6-33

MMI common connections, 3-28

MMI Connector
CSM, 6-30
GLI, 6-32

MMI Connectors, MCC, 6-33

MMI equipment setup, 3-28

Module status indicators, 6-28

Multi Channel Card. See MCC

Multi–FER test Failure, 6-17

N
New installations, 1-4

No AMR control, 6-22

No BBX2 control in the shelf, 6-23

No DC input voltage to  Power Supply Module, 6-24

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX2 or Switch board, 6-25

No GLI2 Control through span line connection, 6-22

No GLI2 Control via LMF, 6-21

No or missing MCC24 channel elements, 6-23

No or missing span line traffic, 6-23

North American, cellular telephone system frequency
spectrum, CDMA allocation, D-4

O
Online Help, 3-28

Optional test equipment, 1-10
10 MHz rubidium standard, 1-11
2–way splitter, 1-10



Index  – continued

08/01/2001 1X SC�4812ET Lite BTS Optimization/ATP

PRELIMINARY
Index-5

CDMA subscriber mobile or portable
radiotelephone, 1-11

duplexer, 1-10
frequency counter, 1-10
LAN tester, 1-10
oscilloscope, 1-10
RF circular, 1-11
RF test cable, 1-10
spectrum analyzer, 1-10

Oscilloscope, optional test equipment, 1-10

P
PCMCIA, Ethernet adapter

LMF to BTS connection, 3-21
remove from BTS, 5-4

Periodic optimization, 1-4

Pilot Time Offset. See PN

Pilot time offset, acceptance test, 4-13

Ping, 3-29

PN
offset programming information, E-1
offset usage, E-1

PN offset per sector, E-1

PN Offset Usage , E-1

Power Input, 6-20

Power Meter
illustration, F-10
Pre–calibration, F-10

Power meter
calibration, Gigatronics 8542B, F-12
illustration, Gigatronics 8542B, F-13
required test equipment, 1-8
TX acceptance tests, 4-3

Power Supply Module Interface, 6-20

Pre–calibration, Power Meter, F-10

Pre–power tests, test data sheets, A-3

Preliminary operations
cell Site types, 2-1
test data sheets, A-2

Prepare to leave site
connect BTS E1/T1 spans, 5-5
connect BTS T1/E1 spans, 5-5
remove external test equipment, 5-3

Prepare to leave the site
bringing modules into service, 5-3
download code and data from CBSC, 5-3

Prerequisites, automated acceptance tests, 4-2

Procedures to Copy CAL Files From Diskette to the
CBSC, 5-1, 6-2, 6-5, 6-6, 6-7

Procedures to Copy Files to a Diskette, 5-1

Program, TSU NAM, 3-85

Pseudorandom Noise. See PN

PWR/ALM and ACTIVE LEDs, MCC, 6-33

PWR/ALM LED
BBX2, 6-33
CSM, 6-29
DC/DC Converter, 6-28
generic, 6-28
MCC, 6-33

R
RAM code, described, 3-32

Report generation, ATP report, 4-20

Required test equipment
communications system analyzer, 1-6, 1-8
digital multimeter, 1-9
directional coupler, 1-9
Ethernet LAN transceiver, 1-7
GPIB cables, 1-8
high–impedance conductive wrist strap, 1-9
power meter, 1-8
RF adapters, 1-9
RF attenuator, 1-9
RF load, 1-9
RS232 to GPIB interface, 1-7
timing reference cables, 1-9

Required test equipment and software, list, 1-6

RESET Pushbutton, GLI, 6-32

RF
attenuator, 1-9
Circular – optional test equipment, 1-11
load for required test equipment, 1-9
required test equipment load, 1-9
test cable, 1-9

RF path, fault isolation, 6-12

RF Path Bay Level Offset Calibration, 3-65

RFDS – Fault Isolation, 6-26

RFDS Calibration, 3-83
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RFDS Location, SC 4812ET, 1-25

RFDS Test Subscriber Unit, 3-33

RFDS TSU Calibration Channel Frequencies, 3-83

Rho
TX waveform quality acceptance test, 4-12
waveform quality requirements, 4-12

ROM code
described, 3-32
downloading, G-1

ROM code download Caution, G-1

ROM code release level Caution, G-2

RS232 to GPIB interface
modifications required for Automated Testing, 1-7
required test equipment, 1-7

RX
acceptance tests, FER, 4-18
antenna VSWR, test data sheets, A-11
sensitivity/frame error rate, 4-8

RX and TX paths fail, Troubleshooting, RFDS, 6-26

S
SC 4812 BTS Optimization/ATP Test Matrix, B-3

SCCP Backplane Troubleshooting, Procedure, 6-21

SCLPA, convergence test data sheets, A-7

Selecting Test Equipment, 3-57

Set Antenna Map Data, 3-81

Set RFDS Configuration Data, 3-82

Setting Cable Loss Values, 3-63

Setting Control Port, 3-15

Setting TX Coupler Loss Value, 3-64

SIF, output considerations vs BBX gain set point, C-1

Site, equipage verification, 3-3

Site checklist, verification data sheets, A-2

Site documents, 1-12

site equipage, CDF file, 3-2

Site expansion, 1-4

Span line
T1/E1 verification equipment, 1-10
troubleshooting, 6-35

Span line configuration, troubleshooting, 6-36

Span Line connector , 6-20

SPANS LED, 6-31

Spectral purity, TX mask – primary and redundant
BBX, 4-7

Spectral purity transmit mask, acceptance test, 4-10

Spectrum analyzer, optional test equipment, 1-10

STATUS LED, GLI, 6-31

Supported Test Sets, 3-48

SYNC Monitor Connector, CSM, 6-30

System Connectivity Test, F-5

T
T1, isolate BTS from the T1 spans, 3-14

Tektronics model 2445 test equipment, 1-10

Test data sheets
Alarm verification, A-11
general optimization checklist, A-4
GPS receiver operation, A-5
initial power tests, A-3
LFR receiver operation, A-6
pre–power tests, A-3
preliminary operations, A-2
RX antenna VSWR, A-11
SCLPA convergence, A-7
site checklist, A-2
TX antenna VSWR, A-10
TX BLO, A-8
verification of test equipment used, A-1

Test equipment
See also Optional test equipment; Required test

equipment
set up, TX output verification/control, 4-3
system analyzer, 1-8
TX acceptance tests, 4-3
verification data sheets, A-1

Test equipment connections , F-1

Test Equipment Setup, 3-48

Test Equipment Setup Calibration for TX Bay Level
Offset, 3-62, F-18

Test Equipment Setup Chart, 3-49

Test equipment setup RF path  calibration, 3-69

Test Set Calibration, 3-56
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Timing reference cables, required test equipment
Model SGLN1145A/4132A CSMs, 1-9
Model SGLN4132B CSMs, 1-9

Transmit TX path audit, 3-74

Transmit TX path calibration, 3-70

Troubleshooting
DC Power Problems, 6-24
RF path fault isolation, 6-12
Set span configuration, 6-36
span problems, 6-35
TX and RX Signal Routing, 6-25
TX level accuracy fault isolation, 6-14

Troubleshooting CSM Checklist, 6-18

TX
acceptance tests

code domain power/noise floor, 4-15
equipment setup, 4-3
pilot time offset, 4-13
spectral purity mask, 4-9

spectrum analyzer display, 4-11
waveform quality (rho), 4-12

all inclusive TX ATP test, 4-4
antenna VSWR, test data sheets, A-10, A-11
BLO test data sheets, A-8
level accuracy fault isolation, 6-14
output acceptance tests

code domain power noise, 4-7
pilot time offset, 4-7
waveform quality, 4-7

TX & RX Path Calibration, 3-65

TX and RX Frequency vs Channel , D-2

TX and RX Signal Routing, C–CCP Backplane
Troubleshooting, 6-25

TX Audit Test, 3-75

TX Bay Level Offset and TX ATP test equipment
setup calibration, 3-61

TX Calibration Test, 3-72

tx fine adjust, E-1

TX Path Calibration, 3-66

TX/RX OUT Connections, 4-2

U
UNIX, shut down on LMF, 5-4

Unshielded Twisted Pair. See UTP

Updating CDMA LMF Files, 5-1

UTP, LMF to BTS connection, 3-21

V
Verify

test equipment used, test data sheets, A-1
TX output, 4-3

Verify GLI ROM code load, 3-33

version Folder, 3-11

Virtual BTS, 1-15

W
Waveform quality (Rho), acceptance test procedure,

4-12

When to optimize
BTS, B-1
inter–frame cabling, B-1

X
XCVR Backplane Troubleshooting, 6-20

Xircom Model PE3–10B2
LMF to BTS connection, 3-21
remove from BTS, 5-4
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